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Getting started
This manual describes how to use LDMS for and is intended for users at
laboratories.

About Frontier Science
Frontier Science develops and maintains LDMS, and provides data hosting for
laboratories.

Frontier Science and Technology Research Foundation, Inc. is a not-for profit
that provides data management services to research organizations. LDMS is
one of those data management services.

Many organizations that utilize LDMS also utilize Frontier Science’s data
management center (often referred to as the DMC) in Amherst, New York for
long term data storage. These organizations use LDMS as a mechanism for
sending specimen data for studies to Frontier Science.

Frontier Science is involved in many other statistical research efforts beyond
LDMS. To learn more about the work that Frontier Science does, visit https://
www.frontierscience.org.

About LDMS
LDMS is a data management solution for laboratories managing biological
medical specimens.

General information
LDMS is specifically designed for the needs of small and medium-sized
research laboratories. It is available for Windows or as a web application.
Laboratories generally use LDMS on one platform only. The Windows version
must be installed on individual machines, but can utilize a centralized LDMS
server installed at the laboratory. The web version does not require additional
software to be installed and can be used in most web browsers. Users of the
web version do not need to maintain a local database or create backups of
data.

LDMS can perform many tasks, including the following:

• cataloging specimen information, such as its volume, additive, and current
condition

• managing the transfer of specimen information between laboratories
• generating labels for specimens
• keeping track of where specimens are located in storage units

Frontier Science manages data for laboratories using LDMS in a secure
environment that meets the standards of 21 CFR Part 11 and NIST/FISMA
guidelines.

Frontier Science Foundation 10
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History
LDMS was initially released for Windows in 1998 to collect data for HIV-
related clinical trials.

The first projects to use LDMS were the Adult and Pediatric AIDS Clinical
Trials Groups (AACTG and PACTG, now known as ACTG and IMPAACT).
While LDMS continues to be used heavily by projects that focus on HIV
and related cohorts, it is also used for many other specialized research
purposes, including hepatitis C (HCV) and influenza studies, proficiency
testing programs, and specimen repositories.

In 2014, Frontier Science released the web version LDMS.

Windows and web versions
Since the release of the web version of LDMS, Frontier Science has focused on
the development of the web version.

The Windows version of LDMS continues to be maintained, and several
updates to the Windows version have been released since the introduction
of the web version. LDMS for Windows releases generally focus on improving
existing features and group-specific changes. When possible, new laboratories
should generally use the web version. When a new laboratory is set up,
Frontier Science will guide the laboratory through the process of selecting and
installing the appropriate version for their needs.

Laboratories are able to ship specimens to and receive specimens from other
laboratories, regardless of which version of LDMS the laboratories are using.
There may be other concerns when laboratories using the Windows and web
versions need to work together. Frontier Science can work with laboratories to
determine how to best handle different scenarios.

Migrating from Windows to web versions
Laboratories currently using LDMS for Windows may be able to migrate to the
web version.

Migration from the Windows to web version must be approved and
coordinated by Frontier Science. Frontier Science will typically invite
laboratories to migrate when it is appropriate to do so. Issues that need to be
considered when migrating a laboratory include the following:

• Are all projects that the laboratory participates in supported in the web
version?

• Are the features the laboratory is currently using supported in the web
version?

• Does the laboratory routinely work with laboratories using the Windows
version?

It is possible to migrate a laboratory's existing LDMS for Windows data to the
web version. To do this, the laboratory's Windows database must be obtained
by LDMS User Support. Frontier Science will then convert the data to the
appropriate format and test it internally for issues. If the database can be

Frontier Science Foundation 11
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converted successfully, LDMS User Support will help get the laboratory setup
with appropriate user accounts and training.

System requirements
These are the system requirements, along with recommended specifications,
for using LDMS.

Required

Table 1: System requirements

Component Requirement

Operating System Windows 8
Windows 8.1
Windows 10
Windows Server 2012
Windows Server 2016

LDMS has been reported to function appropriately on thin clients and
virtual machines, but these have not been thoroughly tested and are
not supported by Frontier Science.

Home editions of Microsoft Windows are not supported.

Web Browser • Firefox 41 or higher
• Chrome 45 or higher
• Edge 20 or higher

JavaScript must be enabled for all browsers. Although most browsers
will be able to use LDMS without issues, Frontier Science does not
provide user support for web browsers that are not listed.

Microsoft .NET
Framework

Version 3.5 (if you are using Windows 7 or higher, you should
already meet this requirement)
Version 4.0 (full profile) or higher (if you are using Windows 8 or
higher, you should already meet this requirement)

Both versions of .NET are required.

Screen Resolution 1024 × 768

Hard Drive Size requirements vary by number of specimens managed

Networking High-speed Internet connection

Input Keyboard and 2-button mouse

Video Monitor and video card capable of at least 1024 × 768 resolution and
16-bit color depth

Label Printing Adobe Acrobat

Frontier Science Foundation 12
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Recommended

Table 2: System recommendations

Component Recommendation

CPU 3.0+ GHz Intel Core 2 or AMD processor

Hard drive 100 GB free space (more if managing a large laboratory)

Removable Storage High capacity removable storage, e.g. CD-RW, DVD-RW, USB drive, etc.

Printer Printers and barcode readers may have additional requirements.
Consult your hardware's documentation for more information.

Memory 2 GB or more of RAM

Barcode Reader Compatible barcode scanner

Power An uninterruptible power supply (UPS) to protect against data loss
caused by power failure.

Other software

LDMS can generate reports and other types of files in several different
formats. Most of these files can be opened by commonly used programs that
are already on our computer.

PDF viewer Needed to view and print reports. You can download
many PDF viewers for free, such as Adobe Reader and
Evince.

Important:  An Adobe PDF viewer is required
when printing labels.

Spreadsheet
viewer

Needed to view exportable reports. Microsoft Excel or
LibreOffice Calc can open these files.

Getting LDMS Installed
If you do not have LDMS installed, contact Frontier Science as they will
facilitate installation. As part of this process, your laboratory will be assigned
a unique LDMS laboratory ID by Frontier Science. A laboratory ID is a 3-digit
number that uniquely identifies a laboratory. This ID is used in several places
in LDMS:

• It is used to generate global specimen IDs for specimens, a number that
uniquely identifies a single specimen across all laboratories using LDMS.

• It is used for shipping specimens between laboratories.

Your LDMS laboratory ID will be assigned to you by Frontier Science prior to
the installation of LDMS. Once this ID has been assigned to you, LDMS User
Support will coordinate the installation of LDMS for you.

For more information on the process of getting LDMS installed, contact LDMS
User Support.

Frontier Science Foundation 13
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Upgrading to the Latest version of LDMS
Frontier Science releases major updates for LDMS several times each year.
An email notification is sent to users when a new version is available. It is
important that you upgrade when a new version is released so that your
laboratory has access to the most secure, stable, and feature-rich version
available.

If you already have LDMS installed, you can upgrade to the latest version
yourself by downloading and running a software update. To determine what
version of LDMS you are currently using, click Help > About from the LDMS
menu bar.

Important:

If you are running LDMS in a client-server setup, you must upgrade
LDMS on the server prior to upgrading the client machines.

Upgrading LDMS

1. Prepare for installation.

• Using LDMS, create a current backup of your LDMS database.
• Close all programs (including LDMS) on the computer. It is a good idea

to reboot the machine.
• Ensure that you have full local administrative privileges on the

computer. These will be required to complete installation.
2. Obtain the LDMS software update. There are two ways to get it:

• Visit the Frontier Science website. Click the Get LDMS Updates link
from the section entitled LDMS User Support. There you will find a
link to download any available LDMS updates.

• Get an installation DVD by contacting LDMS User Support.
3. Run the installer.

Important:

During installation, LDMS will need to update your LDMS database.
The time required to complete this process will vary, depending on
the amount of data at your laboratory. For large laboratories, this
process could take several hours. Do not interrupt this process or
turn off your computer.

4. Once the update has finished, attempt to start LDMS. You will be prompted
to contact LDMS User Support to unlock LDMS before you can use it again.

Frontier Science Foundation 14
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Figure 1: Table update window

This window will show the progress of updating your LDMS database during the upgrade; do not close this window or

turn off your computer.

If you encounter any difficulties or need assistance upgrading, do not hesitate
to contact LDMS User Support.

Setting up an LDMS Client-Server Environment
LDMS can be set up so that multiple computers running LDMS utilize the
same LDMS database. LDMS is installed on one computer and acts as the
server; LDMS is then installed on other computers (the clients) connected to
the same local network, and access the LDMS database on the LDMS server.
Doing this allows you to have multiple computers with LDMS installed that
can access the same data. The LDMS server does not need to be a dedicated
server either—you can use the server like any other computer with LDMS to
add specimens, read assay results, etc.

Important:

The LDMS server and all clients must be running the same version of
LDMS. Upgrades must be performed on all machines at once, with the
server machine upgraded first.

Installing LDMS for client-sever setups

1. Install LDMS on the computer to act as the LDMS server and perform any
needed updates.

2. Locate the LDMS reports directory on the server machine. This location will
need to be accessible to LDMS clients, such as a shared network location.

Frontier Science Foundation 15
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A typical location may be \\[machine name]\[drive letter]\fstrf
\reports.

Important:

This directory must be a shared directory and clients must have full
control permissions for it. To make this directory more secure, you
can obtain a list of Windows login usernames for the people that will
be using LDMS and modify permissions on the reports directory so
that only those users will have permissions to access it.

3. Install LDMS on each client computer that will be connecting to the LDMS
server.

4. On the client machine(s), open C:\fstrf\assay\bin\lldms.ini in a text
editor such as Notepad. Update the following settings (replace ### with
your 3-digit LDMS laboratory ID number):
OracleDatabaseServerName=servername:1521/xe
OracleDatabaseSchemaName=LAB###
DBPATH=\\servername\fstrf\reports
REPPATH=\\servername\fstrf\reports
ExportDir=\\servername\drive\fstrf\reports\Export

5. Start each LDMS client and ensure that all of them open without error.

You must set up a printer for each LDMS client individually (as well as the
server, if you will be using it for normal work). Setting a printer in LDMS is
required for labels and reports to be generated correctly.

Challenge codes
A challenge code is password that you must give to LDMS User Support to
perform certain actions in LDMS.

Access to certain features in LDMS may be restricted for a number of
reasons. For example, unimporting a received shipment can have very serious
consequences. LDMS does not provide “undo” functionality to reverse such an
action. A challenge code is a fail-safe mechanism that can prevent accidental
changes to specimen data.

A challenge code will also be required after installing or upgrading LDMS, or
after an unexpected system shutdown. In these situations, LDMS may display
a description of the problem. Providing that description to LDMS User Support
will help expedient unlocking LDMS.

If you attempt to access a feature locked with a challenge code, LDMS will
prompt you for the response code.

You must contact LDMS User Support and give them the Challenge Code.
If appropriate, they will provide you with the response code which will then
unlock the feature for your use. The code will change each time the feature is
accessed, and will be needed even if the feature was previously unlocked.

Frontier Science Foundation 16
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Figure 2: Prompt for challenge password

In this example, you would provide LDMS User Support with the code NOQEAS and they will provide you with the

Response Code to access this feature.

! Warning:  Do not close the challenge password window before you
obtain the Response Code. Doing so will cause a new Challenge
Code to be generated, which will require a different Response Code.

Logging into LDMS for the First Time
LDMS requires users to log in with their own, unique user name and
password. The first time you start LDMS, you need to create a new user to
act as your system administrator. This person will have the ability to create
accounts for other users.

Creating your first LDMS User

1. Log into LDMS with the temporary user ADMIN, and the password admin.
This is the only time you will use this account.

2. From the LDMS menu bar, click Administration > User Configuration
3. To create an account for your system administrator, click New User.
4. Enter the login name for the person into the User Name field. User names

must be unique at your laboratory. A good idea is to use person's first
initial and last name (e.g. jdoe for "John Doe").

5. Enter the user's full name into the Real Name field.
6. Enter the user's initials into the Initials field. By default, the user's

initials are used by LDMS in specific places to document the user making a
change or entering data.

7. Click the OK button.
8. Enter a password for the user into the New Password and Confirm

Password fields. The passwords must match.
9. Select the System Administrator Capabilities check box.
10.In the Menu Permissions list, click the column header labeled Full to

give the user access to all features in LDMS.
11.Click the    button from the LDMS toolbar.
12.From the User ID drop down list, select ADMIN.
13.Click Delete.
14.When prompted to save your changes, click the Yes button.

Frontier Science Foundation 17
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From now on, the user that you created will act as the administrator for
your LDMS system. They will be able to create new users and manage what
users can do within LDMS. You can create more than one user with these
administrative capabilities.

Acknowledgement of training
If it is your first time logging into LDMS, you will be prompted to sign an
acknowledgement of training after entering your username and password.
Or, if you are an existing user logging in for the first time after the software
upgrade to version 13.0, you will also be prompted with this screen.

Figure 3: Acknowledgment Form

If you have not been trained, you will not be allowed into the system. By
selecting the option Yes, I have been trained, you are indicating that you
have received training in the use of LDMS.

Frontier Science Foundation 18
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Changing Users
You must be logged into LDMS to use it—there is no concept of a guess
account in LDMS. The current user is displayed in the status bar at the bottom
of the screen.

To change to a different user after logging in, click Administration >
Session Lock from the LDMS menu bar, or press Ctrl + Shift + L. This
is also how you would lock LDMS if you need to leave a computer station
unattended. By Default, LDMS will automatically lock and require a user name
and password after 30 minutes of inactivity.

! Attention:

If you click the Cancel button on the login screen, LDMS will close.
If there is unsaved work on the screen, you will not be given the
opportunity to save it.

Date and Time in LDMS
Every time you log into LDMS, you'll be asked to confirm the date and time.
It is very important that the date and time are correct as this information is
used throughout LDMS.

The date and time LDMS will use is pulled directly from your computer's
system time. If the date or time is not correct, you must update it within
Windows. This is typically done by right-clicking on the system clock on the
Windows task bar.

Setting Up a Printer for LDMS
LDMS pulls the settings for your printer directly from Windows for certain
tasks. This is especially important for generating labels. LDMS will access the
driver software for your printer to get information such as the paper size, and
use this information when generating the labels. If a printer is not specified in
LDMS, the labels may not be generated correctly.

Finding Your Way Around
LDMS is task-oriented by design. When you start doing something, you
are performing that task only. To switch from performing one task (such as
entering specimens) to doing another (configuring an assay), you need to
stop doing the first task. You can't be doing two tasks at once.

When LDMS first starts, you will see a white screen. To start working, select a
task from the LDMS menu bar or tool bar. For example, you can click the   
button to start Specimen Management and enter specimen data. To change
tasks and ship the specimens you just entered, you'd need to click the 

  button to leave Specimen Management, and then click the    to open

Frontier Science Foundation 19
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Shipping. This is why, when you start working, you'll notice that most of
LDMS's menu and tool bar buttons become disabled.

Tip:

The    button is used to leave a task in LDMS; the    button is used
to exit LDMS itself.

Figure 4: Main LDMS Screen

A brief overview of where to find certain features in LDMS

All of the task shortcuts on the toolbar are identical to the tasks listed in the
Tasks menu on the menu bar. Likewise the database actions in the toolbar
can also be found in the Database menu.

Let's take a brief look at what each button does:

This action adds something you're doing on a screen,
such as creating a new report or adding a new specimen.
Notice the distinction between  and the Save button.
Saving is what you do when you are modifying
something that already exists; adding is what you do
when you're saving something new.

  Save This action saves changes that you've made to a screen.
It's different than adding  a record in that the record
already exists. On most screens in LDMS, you'll get
a warning message if you try to leave without saving
changes.
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  Execute This action does something. For example, if you are on a
screen that lets you search for something, the execute
button will initiate that search.

  Refresh This action clears a screen of things you entered. It
doesn't undo entering a record (LDMS does not have
an undo function); it simply clears data that's been
entered so that you can start fresh. So if you started
entering information and just want to start again, click
this button.

  Specimen
Management

This is where you go in LDMS to enter new specimens,
and modify or view existing specimens. All specimens
begin their life in LDMS here. New study participants
can be added to LDMS when you are creating specimens
too. You can also print labels, flag specimens for
shipment or for testing, and much more. Using Specimen
Management is explained in detail in .

  Patient
Management

This is where you go in LDMS to modify existing
study participants, such as adding or correcting study
enrollment. New participants can also (but are generally
not) added here. Using Patient Management is explained
in detail in .

  Storage
Management

This is where you go in LDMS to see or change a
specimen's storage location. LDMS allows you to define
a virtual storage structure in your LDMS database that
corresponds to your real-life storage items. There are
freezers, shelves, racks, etc.

  Shipping This is where you go in LDMS to send or receive
specimens to or from another laboratory. LDMS transfers
data between laboratories by creating shipping files. A
shipping file contains specimen information that goes
with a physical shipment of specimens. The receiving
laboratory can import this shipping file to add the
specimens to their own LDMS database.

  Assays This is where you go in LDMS to read assay data and
associate it with specimens. LDMS supports a variety of
assays and assay reader devices.

  Reports This is where you go in LDMS to generate a wide variety
of pre-configured reports. There are dozens of reports
available. LDMS can also generate custom reports using
the Data Retrieval tool
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  Labels This is where you go in LDMS to create new, custom
label formats for specimens. You can also print labels for
numerous specimens at once.

 
Database
Navigation

These buttons are used in a few places in LDMS to move
between entries. Most notably, they are used in LDMS
Specimen Management    to move between specimen
records. They are also used on some assays to change
between specimens when multiple specimens are being
tested.

  Browse and 
  Extended

Search

These two buttons are used to find specimens. Their
primary purpose is in LDMS Specimen Management   ,
where they are used to search for specimens. Browse
is used to find exactly one specimen; Extended Search
is used to find a range of specimens. Extended Search is
also available in a few other places in LDMS to help find
specimens.

  Begin/Break This button is only used in LDMS Specimen Management 
  in conjunction with the    button. When you use 
 , you are limiting the specimens that are displayed.

Clicking    button removes this limited scope.

  Reports
(feature
specific)

This button's function is different than the    button. The
  button is used to generate reports that are specific to

whatever you are doing in LDMS at that moment. For
example, if used while setting up an assay in LDMS, it
will generate reports specific to your assay layout. If
you use it in LDMS Shipping    however, it will generate
reports specific to shipping specimens. When you are
doing something without any associated reports, this
button will be disabled.

  Close This button is used to leave a feature in LDMS. For
example, if you are using LDMS Specimen Management 

  and you want to move to LDMS Shipping   , you
must click the    button.

  Exit This button closes the LDMS program.

Keyboard Usage
Much of the work you will complete in LDMS is data entry. For these types
of tasks, working with just the keyboard can be a lot faster than switching
between the keyboard and a mouse pointer.

Many screens in LDMS are designs so that you can complete large sections of
them quickly using just the keyboard. In Specimen Management, for example,
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you can press the Tab key after completing each field to move on to the next
one.

LDMS menus can also be navigated using just the keyboard. Press the [Alt]
key. Notice that certain letters in the menu bar are now underlined? If you
press the corresponding key, those menus will open. You can also you your
keyboard's arrow keys to navigate menus.

LDMS also has several key combinations that perform a specific function.

Shortcut Toolbar Icon Description

Alt + F3 -- Close current task

Alt + F4 -- Exit the LDMS program

Ctrl + A Add record

Ctrl + D Delete record

Ctrl + G Refresh the screen

Ctrl + H -- Show a helpful description of the currently
selected item on the screen

Ctrl + S Save changes made on a screen

Ctrl + B (In Specimen Management) Exit restricted
scope when using extended search

Ctrl + E Display the last data record

Ctrl + P Display the previous data record

Ctrl + N Display the next data record

Ctrl + F Display the first data record

Ctrl + W (In Specimen Management) Open the Browse
feature

Ctrl + Z -- (In Shipping on the QA/QC tab) Pass the
selected aliquot

Ctrl + X -- (In Shipping, on the QA/QC tab) Fail the
selected aliquot

Getting Help
One of the unique things about LDMS is that Frontier Science, the not-for-
profit organization that develops and maintains LDMS, works closely with
both laboratories and research groups. These relationships allow LDMS User
Support and LDMS Training to cater to each laboratory's specific needs.

There is a lot of LDMS documentation available on the Frontier Science Portal.
Look for the LDMS Documentation and Training link under the LDMS User
Support heading. In addition to this manual, there are also small, topic-
specific reference and video tutorial that demonstrate how to use specific
features in LDMS.
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LDMS User Support is available to laboratories 24-hours per day, every
day. They can assist you by telephone or by e-mail. They can even connect
remotely to your LDMS computer to help. LDMS User Support can assist with
more than just technical issues—they can also answer your questions about
using specific features in LDMS.

LDMS Training is also available. In-depth training sessions are held at Frontier
Science's data management center in Amherst, New York several times each
year. There is no registration cost to attend these trainings (though travel
accommodations are not provided by Frontier Science). Frontier Science can
also arrange for a trainer to come to your site to assist you. Finally, web-
based conference calls can be setup as needed to address specific LDMS
usage topics.

LDMS Support Contact Information

LDMS User
Support

Email ldmshelp@fstrf.org or call (716)-834-0900
extension 7311

LDMS Training E-mail ldms.training@fstrf.org

Administrative
Support

E-mail ldmsinfo@fstrf.org

For the latest LDMS news and training information, visit the LDMS website.

Patient management

Adding a new participant
Participants can be added using the Patients task, although this is not
recommended.

Background

New participant enrollments are typically added to LDMS when specimens
are entered. The first time specimens are added with a new participant, that
participant will be created.

New participants can also be added using the Patients task, although this
practice should generally be avoided.

Steps

1. From the LDMS menu bar, click Tasks > Patients.
2. Click Add Row.

! Warning:  If you add more than one row, LDMS will treat each
each row as the same participant enrolled in different studies.
You cannot add two different participants at the same time.
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3. In the new row, select the group from the Group box.
4. In the Identifier box, enter the ID1 for the participant.
5. In the second and third identifier boxes, enter the ID2 and ID3, as

required by the group.
6. In the Clinic box, select the clinic with which this participant should

be associated.
7. From the LDMS menu bar, click Database > Add.

Finding and Modifying Participant Information
LDMS Patient Management    is used to add, view, or modify study
participants in LDMS. This isn't the only way to add patients in LDMS (you can
also use Specimen Management to add participants when entering specimen
information), but it is the only way to modify an existing participant's
information.

Figure 5: Patient Management Screen

You can bring up participants that have already been entered to add them to
new studies, change their identifier (e.g. to fix a data entry error) and to add
them to a new group.

Modifying an existing participant:

1. Click Tasks > Patient Management from the LDMS menu bar or click
the    button from the LDMS toolbar.

2. At the bottom of Patient Management screen, select the group from the
drop-down.

3. Select the identifier from the drop-down.
4. Click the Find button.
5. Modify the patient information as necessary, such as adding or deleting

rows, or modifying identifiers.
6. Click the    button from the LDMS toolbar.

A common change you'll need to make is updating patients enrolled in the
study NOSID. For many groups, it is acceptable to enter NOSID as the study
identifier when entering specimens. After the participant is assigned to a
study, you need to use Patient Management to update the patient information,
which will cascade to all previously logged specimens.
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! Attention:

If you entered specimens using NOSID, then (once an SID has been
assigned) you start entering specimens with the new SID, you will
end up with two different enrollments (one with the SID and one with
NOSID) when there is in fact only one. This mistake can be difficult to
correct and will usually require LDMS User Support's assistance.

Once a SID has been assigned to a participant previously entered with
NOSID, you must immediately update the NOSID before adding any
more specimens for that participant.

Merging Participants
Participants can be merged in LDMS with the assistance of LDMS User
Support.

Background

Suppose you realize that you have a participant with two different
enrollments. For example, you have two different participants enrolled in two
different studies, then later realized that these two participants are actually
the same person, and should have been listed under the same participant
record as two different enrollments. This could happen if, when entering the
specimens into LDMS, the user didn't add two rows to the participant grid and
instead entered each set of specimens separately.

LDMS can correct issues like this by combining participant records. This
feature, however, is not accessible to users. The reason for this restriction is
because incorrect use of the feature could significantly damage data in your
LDMS database in a way that would be difficult to correct.

If you need to combine participants, contact LDMS User Support. They will be
able to access this feature and make the correction for you.

Using OPID
OPID (Other Patient Identifier) is a field that can be used as a supplement
to ID1 (which is usually a PID, hence OPID) or as the primary identifier for
patients in LDMS.

To use an OPID for a participant, simply enter a value into the OPID column
when entering or modifying that patient's information.

Tip:

You can pre-populate the OPID in multiple rows by typing it into the
OPID box above the patient grid before clicking the    button. You
can also do the same thing with the clinic.
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Specimen Management
Tip:

Context-Sensitive Help in LDMS

For many fields in LDMS, press  Ctrl H  after selecting the field to open
a help window. This works in drop-downs in Specimen Management, for
example, to show you what address is associated with a clinic code or
what an additive code actually means. Whenever you don't know what
something is, select it and press  Ctrl H .

LDMS Specimen Management    is the place where specimen information is
entered and maintained in LDMS. This is where you can add new specimens,
correct issues with existing specimens, add new participants, assign tests,
mark specimens for shipment, etc. Specimen Management is the only place in
LDMS where new specimens can be created.

To work with LDMS in general, there are two important points to understand:

1. LDMS is aliquot-driven: Records in LDMS's internal database are organized
by primary and aliquot, and aliquots are the basic unit of information. All
actions in LDMS (testing, shipping, and storing) happen to aliquots.

2. LDMS is also group-driven: When a group is selected in Specimen
Management (and you must select a group), LDMS enforces rules for
specimen entry determined by leadership for that group. Frontier Science
works closely with network leadership to maintain each group's rules
within LDMS.

Important terms in LDMS

primary This is the sample that was collected from the
participant, such as a tube of blood.

aliquot This is the derived unit from the primary.

specimen This is a generic term for either primaries or aliquots.

specimen ID An identifying number assigned by LDMS to primaries
and aliquots that is not necessarily unique, and does not
show the relationship between primaries and aliquots. By
default, this number is unique per derivative type.

group Individual clinical trial networks, research groups, etc
available in LDMS. Every specimen and participant
enrollment must be associated with a group.

global specimen
ID

A number assigned by LDMS to every primary and
aliquot. It is unique among all specimens at all LDMS
laboratories, and clearly shows the relationship between
primaries and aliquots.
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participant (or
patient)

The individual from whom you've collected samples. The
words participant and patient are used interchangeably in
this manual.

participant (or
patient) ID

A unique identifying number assigned to each study
participant.

visit ID The combination of the visit and visit unit (such as 1 WK).

specimen date The date that the specimen was collected from the study
participant.

specimen time The time that the specimen was collected from the study
participant in 24-hour format.

received date The date that the specimen was received at the
processing laboratory, where the primary was processed
into aliquots.

received time The time that the specimen was received at the
processing laboratory.

processing time The time that the processing laboratory begins to process
a specimen into aliquots.

frozen time The time that specimen is put into a freezer and the
freezing process begins.

Specimen Identifiers
Every specimen in LDMS is assigned two identifying numbers: specimen
ID and global specimen ID. There is also a third identifying number called
the other specimen ID. LDMS does not generate the other specimen ID, nor
does it enforce any rules for its usage. It is there to accommodate unique
workflows, such as internal groups at a laboratory.

The global specimen ID is a unique number generated by LDMS for
every specimen logged. It is unique not just at your laboratory but at all
laboratories using LDMS. The global specimen ID is 10 characters long. The
last two characters are the aliquot sequence, with the first aliquot numbered
-01, the second being -02, etc. The aliquot sequence for a primary is -00.
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Figure 6: Global specimen ID format

An example global specimen ID; this number is unique for each aliquot and is assigned by LDMS.

The global specimen ID is not generated until you actually add the specimens
and aliquots to your database. Once used, the global specimen ID will never
be reused, even if the specimen is deleted.

Specimen IDs, unlike global specimen IDs, are not necessarily unique. They
are generated for a primary as soon as you've entered the primary and
additive type. By default, primaries with the same type and additive will have
the same specimen ID. For example, if you drew two vials of blood at the
same visit and used the same additive, you essentially have 2 specimens that
are the same. LDMS does provide users with the ability to customize how the
specimen ID is generated.

Figure 7: Specimen ID format

An example specimen ID; the six digit sequence resets back to 000001 at the beginning of each year.

Specimens Converted from RLMP

Early in LDMS's life, many specimens were imported from an another platform
called the Retrovirus Laboratory Management Program (RLMP). These
specimens have a unique specimen ID that you may encounter if you are
working with older specimens (or data from older specimens). They appear in
the format 048R98001145, where 048 is the LDMS laboratory number and R
indicates that the specimen was converted from RLMP.

The way LDMS generates specimen IDs (not global specimen IDs) can be
adjusted. If you do adjust it, the changes will take effect for new specimens;
existing specimen IDs will not be modified.

Changing the default method for generating specimen IDs:

1. Click Administration > Define Specimen Numbering.
2. Select one of the following options:
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• If you want all primaries to have the same specimen ID regardless of
additive, select No unique number.

• If you want primaries to have a unique specimen ID for each additive,
select Unique number for EACH additive.

• If you want the specimen ID to be unique for every primary, select All
unique number.

• If you want the specimen ID to be unique for each aliquot of each type
of derivative, select Unique number for EACH derivative.

3. Click the OK button.

! Attention:

You can only change the way LDMS generates specimen IDs once. If
you do change it, you will not be able to do so again.

Entering a New Specimen
Entering a specimen in LDMS is a multi-step process, and many networks
have their own rules and workflows. You should always follow the procedures
defined by individual groups. The material in this section should, however,
apply to most specimen entries.

Figure 8: Specimen Entry Workflow

The numbered call-outs are referenced in the steps below.

Entering a new specimen:

1. Enter the participant's information into the Patient Grid at the top of the
screen. (#1)

1.1. Select a Group (sometimes called the network or project) from the
drop-down. This must be done first because it affects other fields.

1.2. Enter ID1 for the participant. For many groups, this is called the PID
or patient identifier, and its format is specific to that group.

1.3. Enter ID2 for the participant. For many groups, this is a study or
protocol number.
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Note:

For most groups, studies are selected from a pre-populated
list. Studies can be added or removed by Frontier Science as
needed. If you are looking for a study but find that it is not
available, contact LDMS User Support.

1.4. Enter ID3 for the participant. This is often a sub-study number
though some do not require or use this field.

Note:

For networks that use ID3 for SID (study identifier), NOSID
may be a valid entry. You would do this when a SID hasn't be
assigned yet, then update the participant's information later
once it has been assigned.

1.5. Enter the Visit and [Visit] Unit for the this particular specimen
entry.

1.6. Enter the clinic for this particular specimen entry. If you want to
know what clinic is associated with a code, select it and press Ctrl +
H.

1.7. To enter additional information, such as whether or not the
participant was fasting, click the  

2. Enter the information for the first primary into the Primary Grid in the
middle of the screen (#2).

2.1. Enter the Spec[imen] Date from the drop-down. This is the date
that the specimen was collected from the participant.

2.2. Enter the Rec[eived] Date from the drop-down. This is the date
that the specimen was received by the processing laboratory.

2.3. Enter the Rec[eive]d Time into the bottom. This is the time (in 24-
hour format) that the processing laboratory received the specimen.

2.4. Enter the number of tubes collected for the primary into the # of
Tubes box. If you're planning to pool multiple primaries together,
enter one.

2.5. Select the Primary Type from the drop-down. If you need to enter
more than one type of primary, they must be added as separate
tubes.

2.6. Enter the Other Spec[imen] ID.
2.7. Enter the Spec[imen] Time in 24-hour format. This is the time that

the specimen was collected from the participant.
3. Click the    button (#3). This will add the number of tubes you entered

to the primary grid below.
4. For each primary added, select an Additive from the drop-down. After

doing this, the Specimen ID will be generated (the Global Specimen ID
isn't generated until you click the    button later.

5. For each primary added, enter the Volume and Units for the primary. It
is acceptable to pool primaries of the same type for the same participant
together. (e.g. two 10 ML tubes drawn from the same participant, with the
same additive, and the same specimen time can be entered as become
one 20 ML tube).
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6. Click a primary row to select it (it will be highlighted). When an aliquot is
added, they will be derived from this primary.

7. Enter information for the first aliquot into the aliquot grid. (#4)

7.1. Enter the number of aliquots that were derived from this primary
for a specific derivative type into the # of aliquots field. If you
have more than one type of derivative for the primary, they must be
added separately.

7.2. Enter the Vol[ume] and [Volume] Units for the aliquots. This is
the volume per aliquot, not the total.

Note:

CEL (cells) is expressed in millions in LDMS. For example, if
you need to enter 2 million CEL, enter 2 into the Vol field,
not 2,000,000. When you click the    button later to add the
records later, the volume will automatically be converted to
millions.

7.3. Select the Derivative type from the drop-down.
7.4. Select the Sub Add[itive]/Der[ivative].
7.5. Click the    (#5).

8. After all of the primaries and aliquots have been added, click the   
button from the LDMS toolbar.

9. If the group and ID1 combination have never been entered before, LDMS
will prompt you to add the new participant to LDMS.

10.LDMS will prompt you to print labels for your aliquots. Select the group
from the Format drop-down, the Barcode Content and label Size.

When you are entering specimens, you'll see all the primaries for a particular
visit, as well as all the aliquots derived from each primary on the same
screen. This is the only time you'll see all this visit information on the same
screen. Once you click the    button, the entries will be split up by primaries.
If you click the    button from the LDMS toolbar, you'll see the last primary.
Using the database navigation buttons    from the LDMS toolbar, you
can see that all of the primaries for the visit are now on different screens.

Figure 9: The Specimen Management screen before and after adding
records

The left side shows how a visit will appear when it is being entered; the right side shows how two different primaries

are split into two different records.
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Understanding the Specimen Management screen

The Patient Grid
The patient grid is the top portion of the LDMS Specimen Management   
screen. This is where you enter participant information for the specimens you
are about to enter. Specimens can only be entered for one participant at a
time, however, co-enrollments (meaning one participant who is enrolled in
more than one study) can be entered together.

Figure 10: The Patient Grid from the Specimen Management Screen

This image shows how one participant can be enrolled in two studies at once. In this case, the participant is enrolled in

ACTG/IMPAACT and FRONTIER studies.

Co-enrollments require additional handling when entering aliquots. Normally,
when the participant is in one study, the aliquot will default to the first group
(since it's the only group). With co-enrollments, you'll need to specify the
group for each aliquot for using the Group/ID field in the aliquot grid.

The OPID (other patient identifier) is an optional identifier that some groups
may utilize to track participant information instead of using ID1. LDMS is not
strict on the format OPIDs, so they can contain up to 15 letters and numbers,
as well as spaces. For some groups, OPID may not be available.

The    button opens up the details window. For participants, this only
has two fields: Time and Time Unit. These fields let you specify more details
about the visit. For example, you might select 12 for the Time and Fasting
for the Time Unit to indicate that the participant had been fasting for 12
hours at the time of the visit. You can tell if details have been set when the
button changes to a letter code. If it still reads "Details", then no options were
specified; if it says "T", that means the time fields were specified.

The Primary Grid
The primary grid is the middle portion of the Specimen Management screen.
This is where you enter information for the primaries that were processed.
The top half is used for entering information for primaries; once they are
added, they appear in the bottom half. You can enter as many primaries as
you'd like at once, provided that they are for the same participant and the
same visit.
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Figure 11: The Primary Grid from the Specimen Management screen

To delete a primary after adding it, select it and click the    button.

Times Fields in LDMS

There are several "time" fields in LDMS:

Time Description

Specimen Time Time specimen was collected from study participant

Received Time Time that the specimen was received by the processing laboratory

Processing Time Time that the processing laboratory began processing the specimen
into aliquots (i.e. the time that you opened the tube to start
processing)

Frozen Time Time that the specimen was placed in a freezer and the freezing
process begins

Time See below

The field labeled simply time in the primary grid has several purposes. It can
be used to indicate things such as the amount of time it took to process an
aliquot, the amount of time a study participant was fasting, and even how
many raw samples were pooled together to form the primary.

A separate time field can also be found in the patient details window. The
possible time unit values for this field are identical to the one found in the
primary grid.

The Time field is typically used when testing pharmacology specimens. You
can use the primary comments (found by clicking the Details button for the
primary) to clarify how the time field was used, if necessary.

Some of the information you specify for primaries can be cascaded to derived
aliquots. For example, if you had difficulty collecting a blood draw from a
participant, and only collected about 80% of the tube, you can change that
primary's Cond[ition Code] to SHV (short volume), and then cascade that
condition code to aliquots. This will help show why the volume for each aliquot
is slightly less than what would typically be collected for that visit. Cascading
information from the primary to aliquots applies to Cond[ition Code], Other
Spec[imen] ID, and much of the information in the    window. LDMS
will automatically prompt you if a change to the primary can be cascaded.
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Figure 12: Primary Details window

The Primary Details Window. Here, you can enter comments and set conditions that can be inherited by aliquots, and

specify who processed the primary into aliquots and when.

! Attention:

Specimen comments are included when shipping specimens to another
laboratory. They are also included with specimen records that are
exported to Frontier Science. For this reason, comments should never
contain protected health information or personal identifying information
like a participant's name.

A key feature on this screen is the ability to send ambient shipments. Ambient
shipment is the only way to ship a primary without creating aliquots (the
name "ambient shipment" refers to the fact that it is shipped immediately
after collection, usually at room temperature, instead of being frozen). To do
this, change Ambient Ship to Sent, and then select the intended destination
laboratory from the Ship To drop-down list. This will change the primary's
status to sent in LDMS.

This method of shipping a primary has a significant disadvantage: you can't
add the primary's information to a shipping file, meaning the destination
laboratory can't import it; they have to re-enter the specimen information and
manually enter the Specimen ID. The primary will also have a different global
specimen ID at your laboratory and the receiving laboratory.

To ship a primary in LDMS in such a way that it can be added to a shipping
file, create an aliquot with the exact same volume, derivative, etc as the
primary you are shipping, then ship that aliquot like you would any other
aliquot. This is referred to as creating a ghost aliquot.

The Aliquot Grid
The Aliquot Grid is the bottom portion of the Specimen Management screen.
The aliquots derived from the currently selected primary in the Primary Grid
are displayed. If a new aliquot is added, it is considered derived from the
currently selected primary as well.
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Figure 13: The Aliquot Grid

To add a new aliquot, complete the fields in the upper-left corner of the
aliquot Grid, and then click the    button. This will add as many aliquots
as specified in the # of Aliquots field into the list of aliquots below. To delete
an aliquot, simply select it and click the    button. You can select multiple
aliquots at once by holding down the Ctrl or Shift key.

! Attention:

Other Spec[imen] ID can be used as an internal specimen identifier
for both primaries and aliquots. There are no validation checks for
this field, which allows it to be flexible. If you work with laboratories
that are using LabWare version 1.x, however, you should leave this
field blank. When reading shipping files, these versions of LabWare will
incorrectly use the other spec ID instead of the global specimen ID
as the primary identifier for that specimen. If other specimen ID is not
present, however, the global specimen ID will be used correctly.

After entering an aliquot, you can modify it by simply changing a value in the
table, and then clicking the    button from the LDMS toolbar.

Tip:

Want to modify more than one aliquot at once? Simply select those
rows by holding down the Ctrl or Shift key and clicking them. Next,
enter your corrections in the fields where you enter new aliquots. For
example, if you want to correct the volume for multiple aliquots, enter
the corrected volume into Vol field in the top-left, then click   
button. This will cascade your changes down to all the selected aliquots.

If you are entering specimens for a co-enrollment (i.e. you entered two or
more rows in the participant grid), you need to select which group/study
combination will be assigned to the aliquot. To do this, click the Group/ID for
the aliquot to show the group drop-down list. From this list, select the correct
group and study combination.

The Aliquot Grid also has a handy right-click menu that lets you perform some
functions on multiple aliquots.

Aliquot grid right-click menu options

Modify all
selected

Same as the    button: cascade changes from the
entry fields above the aliquot grid to the selected aliquots

Delete all
selected

Same as    button: delete the selected aliquots

Frontier Science Foundation 36



LS.0005 | LDMS for Windows - User Manual

All selected
are never to be
stored

Marks all aliquots to never store; this means they will not
appear as available to be added to storage in LDMS; for
more information on never store, see

All selected can
be stored

If the aliquots have been set to never store, this removes
that flag

All selected
mark for
shipping

Makes it easier to find aliquots when setting up a
shipment. For more information on how this works, see
linkend="ship_finding-specimens-to-ship"/>-->

Frozen Date/
Time

Enter a frozen date time for multiple aliquots. This is the
same as opening up the Details Window for each aliquot
and entering the same information one at a time

Test Setup Assign an assay in LDMS to a specimen. A test must be
assigned to a specimen before you can actually setup the
assay to be read in LDMS.

Print Labels
for Selected
Aliquots

Re-print aliquot labels; same as when you initially added
the aliquots by clicking the    button

The right column in each aliquot row is the aliquot details button. It has a
series on single letter codes on it, similar to the primary details button. Click
it to open up the Aliquot Details window.

! Attention:

A lot of information in the Aliquot Details window can be cascaded from
the primary. For example, if you enter a condition code or processing
information for a primary, you will be prompted to cascade that
information to all aliquots derived from that primary. If you haven't
entered aliquots yet, some of this information will automatically
cascade when you add them. It's a good idea to review the aliquot
details just to make sure that something didn't end up in them that you
didn't intend.
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Figure 14: The Aliquot Details window

Most fields in the Aliquot Details window can be cascaded to other aliquots too . If you make a change, LDMS will

automatically prompt you if you want those changes to affect other aliquots of the same derivative type or all aliquots

on the screen.

Preloads: Templates for expected collections

Using Preloads
A preload is a template for LDMS Specimen Management    that fills out
the expected primaries and aliquot collections for a particular study and visit
combination. A preload is triggered by entering information into the patient
grid that meets the criteria for the preload. For example, a preload may be
triggered by a 1 WK visit for study S103. If you enter this information for the
participant, LDMS will prompt you if you'd like to use a preload.

A preload automatically fills out the expected specimen collections for that
visit. For example, if a study defines 3 vials on BLD on the visit 3 WK, the
preload will add those 3 primaries and the aliquots that are supposed to be
produced from them. This will save you a lot of data entry work.

There are two types of preloads: FSTRF-defined and user-defined. FSTRF-
defined preloads are created through collaboration between groups and
Frontier Science, and are sent to laboratories through deploys. These preloads
cannot be modified by individual LDMS users. Many groups also will not
allow users to define their own preloads for those groups as well, preferring
to define them at a leadership level instead. This is to prevent individual
laboratories from creating an incorrect preload and logging specimens
improperly. User-defined preloads are, of course, preloads created at your
laboratory. You're free to use these as you see fit, though you won't be able to
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create them for some groups. There are no limitations to creating preloads for
internal groups.

To see what preloads are available and how to trigger them you can do one of
the following.

1. Click Administration > Define Preloads from the LDMS menu bar. Here,
you can create, view, and modify preloads.

2. Generate the Preload List report, which is found by clicking Tasks >
Reports, then selecting Preload > Preload List.

Defining Preloads
For groups that are hard-coded into LDMS, you cannot define your own
preloads. Preloads for these groups are created by Frontier Science in
collaboration with individual group leadership.

New preloads created by Frontier Science are added to LDMS regularly.
Laboratories receive these updates when they perform an export. You can
create preloads for your own internal groups.

Figure 15: Define preloads screen

The define preload screen, showing a read-only FSTRF-defined preload.

! Attention:

You cannot create modify and save an existing preload that was created
by Frontier Science, nor can you use one as a base for creating a new
one. You won't see this message until you click the    or    button
on the LDMS toolbar. New preloads must be derived from ones that
you created or simply be new altogether. You can tell if a preload was
defined by Frontier Science by looking at the FSTRF Preload check box
beneath the preload name.

Creating a new preload

1. Click Administration > Define Preloads
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2. Enter a name for your preload into the Preload Name field or select a
saved preload to be modified as the base for a new preload.

3. Select the Comments check box and enter a message that will appear
to the user when the preload is triggered. This is commonly used for
providing instructions on the preload's usage.

4. In the Criteria section, enter the field values that must be met in
Specimen Management for the preload to be triggered. For example,
entering the study "14", visit "1", and visit unit "wk" will cause your
preload to trigger when that combination is entered. group is required;
other fields are optional.

5. Enter participant enrollment data that will automatically be added into the
patient grid when the preload triggers into the Patient Data Auto Fill 
section.

6. Click the Add button next to the Primaries fields to add a primary row.
Enter the information for the primary just as you would in Specimen
Management. Primary, Additive, Volume, and Volume Units are
required; other fields are optional.

7. With a primary selected, click the Add button next to the Aliquots section
to add a new aliquot to be derived from that primary.

8. Click the    button to add the new preload.

Figure 16: Primary and aliquot details windows for preloads

The primary details (left) and aliquot details (right) windows found in the define preloads feature.

The Details for primaries and aliquots are stripped-down versions of the
ones you can find in Specimen Management. The most notable feature is that
you can automatically mark specimens for shipment and select the intended
destination laboratory.

You can modify an existing preload (that you created) by selecting it from
the Saved Preloads drop-down, making your changes, and clicking the 

  button from the LDMS toolbar. You can also disable a preload, which will
prevent it from being triggered, by selecting the Preload Disabled check
box. Preloads can be deleted clicking the    button from the LDMS toolbar.
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What are condition codes
A condition code is a 3-letter code that indicates the status of a specimen.
Every primary and aliquot in LDMS has a condition code assigned to it. The
default condition code for new specimens is SAT (satisfactory), but there are
many others.

The majority of condition codes indicate a deviation from the expected
handling for a specimen. For example, if a specimen has supposed to be
collected in one type of tube but another was used, the INT (incorrect tube
type) condition code could be used to indicate this.

There are several places where the condition code of specimens can be
changed:

• In the Specimen Management    task, there is a Cond column in both the
Primary Grid and the Aliquot Grid that can be used to change the condition
code.

• In the Specimen Management    task, the condition code can also be
changed in the primary or aliquot Details windows.

• When importing a shipping file, the condition code for the specimens being
important can be changed.

• In the Storage Management    task, the condition code for all specimens
in a storage item can be modified together.

The most common use for condition codes is to use them in conjunction with
a preload, a feature in LDMS that automatically enters expected specimen
collection information when certain criteria is met when entering a new
specimen. For example, a preload may add 2 expected primaries. If the
participant decided during the visit that they did not want to be stuck with
another needle and only one of the primaries was collected, the second
primary added by the preload would not exist. While you could simply delete
the second primary, there will be no indication why the expected collection is
not available in LDMS. Was it not entered in error? Does it not exist? Was it
intentionally destroyed because the sample was of poor quality? At this point,
there is no way to know for sure.

Using a condition code can solve this problem. By changing the condition code
from SAT to SNC (sample not collected), you now know why the expected
specimen is not available. There's an additional option within the Details
window for aliquots called Reason sample not collected, which allows you
to specify the exact reason why it was not collected. By using condition codes,
you can document why an expected collection is missing.

Important:

Not all networks permit preloads, and some networks do not want
condition codes to be used in this manner. Always defer to instructions
specific to your network.

Whenever a condition code is applied, it is strongly recommended that you
add comments to the affected specimens to describe why the code was

Frontier Science Foundation 41



LS.0005 | LDMS for Windows - User Manual

applied. These comments can help investigators diagnose discrepancies with
study data without needing to contact your laboratory for clarification.

There is a related property to condition codes called never store. Never store
indicates that the specimen is not available (for example, because it was
never collected).

Procedural conditions
These specimen condition codes describe issues that can occur in the
collection and processing environment.

Table 3: Procedural conditions

Code Description Usage

ANP Aliquot Not Prepared Indicate that an expected aliquot was not processed,
but no other more specific condition code applies. The
reason specimen not collected box should be used in
conjunction with ANP.

EQF Equipment Failure There was an issue with the processing equipment, such
as a power failure during processing.

INV Invalid The specimen is not valid for testing purposes. Generally
another condition code, such as LBE or PST, would be
more appropriate.

LBE Laboratory Error The laboratory made a general error during processing,
such as setting equipment up incorrectly or mislabeling
specimens.

OPR Outside Protocol
Requirements

The specimen was drawn during the protocol-defined
window, but not in a manner consistent with the protocol.
For example, if a participant was supposed to be fasting
but was not, this code would apply.

OSW Outside Visit Window The specimen was collected correctly, but outside the
window for the visit as specified by the protocol.

PST Processed After Specified
Time

The specimen was collected and processed into aliquots,
but the processing was done after the time frame
specified by the protocol. This is commonly applicable for
PBMC and pharmacology specimens.

Specimen container conditions
These condition codes describe physical problems with the specimen’s
container. If there is a qualitative issue with the specimen as a result of the
container issue, a qualitative code may be more appropriate.

Table 4: Specimen container conditions

Code Description Usage

BKV Broken Vial The container was broken beyond recovery, such as being
dropped and shattered on the ground.

DMG Damaged The container is not leaking, but is damaged in another
way, such as a tear in a label or a dent in a plastic
container.
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Code Description Usage

EXP Expired The additive in a container, or some other component
used during specimen collection, was expired.

INT Incorrect Tube A tube type other than the one specified by the protocol
was used, and the tube used was determined to be an
acceptable alternative by the study team.

LKD Leaked The specimen leaked from the container, and it was placed
inside another container and recovered.

Temperature conditions
Temperature condition codes are typically applicable if there was an issue
during shipping (such as sublimed dry ice) or if a piece of storage equipment
failed. Other codes are applied as part of routine and expected handling of
specimens. For example the FRO condition code can be used to indicate that a
specimen intended to be stored ambient or refrigerated was frozen.

Table 5: Temperature conditions

Code Description Usage

DIM Dry Ice Melted The specimen was kept on dry ice, but the dry ice
sublimed. This does not necessary imply that the
specimen was damaged or TNO.

FRO Frozen The temperature of the specimen has been lowered
below its freezing point. This applies only to
specimens that were not intended to be frozen,
such as specimens that were shipped at ambient
temperature during the winter.

REF Refrigerated The specimen is cooler than room temperature but
not below its freezing point. This applies only to
specimens that were not intended to be refrigerated.

TNO Temperature Not Optimal The specimen was stored or shipped at any
temperature other than the temperature specified by
the protocol.

TWD Thawed The specimen was frozen, and has been warmed so
that it is no longer frozen. LDMS has a field to track
a thaw count, which can be used to keep track of
how many times the specimen has been thawed. This
information can be found on the Details Window for
the aliquot in Specimen Management.

Shipping conditions
These condition codes apply to issues with a specimen shipment where the
specimens are unaccounted for or were received late. If the shipping issue
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damaged the specimens, a temperature-related code such as DIM (dry ice
melted) may be more appropriate.

Table 6: Shipping conditions

Code Description Usage

DSH Delayed Shipment A shipment did not occur on schedule, but there is no
obvious damage to the specimens. If there was obvious
damage, a more descriptive, temperature-related code
(such as DIM or TNO) may be more appropriate.

LSH Lost Shipment A shipment was created and sent, but did not arrive at
the receiving laboratory. Neither the shipping nor the
receiving laboratory can locate it.

SNR Sample Not Received A data collection form, such as a CRF, was received, but a
specimen listed on the form was not received. This differs
from LSH in that only some specimens were not received,
compared to an entire shipment.

Qualitative conditions
These codes refer to the quality of a specimen. For example, if a blood
specimen clotted, this is a qualitative issue that could prevent processing.
If there was a qualitative or participant abnormality that would prevent
processing but no other code is applicable, the SNP condition code can be
used.

Table 7: Qualitative conditions

Code Description Usage

BLD Bloody The specimen, such as a throat swab, contained blood.

CLT Clotted The specimen has clotted, often because the additive did
not mix correctly with the specimen.

CTM Contaminated The specimen is visibly contaminated.

DCG Discharge present A specimen, such as a vagina swab, that contains
discharge material

HEM Hemolyzed A blood specimen that has hemolyzed.

HUM Humidity The specimen has been exposed to high humidity.

ICT Icteric There are excessive amounts of bilirubin in the specimen.

LIP Lipemic There is excessive fat content in the specimen.

LYS Lysed There has been a breakdown of cells in the specimen
other than hemolyzation.

NQA Real-time QA for viability
and viable recovery not
performed due to low
volume of sample collected

Used by a Leukopak processing laboratory to indicate that
the full specimen volume needed for PBMC viability and
viable recovery QA could not be obtained.
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Code Description Usage

SNP Sample Not Processed A generic code for when there is a qualitative issue that
prevents an otherwise correctly collected primary from
being processed into aliquots, but no other code applies.
The Reason sample not collected field should be used in
conjunction with SNP.

VPL Viability percentage may
be less than the expected
parameter

Used by a processing laboratory to indicate that the PBMC
viable percentage of the PBMC specimen may be lower
than what's expected.

VRU Viable recovery may
be outside expected
parameters (higher or
lower)

Used by a processing laboratory to indicate that the PBMC
viable recovery of the PBMC specimen may be outside
what is expected.

Quantitative conditions
These condition codes refer to the volume of specimen collected.

Table 8: Quantitative conditions

Code Description Usage

DFB Difficult bleed There was problems trying to obtain a blood specimen
from the participant, typically resulting in a lower volume
than was expected. This code is more specific than SHV,
which does not indicate why the volume was low.

QNS Quantity Not Sufficient There was not enough specimen available to create the
aliquot. For example, if specimen collected from the
participant was supposed to be 10 mL but only 5 mL was
collected, the aliquots that could not be created due to the
low volume would be considered QNS. QNS means there
is no volume at all for the aliquot, even though there was
some volume for the primary.

SHV Short Volume The primary or aliquot specimen has at least some
volume, but not the full expected volume.

SNC Sample Not Collected The primary specimen was not collected from the
participant at all. This might happen if the participant
declined to provide a specific sample.

Other conditions
These condition codes are either automatically assigned to specimens or
indicate some combination of issues. The default condition code that is
assigned to all new specimens is SAT (satisfactory).

Table 9: Other conditions

Code Description Usage

ANM Anonymized The specimen was created using the anonymization tool in
LDMS. This code is automatically assigned by LDMS and
cannot be assigned manually.

COC Combination of Codes More than one condition code applies; the comments field
in LDMS can be used to list the applicable codes.
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Code Description Usage

DSR Destroyed The specimen has been destroyed.

OTH Other There is something noteworthy or unusual about the
specimen, but no other available condition code applies.

SAT Satisfactory The default condition code for new specimens, indicating
that the specimen was collected, processed, and handled
as expected.

UNK Unknown Indicates that there is a significant gap in knowledge in
the specimen’s history. For example, if the specimen was
collected by another laboratory that was not using LDMS
and is several years old, and it may have been stored or
treated improperly, this code may be appropriate.

YST Did consent to storage The participant has provided consent to storage of the
specimen.

NST Did not consent to storage The participant did not provide consent to storage of the
specimen.

Correcting data
Most data in LDMS can be corrected by a user simply by changing it and
clicking the Save button from the LDMS toolbar. For example, if a specimen
date was entered incorrectly, the specimen can be located in Specimen
Management, the specimen date changed, and the records saved. Changes
that apply to a participant enrollment, such as PID or study, should be
made in Patient Management, not Specimen Management, to avoid creating
erroneous duplicate enrollments.

There are a few important points that need to be considered when modifying
LDMS data:

• Different groups have different policies on what data can and cannot be
corrected. If you are not sure if a group permits a specific change, consult
with leadership from that group.

• If the specimen data was exported to Frontier Science previously, you will
need to export again so that Frontier Science receives the corrected data.
You can determine if information for a specific specimen exports to Frontier
Science by looking at the Exportable field in the Details Window Specimen
Management.

• If the specimen(s) was shipped to another laboratory, correcting data at
the sending laboratory will not fix the error at the receiving laboratory.
Both laboratories must make the change.

• If you change data it will not be apparent to others who made the change
and why. LDMS has several data entry fields that can be used to help track
changes (see below).

• If labels were already printed, those labels may now have incorrect
information. LDMS will automatically ask if you would like to print new
labels when saving modified specimens.

! Attention:
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LDMS does not have an undo function. If you delete a record or click
the    button, the changes you made are permanent. Think carefully
before you act. If you're considering a significant change, or need to
change records that were imported or shipped to another laboratory,
contact LDMS User Support for assistance.

LDMS has several features to help users track specimen changes. All of these
fields are accessed by clicking the Details button for the aliquot or primary in
Specimen Management. These fields are described below:

Comments The comments field can be used to enter free-form
details about the change. So that others know about
the change, it is important that you use this field to
document it. Comments should include what information
was changed for the specimen, the original data, the new
data, the date it was changed, who made the change,
and why.

Condition codes Condition codes are 3-character codes that signify
certain properties about the specimen. For example,
the condition code DSR indicates that a specimen
was destroyed, while the code SHV (Short Volume)
indicates that the volume of the specimen is less than
was expected. The default condition code for specimens
is SAT , which indicates that the specimen is satisfactory
and was collected and processed as expected.

Reason sample
not collected

This field is a drop-down list on the details window that
can be used to specify why an expected specimen was
not collected from a participant. This field is typically
used in conjunction with condition codes such as SNC
(Sample Not Collected) that indicate that a specimen was
not collected.

When making a change to a specimen, you will be asked if you’d like to
cascade the change to aliquots, which can help if the data entry change
was made to the primary specimen or if multiple aliquots were affected. It
is important that comments are made at the aliquot level (instead of or in
addition to comments to the primary). The reason is because comments to
aliquots will appear on shipping manifests, whereas comments for primaries
will not.

Data corrections made for a specimen at one laboratory will not be
automatically synchronized with that specimen’s record at another laboratory.
For most data corrections, if the specimens were shipped, both laboratories
will need to make the corrections.
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Example corrections

Correcting an ID1 for a Specimen

In LDMS, ID1 is used to uniquely identify a study participant across many
visits (and even across multiple studies). The name for ID1 varies across
groups, including PID, PTID, MSCSID, etc. The integrity of this identifier is
very important.

For this reason, many groups have specific instructions on how to remediate
an error with an ID1 entry. Some groups will not permit any changes to an
ID1 after it has been entered; other groups may allow changes but only after
approval by the group has been given. The exact rules vary from group to
group, so it is very important to discuss the issue with the affected group
once the error is discovered.

If you do need to make an approved ID1 change, the safest way to do so is
to use the extended search feature in Specimen Management. This will allow
you to restrict Specimen Management to show only the affected records that
need to be changed. This will help ensure that you change all of the records
that need updated.

Important:

If you are unsure if it is acceptable to make a change to enrollment
information for a participant for a specific group, contact that group
for further guidance before attempting to make a change. Some
laboratories may also have their own stricter rules that prohibit
modifying enrollment information.

If a participant was entered incorrectly such that two different participants are
actually the same person this is a correction that you cannot make on your
own. You will need to contact LDMS User Support for assistance merging the
two participants.

After changing an ID1, corrected labels need to be printed and the specimens
re-labeled. If the specimens have been shipped to another laboratory, the
correction should be made at both laboratories as well.

Once all approved changes have been made, you should review the
affective participants and specimens in Specimen Management to ensure
that everything is correct. It is also important to confirm that any other
laboratories that had the specimen(s) have also made the changes, so that
LDMS data is consistent across laboratories.

Correcting specimen information (other than ID1)

When an error occurs to information other than ID1, groups generally allow
corrections. This would include things such as fixing an incorrect specimen
date or a specimen type code. If the specimens have been shipped to another
laboratory, both laboratories will need to make the changes.

Using Specimen Management or Patient Management, find the specimen(s) or
enrollments that were entered incorrectly. Correct the data that was entered
incorrectly. For aliquots that were affected by the change, open the details
window and explain what was changed in the comments fields. To make the
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change as transparent as possible, the following information in comments is
strongly encouraged:

• Field that was changed and its original value
• Who made the change
• When the change was made
• Why the change was made

If the comment was added it a primary, it must be cascaded to all aliquots
from the primary. The reason the comment must be added to aliquots is
because only aliquot comments will appear on shipping manifests. In addition
to this, if the data is exported to Frontier Science, only aliquot comments will
be exported. Once these changes have been made, click the    button from
the LDMS toolbar.

Example aliquot comment to document a data change

Aliquot volume changed from 1 mL to 10mL. This was a data entry error; the
specimen has been verified to be 10mL. – Dr Doe, 17-Jan-2014

Upon Saving, LDMS will automatically ask if you would like to re-print labels.
Depending on the label that was originally used and the data that was
corrected, the labels on the specimens may now have inaccurate information.
Laboratories may, at their discretion, re-print and re-label the modified
specimens.

If the specimens have been shipped, both the sending and receiving
laboratories would need to make the correction—the correction will not be
synchronized across laboratories for shipped specimens.

Note:

The specimen ID (but not the global specimen ID) can be manually
specified. You might want to do this if you deleted a primary and want
to re-enter it using the same specimen ID. Click Enter Specimen
ID before you click Add to add a primary. You won't see your entry
immediately, but when you click Add to add the primary, it will be
assigned the specimen ID that you entered. Once a specimen ID has
been assigned, it cannot be manually changed again.

Documenting specimens processed or frozen outside an expected
window

Many specimens have specific time requirements for processing. These
would include things like PBMCs, pharmacology, and single copy assay (SCA)
specimens. Such specimens need to be collected, processed, and frozen
following specific instructions.

LDMS has a set of condition codes that can be utilized when such specimens
are not processed as scheduled.
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Table 10: Condition codes for specimen processing exceptions

Code Description Usage

OPR Outside Protocol
Requirements

The specimen was drawn during the protocol-defined window,
but not in a manner consistent with the protocol. For example,
if a participant was supposed to be fasting but was not, this
code would apply.

OSW Outside Visit
Window

The specimen was collected correctly, but outside the window
for the visit as specified by the protocol.

PST Processed After
Specified Time

The specimen was collected and processed into aliquots,
but the processing was done after the time frame specified
by the protocol. This is commonly applicable for PBMC and
pharmacology specimens.

If these conditions apply, the condition code should be set cascaded to all
affected aliquots, or (if applicable) set at the primary. You should also use
the comments field in the Details window for the aliquots to explain why the
condition code was selected.

If the assay results are supposed to be entered or read by LDMS for the
study, but the assay will not be run due to the improper specimen handling,
you can document this in Specimen Management. Find the specimen(s) and
right-click on it to select Test Setup . Assign the test (if not already assigned),
but then select Test Not Run . Use the Reason field to indicate why the test
will not be performed.

Doing other things with aliquots

Finding Aliquots After Logging Them
In Specimen Management, you can use the database navigation buttons 

  on the LDMS toolbar move between specimen records. This is fine
if you only have a few dozen primaries. For larger laboratories, though, this
really doesn't scale.

There are several other ways to find records in LDMS:

1. Scan a barcode with LDMS Specimen Management    open and the record
associated with it will be displayed.

2. Use the Browse    feature when you need to find exactly one specimen.
3. Use the Extended Search    feature when you need to find a range of

specimens based on certain criteria.

The browse feature is accessed by clicking the    button from the LDMS
toolbar within Specimen Management. It is used to find exactly one, specific
specimen.
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Figure 17: The Browse window

After selecting the Group, the options available in many of the drop-down
lists below (e.g. Type 1, Type 2, etc) will change. Many of these are
enumerated with entries already in your LDMS database. For example, if you
select PID for Type 1, then the ID1 list will be populated with all of the PIDs
that have been entered for the selected group.

After entering search criteria, click the    button. Next, select the record
you want to see and click the    button. By default, only primaries will
be shown; select the Show Aliquots check box to also show aliquots in the
search results.

Extended Search is accessed by clicking the    button from the LDMS
toolbar. Unlike Browse, Extended Search is used to find a range of one or
more specimens, based on search criteria. You can then limit LDMS to only
displaying those records, and then use the database navigation buttons 

  to view records within a restricted scope.

Figure 18: Extended Search Window

Important:
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After clicking the    button, Specimen Management is in limited
scope. If you look at the LDMS status bar, you'll see this message:
Primary 1 of 13 (restricted scope)

This means using the database navigation buttons only moves within
these specimens. To leave restricted scope and see your full LDMS
database again, click the    button from the LDMS toolbar.

Using Never Store
Never store is a unique property that can be assigned to an aliquot in LDMS.
It means that a specimen is unavailable. An examples of a specimen to which
it would be appropriate to assign never store would be an aliquot that was
destroyed—it will never be stored or shipped because it no longer exists.

In LDMS, an aliquot set with never store will not appear on the Bulk Add
tab in LDMS Storage    . It will still appear on shipping screens and can be
shipped, but it will be highlighted in red.

You can see if an aliquot has never store assigned to it by clicking on the
aliquot    button in LDMS Specimen Management   . If the aliquot
hasn't been shipped or added to storage, this is also where you can change its
status to never store.

Some condition codes will automatically cause an aliquot to be flagged with
never store.

Table 11: Condition codes that will automatically assign never store
to a specimen

Code Description

ANP Aliquot Not Prepared

CDT Consumed During Testing

DSR Destroyed

LSH Lost Shipment

QNS Quantity Not Sufficient

SNC Sample Not Collected

SNP Sample Not Processed

SNR Sample Not Received

Marking Aliquots for Shipment
Marking aliquots for shipment makes them easier to find later when you're
setting up a shipment. Marking for shipment is not the same as creating
a shipment or adding aliquots to an existing shipment; it simply flags the
aliquots as intended for shipment. You are not required to mark aliquots
before shipping them, but doing so can make the processing easier.

Marking aliquots for shipment
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1. In the Aliquot Grid on the LDMS Specimen Management    screen, select
the aliquots to be marked for shipment (use Ctrl or Shift to select multiple
aliquots).

2. Right-click on the aliquots, then select All Selected Mark for Shipping.
(The Mark for Shipping option only marks the aliquot that was clicked,
not all the ones that are highlighted.)

3. Enter the Shipping Category, Intended Shipping Date, and Intended
Receiving Lab.

After marking aliquots for shipping, the    will show the I code, meaning
"intended for shipment".

The Shipping Category, Intended Shipping Date, and Intended
Receiving Lab correspond to criteria that you can search for on the Setup
Shipment tab in LDMS Shipping   . They correspond to MARKED SHIPS,
INTENDED REC LAB, and INTENDED SHIP DATE respectively. They have
no enforced semantic meaning (meaning if you selected monthly for the
Shipping Category, you're not locked into only sending that aliquot in a
monthly shipment), though you will see a warning if the intended and actual
destination differ.

Assigning an Assay to Aliquots
Similar to marking aliquots for shipment, aliquots can also be flagged to be
run on an assay. On the LDMS Assays    screen, you can then quickly find all
aliquots that have been assigned a specific assay but not yet tested.

Important:

You must assign the aliquot the assay before results can be read by
LDMS; this step is no optional. You will not find an aliquot in LDMS
Assays    until you assign it to a test.

Flagging an aliquot for an assay

1. Select the aliquot(s) to which you want to assign an assay from the Aliquot
Grid.

2. Right click on the aliquot(s) and select Test Setup.
3. Find the assay you want to assign, and double click on it; this will added it

to the Tests Setup table below.
4. Click the    button, and then click the    button.

! Attention:

Clicking the Done button without clicking the Save button will not save
your changes.

You'll see that the    button for the aliquots now has a T code on it,
indicating that the aliquots have been assigned a test. To remove the test
assignment, simply return to Test Setup, highlight the test, and click the 

  button.
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Re-printing Labels
LDMS will prompt you to print labels whenever you enter new specimens or
make changes to an existing specimen. You can also re-print labels manually
at any time.

Re-printing labels using LDMS Specimen Management  

1. Find the aliquot(s) to be re-printed in Specimen Management.
2. Click on the aliquots to be re-printed in the aliquot grid.
3. Right-click on one of the selected aliquots and select Print Labels for

Selected Aliquots.

This is not the only way to print labels after entering specimens. You can also
use the Labels feature by clicking    from the LDMS toolbar.

Entering special types of specimens

Creating Anonymized Specimens
Every specimen in LDMS is associated with a group and participant
identifier. This information is entered into the patient grid in LDMS Specimen
Management   . Using this information in conjunction with information from
other source could enable a user to determine a participant's real-life identify.
For certain work, such as blinded studies, this is a significant problem.

LDMS has a tool for creating specimens that have been stripped of identifying
information. This process is called anonymization. Anonymized specimens
are new specimens that have had certain identifying information removed;
the original specimen is not modified or deleted. The mappings for how
anonymized specimens are created are listed below.

Table 12: Anonymized specimen mapping

This table shows how fields are mapped from an original specimen to the new, anonymized specimen

Original Specimen Field Anonymized Specimen Value

group Changed to ANON

ID2/Study Not modified

PID Random number

Specimen ID New specimen ID assigned

Specimen Date Date of anonymization

Received Date Date of anonymization

Clinic ID empty

Other Specimen ID empty

Comments empty

Global Specimen ID New global specimen ID assigned

Visit Unit Changed to UNK
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Original Specimen Field Anonymized Specimen Value

Visit value Empty

OPID Empty

ID3 Empty

Specimen Time Empty

Processing fields (e.g. frozen date, initials, etc) Empty

Figure 19: The Anonymization screen

The anonymization screen. Note that some of the right-click menu options (such as Anonymize Aliquot apply to the

aliquot that was clicked, not the selected aliquots.

Creating anonymized specimens

1. Select Administration > Specimen Anonymization from the LDMS
menu bar.

2. Find the specimens that you want to anonymize. There are two ways to do
this:

• Import a text file list of specimen IDs or global specimen IDs.
• Enter search criteria to find and select the specimens to be anonymized.

3. To import a list of specimen IDs or global specimen IDs, click the   
button and select your file. This must be a list of either specimen IDs or
global specimen IDs, with one ID per line.

4. To search for specimens:

4.1. Drag the criteria you want to search from the Available Criteria list
on the left to the Selection Criteria on the right.

4.2. Select or enter a Value for each criteria.
4.3. Specify logic for the search in the Criteria Sentence box using

the numbers from the Selection Criteria list, using AND, OR, and
parenthesis (e.g. 1 AND (2 OR 3)) If no logic is specified, LDMS will
default to separating each criteria with AND (i.e. 1 AND 2 AND 3...
etc).

4.4. Click the    button to find aliquots that meet your criteria.
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Note:

Specimens that have been shipped, specimens in the ANON
group, and specimens with condition codes that indicate the
specimen does not exist (e.g. DSR) will not be displayed. Such
specimens cannot be anonymized.

5. Select the aliquots that you would like to anonymize. Hold down the Ctrl
and Shift keys to select multiple aliquots.

6. Click the    button below the search results.
7. You will be prompted if you would like to mark the specimens for

shipment. If yes, indicate the intended shipping information.
8. You will be prompted if you would like to change the derivative type for

the anonymized specimens. If yes, select the new derivative type.
9. You will be prompted if you would like to remove the original specimens

from storage and flag them as never store.
10.You will be prompted if you would like to view a report showing the linking

between the original and new specimens that were just anonymized. This
information can be obtained later by generated the Anonymous Patient
Map report in LDMS Reports.

Adding Bulk VQA Records
The VQA Bulk Plate Add feature can be used to create numerous specimens at
once for VQA panel testing. These specimens can later be added to a shipping
file for distribution to individual testing laboratories.

Figure 20: The Bulk VQA Plate Add Tool

The VQA Bulk Plate Add feature allows many specimens to be added using a small sub-set of LDMS's specimen entry

features.

Using the Bulk VQA Plate Add tool

1. Open LDMS Specimen Management by clicking the    button from the
LDMS toolbar.

2. Click the    button from the top of the primary grid.
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3. Enter the panel information into the top of the screen.

Note:

The Panel consists of the assay category, panel number, and panel
sub-type only, not the full PanelID. The specimen number refers
to the VQA specimen number for the panel, not the specimen ID.

4. Enter the Primary Type, Additive, Derivative, and Sub Add/Der for
the aliquots to be added.

5. Enter the volume for each aliquot into the Vol field and select the desired
[volume] units.

6. Select the desired test(s) to be assigned to each aliquot. Multiple tests can
be selected and assigned.

7.
Click the    button. Aliquots will be added below for each
specimen within the starting specimen number and ending specimen
number range that you specified.

8. If needed, repeat the above steps to add more aliquots to the list of
specimens to be added.

9. Click the    button from the LDMS toolbar.

When you are finished, click the    button from the LDMS toolbar to return to
LDMS Specimen Management. You can see the specimens you just added by
using the database navigation buttons    from the LDMS toolbar.

Pharmacology Specimens
Pharmacology protocols utilize the Time and Time Unit fields in the Primary
Grid to record the expected time point for the draw. For example, if you were
expected to draw a PK specimen at 2 hours, select 2 for the time  and hours
for the time unit. The Spec[imen] Time is stilled used to document the
time the specimen was actually drawn (in 24-hour format).

Intracellular Pharmacology specimens have a few extra fields for entry. When
you select the IPK derivative code for an aliquot, you'll automatically be
prompted to enter this information.

Entering Intracellular Pharmacology Aliquots

1. Enter the number of cells per aliquot into the Volume field and select CEL
from the Units in the aliquot grid.

2. Select the Derivative type IPK.
3. Click the    button to add the new aliquot. This will cause a dialogue

window to appear asking for the methanol volume for the aliquot.
4. Enter the methanol volume and units or select IPK Methanol Vol is not

available.

After entering the methanol volume, you can view or change it later by
clicking on the aliquot    button.

Pharmacology Controls
Note:
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This method of entering pharmacology controls should no longer be
used. Use the PK QA Lot Entry feature instead.

Pharmacology control specimens must be entered into LDMS Specimen
Management    before they can be used on a pharmacology assay.

Entering pharmacology control specimens

1. Open LDMS Specimen Management  
2. From the Group selection field, select CONTROL.
3. Enter the CONTROLNAME, PROTOCOL and (optionally) ID3.
4. Enter the date that the control specimen was prepared into the

Spec[imen] Date and Rec[ieved] Date fields.
5. Enter 00:00 into the Spec[imen] Time field.
6. Enter the number of control tubes into the # of tubes field, and then click

the    button.
7. In the Time field for the primary, enter 0.00 and select Random from the

Time Unit list.
8. Complete the remaining specimen information as normal.

Once the controls are added, you will also need to assign them to the PK
assay. You can do this while you create the control specimens by right-clicking
them in the aliquot grid and selecting Test Setup, or by using the Assign
Tests tool to locate specimens in the CONTROL group.

Culture Derivative
Culture derivatives are the specimen remnants after a culture is terminated.
Creating and terminating cultures is done in LDMS Assays. Since LDMS is
aliquot-based, you can't do certain things with a culture itself (such assigning
a storage location). To do these things, you'll need to create an aliquot (or
aliquots) derived from the culture.

Logging a culture derivative

1. Locate the aliquot in LDMS Specimen Management    that was used to
create the culture.

2. Click the    button.

Note:

If you receive a message that no cultures were found, it means that
you have not yet created the culture from this specimen in LDMS
Assays.

3. Select the culture from the top from which you will be creating an
aliquot(s).

4. Complete the aliquot information (# of Aliqots, Vol, etc) as appropriate.
5. Click the    button to create the aliquots.
6. You will be prompted as to whether you would like to specify a specimen

ID manually (which will be applied to all of the aliquots you are creating).
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Astro Numbered Specimen
Note:

This feature is currently only available for the internal group SIP-13.
This group must be created manually.

An astro number is a sequential hexadecimal number that is assigned to an
aliquot's other specimen ID. It is pulled from a range of numbers that were
specified by you. When entering an aliquot in LDMS Specimen Management 

 , LDMS picks the next available number within that range, and assigns it to
the aliquot.

Specifying the astro number range

1. From the LDMS menu bar, select Administration > Add Astro Number
Block

2. Enter an 8-digit hexadecimal number into the Starting Number and
Ending Number fields

3. Click the Add button.
4. After all number ranges have been assigned, click the Done button.

You can also remove numbering blocks this way as well. Blocks can only be
removed if they are not currently in use, which is indicated by the In Use
column. This means that a specimen has been assigned an astro number from
within that number range already.

In LDMS Specimen Management   , astro numbers are triggered and
assigned automatically, provided that you selected the SIP-13 group. The
astro number will be assigned to the other specimen ID for aliquots (but not
primaries). Each aliquot is assigned a unique astro number.

Entering Reagent Information
In LDMS, reagents are not specimens nor are they directly associated with
specimens. Instead, you can define a reagent used at your laboratory, and
the dates that it was used. You can compare this information to the date a
specimen was entered into LDMS to determine if that reagent was being used
at that time.

Adding a reagent into LDMS

1. Click Administration > Reagent Logging from the LDMS menu.
2. Complete the fields at the bottom of the screen as applicable for your

reagent.
3. Enter the date that use of the reagent began into the start date field.

Note:

The start date can be a future date, allowing you to enter planned
reagent use in advance.

4. (If applicable) Enter the date that the reagent was discontinued at your
laboratory into the End Date field.

5. Click the    button from the LDMS toolbar.

Frontier Science Foundation 59



LS.0005 | LDMS for Windows - User Manual

After a reagent has been entered, you can modify by selecting it from the
list of reagents, changing the desired fields at the bottom of the screen, and
clicking the    button from the LDMS toolbar.

Storage

The LDMS Storage Hierarchy
LDMS Storage    is a flexible tool for assigning aliquots to storage locations
and keeping track of them. Storage works on the concepts of containers and
levels, and represents the real-life physical arrangement of storage at your
laboratory.

LDMS distinguishes between a storage unit's configuration and a named
storage unit. For example, you might have dozens of boxes of a certain type,
then there is a specific box of that type called "Box 3, Specimens For Testing".
This distinction between the types of units and specific, named units allows
you to define the type of unit once, then reuse it. This applies to all storage
units, from the biggest freezers to small boxes.

The three types of storage units in LDMS (from biggest to smallest) are
freezer, level, and container. LDMS organizes these units in a tree structure,
such that a freezer holds levels, levels hold more levels or containers, and
containers hold individual aliquots.

Figure 21: An example storage hierarchy

This example shows the different type of storage units in LDMS and the corresponding visual representation.
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Figure 22: The Storage Tree In LDMS

LDMS organizes the three types of units (freezers, levels, and containers), as a tree.

In LDMS, creating a storage system is a three part process.

1. Define the configurations for your storage—that is, you need to create
templates and rules for storage containers, levels, and freezers.

2. Create the named storage units—that is, tell LDMS how the configurations
you created are setup in your real-life storage.

3. Add specimens to storage containers.

Getting around Storage Management
LDMS Storage    has multiple tabs. While each tab does something different,
many of them look very similar and some functionality is common across
multiple screens. The behavior of the    button is also a little different than in
other places in LDMS.

Table 13: LDMS Storage    tabs explained

Tab Name What You Do on It What the    Button Does

Main View View the contents of a level or
container

Add new freezers, levels and
containers

Container View View the contents of a container Add new freezers, levels and
containers

Move Move stored specimens and
containers from one location to
another

Add new freezers, levels and
containers

Configuration Create and modify level and
container configurations

Create a new container or level
configuration using inputs on the
screen

Freezer Cfg Create and modify freezer
configurations

Create a new freezer configuration
using inputs on the screen

Bulk Add Add one or more specimens to a
container

Add new freezers, levels and
containers

Compress This tab is disabled; rearrange a
storage container, use the Move tab

N/A
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Tab Name What You Do on It What the    Button Does

Search Find specimens in storage; purge
shipped specimens from storage

N/A

Transactions View changes made in storage N/A

On the Main View and Container View tabs, the    button from the LDMS
toolbar is used to display the contents of the currently selected freezer, level,
or container.

Main View vs Container View

The difference between the Main View and Container View tabs might not
be apparent at first. Both are used to view the contents of storage by finding
a container and clicking the    button from the LDMS toolbar. The Container
View tab is limited to only displaying the contents of containers, while the
Main View tab can be used to see levels as well.

The main difference is how they display information. The Container View tab
shows each location in the container in large, graphic representation (you'll
need to scroll to see all of them), whereas the Main View tab shows more
familiar, tabular information. The content that is displayed is identical. For
most users, the Main View tab will be more appropriate.

Defining a storage system

Defining a Freezer Configuration
The largest unit in LDMS Storage    is a freezer. A freezer contains one or
more levels, which contain containers, which hold individual specimens. A
freezer in LDMS isn't necessarily an actual freezer. For example, a refrigerator
is considered a freezer since it is the largest storage unit. The term freezer
was chosen simply because it is the most common large storage unit that
laboratories use.

The Freezer Cfg tab in LDMS Storage    is where you define a freezer
configuration. Like containers and levels, a freezer configuration must be
defined before a new freezer of that type can be created.. When the freezer in
the following example is added to storage (e.g. when the user creates a new
Big Cabinet freezer), it will automatically have these levels added exactly
as shown. Additionally, the user will be restricted to only adding 4x1 shelves
directly to freezers using this configuration.
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Figure 23: The Freezer Configuration tab

Levels and sub-levels are added to a freezer configuration by dragging them from the list on the left to the list on the

right. In this example, users will only be able to add a 4x1 level directly to the freezer.

Creating a freezer configuration

1. Enter a descriptive name for your freezer into the Label field.
2. Select the type of "freezer" from the Type list.
3. Select the operating temperature for your freezer from the Temperature

list.
4. Select a level from the Level Types list and drag it to the Configuration

Design list. You must add at least one level to the freezer configuration.

4.1. If the level is going to be a sub-level of another level, select the
parent from the Sub Level of list; if it is not a sub-level, leave this
field blank.

4.2. Enter the number of levels to add into the Number field.
5. After all levels are added, click the    button from the LDMS toolbar to

create the configuration.

You can modify an existing freezer the same way. Select the freezer from the
Configurations list in the top-left corner, make your changes, and then click
the    button from the LDMS toolbar.

Defining Containers and Levels
In LDMS, a container is considered a rectangular object with places for
individual specimens. It is the smallest storage unit in LDMS. An 8x8
container, for example, would contain 8 rows of 8 specimens, for a total of 64
aliquots in the container. Individual specimens have a unique storage position
using the container's coordinates.

Before a container can be used in LDMS, you must define the type of
container (its size, sorting method, etc) by creating a configuration for
it. Adding a container configuration is done in LDMS Storage    on the
Configuration tab.

Creating a storage container configuration

1. Select the Container radio button (this is selected by default).
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2. Enter the No. of Columns and No. of Rows for your container. These are
the dimensions for the number of specimens the container can hold.

3. If needed, select an Exclusion Type. This allows you define a specific
position, row, or column in the box that will not hold a specimens. For
example, by excluding the top-left corner, you can use the empty spot as a
reference point to determine which side of the box is the top.

4. Enter a descriptive name for the container into the Label field.

Tip:

To make it easier to re-use configurations, consider using generic
names. For example, 8x8 Box, no top-left corner could be used
for many groups, whereas Frontier Project Box implies that the
box can't be used for other groups.

5. Select the Labeling Method. This is how coordinates for the container
are labeled. You can chose from a combination of numeric or alphabetic
rows and columns. You can also chose Positions Only, which will assign a
number to each specimen slot instead of coordinates.

6. Select the Fill Order. This how LDMS will add specimens to a container
when positions are automatically assigned to specimens.

7. Select the format you want to use for coordinates from the Coordinates
list. You can chose between (row, column) or (column, row)

8. If the box's rows are organized in ascending order (e.g. F, E, D...) instead
of the default (A, B, C...), select the Reverse Row Labeling check box.

9. Click the    button from the LDMS toolbar to add the new storage
container configuration.

Figure 24: Example container configurations

Examples of the settings used for two different storage containers. The arrow indicates how the box will be filled; the

shaded location illustrates the two different ways of displaying coordinates.

Storage level configurations are created the exact same way as containers.
Storage levels have coordinates and positions just like containers. The
difference is that instead of holding aliquots, levels hold containers or other
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levels. For example, a storage level with 1 row and 3 columns would equate
to a shelf that can hold 3 boxes (one box per column).

Creating storage level configurations does offer one additional option, the
ability to set the Container for Level. This field lets you restrict a level to
only holding certain containers. For example, you can create a shelf that only
lets you add a specific type of box to it. If a level is to be restricted, it can
only be restricted to one specific type of container. If you anticipate needing
to use more than one container type, leave the Container for Level field
blank.

Modifying and Deactivating Containers and Levels
A container or level can be modified on the Configuration tab by selecting
it in the Storage Type list, making any changes, and then clicking the   
button from the LDMS toolbar. (To modify a level, select the Level radio
button instead; Container is selected by default).

If you want to remove a container or level, select it from the Storage Type
list at the bottom, then click the    from the LDMS toolbar.

However, You cannot delete a container or level configuration that is
currently in use. Instead, you must deactivate the storage unit. This prevents
users from adding more units of that type to your storage. To de-activate
a container or level, select it from the Storage Type list, unselect the
Configuration is Active check box, then click the    button from the LDMS
toolbar.

Storing Dried Blood Spot Cards
Figuring out how to define your storage is not always obvious. Certain
specimens doesn't easily fit into a box with rows and columns. These types of
scenarios may require some creativity to store things efficiently.

One such scenario is storing dried blood spots (DBS) cards that have multiple
blood specimens on them. Each blood spot may have its own, unique global
specimen ID in LDMS, thus a single DBS card isn't really a single specimen
that can be placed into a box. Putting the cards into, for example, a 1x20
container would not be correct since it doesn't account for the individual spots
on the card.

One way to solve this is to treat the spots on the card as columns in a storage
container. Each row in the container would be one card, and each spot would
be a column. The following image shows how this would be done with a DBS
card with 4 specimens on it.
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Figure 25: Dried blood spot cards in storage

The LDMS configuration (bottom) used to create a box of 40 DBS cards, where each card contains 4 blood spots.

Another way to approach this problem is to treat the DBS card itself as a
container (meaning you would create a 1x4 container), and then treat the
container that you are putting the cards into as a level. This would only work,
however, if your freezer needs only one level in it, since LDMS limits you to
two levels in a freezer. This would also require you to add many containers,
one for each card.

There are many types of unusual specimens and container needs that exist.
If you have trouble figuring out how to define a certain type of container in
LDMS to meet your needs, LDMS User Support can help you.

Creating a storage system

Adding and removing Freezers
Creating named freezers, as well as adding levels and containers to a freezer,
is done on the Main View tab in LDMS Storage    . You must create the
freezer configuration on the Freezer Cfg tab before adding the freezer.

Creating a new freezer in storage

1. On the Main View tab, click the    button from the LDMS toolbar.
2. You will be prompted to select the type of item you want to add. Select

FREEZER.
3. Select the freezer configuration that you want to use. You must have

already created the freezer configuration on the Freezer Cfg tab.
4. Enter a name for your freezer. This is for ease-of-use and can be changed

later. It is okay to use a group name as part of a freezer name, if that's
the freezer's primary purpose.

If the configuration used had levels added by default, you'll see those levels
were already added to the newly created freezer.

To remove a freezer, select it on the Main View tab, then click the    button
from the LDMS toolbar. The freezer can contain levels and containers when
it is deleted, but it cannot contain specimens; you'll need to remove the
specimens from storage or move them to another location.
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Assigning storage locations using Bulk Add

Steps

1. From the LDMS menu bar, click Tasks > Storage Management.
2. Click the Bulk Add tab.
3. Under Storage Structure, find the container where you want to store

specimens.
4. Optional: On the right side of the screen, enter any criteria for the

specimens you want to store.
If no criteria is specified, all specimens available for storage will be
listed after the next step.

5. From the LDMS tool bar click the Execute button.
6. From the search results, select the specimens to be assigned a

storage location.
Hold down the Ctrl or Shift key to select multiple specimens.

7. Drag the selected specimens from the search results on the right to
the intended storage container on the left.
A red box will appear around the storage container.

8. In the Specimen Position Selection window, do one of the
following.
8.1. Optional: Click Start Here and select the location in the storage

container for the next step.
8.2. Do one of the following.

• To assign the specimen to a specific location in the container,
select the location and click Put Here.

• To assign the specimen to the next available location in the
container based on the container's fill order, click Automatic.

• To assign all specimens to the next available location in the
container based on the container's fill order, click Auto All

If multiple specimens are being assigned storage locations, you
will be prompted for each specimen unless you click Auto All.

9. When prompted, indicate if you want to adjust the volume, frozen
date, or frozen time of the specimens.
If you select Yes,
9.1. Select the specimen to be modified.
9.2. In the corresponding box, enter the adjusted volume, frozen

date, or frozen time.
9.3. Click Modify.
9.4. After all changes have been made, click Save.
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Assigning storage locations using a barcode scanner
On the Bulk Add tab, you can assign specimens to a storage location be
scanning them using a hand held barcode scanner.

Background
This is the preferred method of assign storage locations to specimens.

Steps

1. From the LDMS menu bar, click Tasks > Storage Management.
2. Click the Bulk Add tab.
3. Under Storage Structure, find the container where you want to store

specimens.
4. Scan the specimen to be stored.
5. In the Specimen Position Selection window, do one of the

following.
5.1. Optional: Click Start Here and select the location in the storage

container for the next step.
5.2. Do one of the following.

• To assign the specimen to a specific location in the container,
select the location and click Put Here.

• To assign the specimen to the next available location in the
container based on the container's fill order, click Automatic.

• To assign all specimens to the next available location in the
container based on the container's fill order, click Auto All

If multiple specimens are being assigned storage locations, you
will be prompted for each specimen unless you click Auto All.

6. When prompted, indicate if you want to adjust the volume, frozen
date, or frozen time of the specimens.
If you select Yes,
6.1. Select the specimen to be modified.
6.2. In the corresponding box, enter the adjusted volume, frozen

date, or frozen time.
6.3. Click Modify.
6.4. After all changes have been made, click Save.

Bulk Add options
In the Storage Management task, on the Bulk Add tab, click the Options
button to toggle additional features.

These options will only last for the current session. If you exit and re-enter
the Storage Management task, will return back to their default settings.

Set Frozen
Date/Time to
Current Date/
Time

If enabled, specimens that do not have a frozen date
or time specified will have their frozen date and time
automatically set to the current date and time.
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Skip Volume
and Frozen
Date/Time
Adjustment

If enabled, you will not be prompted to change the
volume or frozen date/time for the specimens.

Automatically
Assign Positions

If enabled, you will not be prompted to assign storage
positions, and instead specimens will be assigned a
storage location based on the container's fill order.

Note:  The Set Frozen Date/Time to Current Date/Time option
can be made permanent by clicking Administration > System
Configuration from the LDMS menu bar. The option can be found on
the Storage tab. This setting will persist across LDMS sessions.

Removing a specimen from storage
Removing a specimen from storage removes its storage location assignment.

Background
Specimens that are removed from storage are not deleted. They can still be
found and viewed using the Specimen Management task and various reports.

Steps

1. From the LDMS menu bar, click Tasks > Storage Management.
2. Locate and select the specimen to be removed from storage.

You can select multiple specimens at once by holding down the Ctrl or
Shift keys.

3. In the LDMS tool bar, click the Delete button.
4. Optional: To assign the never store property to the specimen, select

the Permanent Delete From Storage option.
Never store means that the specimen will not be listed as available to
be stored again in LDMS.

5. Click Yes.
To remove all specimens that were selected without being prompted,
click Yes to all instead.

Maintaining storage

The Storage Structure List Explained
You may have noticed that the left side of the Main View, Container View,
Move, and Bulk Add tabs in LDMS is identical. This list is called the Storage
Structure and it shows your actual storage items and specimens. It also
allows you to set a few options for storage levels/containers, and storage in
general.

By selecting a storage item from the Storage Structure list and then clicking
the    button, you can access more options for that storage unit. This
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is similar to the details button in LDMS Specimen Management    in that
it allows you to assign comments to storage locations and mark items for
shipment.

Figure 26: The storage details window

The Storage Comments field allows you to add details about a storage level,
such as special handling instructions. These comments can also be viewed
in LDMS Specimen Management   , on the Aliquot Details window. Storage
comments, unlike Specimen Management comments, are not included when
specimens are shipped and will not be exported to Frontier Science; they are
for your internal use.

There is also an    button at the bottom of the list. This button allows you
to access two settings that affect how storage items are added and moved.

What does the Resequence button do?

You might think that the Resequence button on a the Details window is
used to re-arrange specimens in a box. In truth, the button is actually a
legacy feature for when many laboratories were converting data from RLMP,
another laboratory software program, to LDMS. The feature has not been
removed from LDMS, in the event that old data needs to be processed.

Adding Levels and Containers to a Freezer
Levels can be added to and removed from freezers on the Main View tab.
There are a few restrictions to how they can be added.
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• Every freezer must have at least one level. Containers must be added to
levels; they cannot be added directly to freezers.

• You cannot add more than one sub-level within a freezer.
• Levels that were not defined as part of your freezer configuration cannot be

directly added to a freezer (any level configuration, however, can be added
as a sub-level).

Adding levels and containers to a freezer

1. Select the freezer or level that will hold the new level or container.
2. Click the    button from the LDMS toolbar.
3. You will be prompted to select the type of item you want to add. Select

LEVEL or CONTAINER as appropriate.
4. Choose the container or level that you want to add.
5. (For containers only) Enter the number of containers that you want to add

to the selected level. If you need to cancel at this point, enter 0.

Just as with freezers, you can remove levels and containers by selecting
them, and then clicking the    button from the LDMS toolbar. The level or
container cannot contain any specimens when removing it.

Modifying All the Specimens in a Container
LDMS has a feature for changing the condition and specimen comments, and
assigning the never store property to all specimens in a storage item at once.
This feature can be useful if something happened to all of the specimens in a
storage container. For example, if a freezer failed, you could use this feature
to change the condition code for all of the specimens to thawed.

To access this feature in the Storage Management    task, find the storage
item in the Storage Structure on the left side of the screen, then right-click
on the container and select Bulk Update Specimens of Container. Due
to the large amount of data this feature can modify at once, using the bulk
update feature requires a challenge password from LDMS User Support.
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Figure 27: Bulk specimen update window

The bulk specimen update window. The comment will be added to the specimen comment, not the storage comment.

Shipping a Storage Unit
LDMS allows users to ship entire units. This is often easier and faster to do
than selecting individual specimens to ship. Specimens can be added to a
shipping container within a freezer, and then the container, level, or freezer
itself can be shipped.

Shipping storage units is a two step process. First, you need to mark the
storage unit for shipment, then you need to actually add it to a shipment in
LDMS Shipping   . Unlike shipping individual specimens, you must mark the
storage unit for shipment, otherwise it will not appear in LDMS Shipping    as
available to ship.

Marking a storage unit for shipment

1. Select the storage unit that you want to ship from the Storage Structure
list.

2. Click the    button.
3. Click the    button.

A storage unit cannot be marked to ship if any specimens or storage units in
it have been shipped (which is indicated by a  icon next to it) or added to a
shipping batch (indicated by a  icon).

Note:

While you are permitted to ship a container without any restrictions,
you will be prompted to contact LDMS User Support for a challenge
password if you want to ship a level of freezer. This is because shipment
of such a large storage unit generally requires coordination with group
leadership and multiple laboratories.
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The same process is used to un-mark the storage unit for shipment. If a
storage unit has been added to a shipping batch in LDMS shipping   , it must
be removed from the batch before it can be un-marked in LDMS Storage   .

How LDMS Storage Handles Shipped Specimens
Specimens go through a two-part process when they are shipped in
LDMS. First, they are added to a shipment (also called a batch). Next, the
user creates a shipping file from that batch that contains the specimen
information. This shipping file is sent to a receiving laboratory, where it is
then imported into their LDMS database.

At no point during this process, however, does LDMS Storage    remove
specimens from the sending laboratory's storage. This means that when you
send a shipping file to another laboratory and they import it, both laboratories
now have the exact same specimen in LDMS. The Storage Structure list
shows the shipment status of a specimen with an icon next to its name.

This is what each icon in the storage structure means.

Specimen has been added to a shipping batch

Item has been marked for shipment

A shipping file with the specimen has been created (e.g.
the specimen has been shipped)

You will need to periodically find and remove shipped specimens from your
LDMS Storage   . This will remove the specimens from storage, and since
shipped specimens will not appear in the Bulk Add tab, you won't be able to
add them to storage again. This only removes the specimens from storage;
they will still appear in other places in LDMS, such as Specimen Management.

Removing shipped specimens from LDMS Storage   :

1. In LDMS Storage   , select the Search tab.
2. Click the    button.
3. Enter a Beginning and Ending date to find specimens with a shipment

date within that range. If you leave these blank, LDMS will find all shipped
specimens in storage.

4. When prompted to purge items from storage, click Yes.

LDMS does not have a way to automatically perform this purge; you must do
it yourself. A good practice would be to remove specimens after sending the
physical shipment to the laboratory. If you purge them without contacting the
receiving laboratory, you run the risk of something being wrong and no easy
way to diagnose the problem.

Moving and Re-arranging Stored Items
Moving specimens between different containers (and within the same
container), as well as moving levels within freezers and other levels, is done
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on the Move tab within LDMS Storage    . This is also how you would re-
arrange a storage unit's content.

Moving specimens or storage containers

1. Find and select the storage unit to be moved from the Storage Structure
list on the left.

2. Find the destination storage unit from the Destination list on the right.
3. Select and drag the storage unit to be moved from the left side to the

right.
4. Place the storage unit or specimens into the destination by doing one of

the following:

• Select a location in the container, and then click the    button.
This must be done for every unit being moved. The order they are
added is the order in which they were selected.

• Select a starting location in the container, select the Start here check
box, and then click the    button. This will place the specimen into
the container based on its fill order, starting with the selected location.
This must be done for every storage unit being moved.

• Select a starting location, select the Start here option, and then click
the    button. This will add all specimens being added based
on the container's fill order. This will also enable the Automatically
Assign Positions option for the remainder of your LDMS Storage
session.

! Warning:

There is no undo functionality when performing a move. Since moves
take effect immediately, you will need to correct any mistakes by
moving specimens or containers to the correct location.

Tip:

If you want to re-arrange a unit's contents, such as rearranging
specimens in a box, simply move them to the same container. For
example, if you move specimens from one box, to the same box, you'll
be allowed to select new locations for them.

Finding Specimens in Storage
You have a few options for finding a specimen that is in LDMS Storage   :

• Open the Main View tab and just scan the label with a bar code reader
(this only works if you have the specimen in front of you or reprinted its
label).

• Browse the Storage Structure list
• Use the simple search feature, accessed by clicking the    button

below the Storage Structure list.
• Use the Search tab

Simple Search is used to locate a specimen with a specific Specimen ID,
Global Specimen ID, or Other Specimen ID. You can limit your search to a
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specific storage location by using the Narrow Your Search fields. If you
need more advanced searching, use the Search tab.

Figure 28: The storage search tab

On the search tab, you can also click the    button from the LDMS toolbar to access the more familiar extended

search feature.

To search, enter criteria to search, and then click the    button from the
LDMS toolbar. Specimens that meet all of your search criteria that are in
storage will be displayed at the bottom of the screen. Specimens that are
not in storage or do not meet all your search criteria will not be displayed.
For example, in the above image, the user has specified the Group to be
Frontier and they have also entered one or more items in the Global |
Other | Specimen ID field. Even though there are many more specimens
in storage that are in the Frontier group, only the ones that also match the
specimen IDs specified will be displayed.

Searching by Specimen ID and Global Specimen ID can be confusing. Here
are a few key points:

• The field Global | Other | Specimen ID accepts Specimen IDs, Other
Specimen IDs, and Global Specimen IDs.

• The only Specimen IDs/Other Specimen IDs/Global Specimen IDs that
will be shown will be the ones in the list below the Global | Other |
Specimen ID field. They are added to this list by using the Add button or
the <- button.

• Clicking the    button will find all specimens in storage that meet the
search criteria you've already entered and display them in the Specimen
List box (this is identical to clicking the    button) . You still need to select
the specimens, and then click the <- button to move the specimen to the
box to the right.

• Clicking the    button will import a text file list of specimens to
search. This text file must have one global specimen ID per line.

Tip:

You can also use the Extended Search feature to find specimens
in storage by clicking the    button from the LDMS toolbar.
Extended Search works the same way that it does in LDMS Specimen
Management   .
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Storage Reports
There are a number of reports that are available within LDMS Storage    .

Storage reports

Empty Storage
Locations
Report

List storage positions by container that do not have any
specimens. Empty level locations are not shown; only
containers. To find this report, select a level from the
Storage Structure list, click    then select Empty
Storage Locations Report

Container
Report

List specimens in a container, along with pertinent
details, organized by container. To find this report, select
a level from the Storage Structure list, click    then
click the Spec Report button.

Storage Detail
Report

Shows basic information about specimens that were
found on the Search tab. You must click the    button
from the LDMS toolbar to generate search results before
generating the report. To find this report, go to the
Search tab and click the    button from the LDMS
toolbar.

Note:  When generating this report for PHIA
samples, the following additional headers are
displayed:

• Header that displays a comma separated list
of file names that were uploaded using the
Import Specimens button

• Header to be filled in to describe the purpose of
the report

Storage
Transactions
Report

Shows saved transactions that were found or (if no
search criteria was entered) all saved transactions. To
find this report, go to the Transactions tab and click the
  button from the LDMS toolbar.

Specimens
Stored from
Bulk Add Report

Shows specimens that have been added to storage using
the Bulk Add tab. To access this report, click the   
button on the Bulk Add tab.

Storage Move
Report

Shows specimens that have been moved to a new
location within storage on the Move tab. To access this
report, click the    button on the Bulk Add tab.

Specimens not
in Storage

After generating search results on the Bulk Add tab by
clicking the    button, click the    button from the LDMS
toolbar. This report shows specimens within your search
results that are not currently in storage.
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There are more storage reports available in LDMS Reports   .

Storage Change Log (Transactions)
LDMS automatically tracks changes that you make to storage. The record of
each change is called a transaction. When you exit LDMS, these transactions
are automatically deleted. The change still happened; only the record of it is
not saved.

For some networks and at some laboratories, you may need to have audit-
able storage records on hand. To keep records of storage transactions, you
need to manually save them. Saving a transaction is also synonymous with
creating a comment for the transaction.

! Attention:

LDMS will not save transactions automatically; you must do this. If you
exit LDMS entirely without saving them, they are lost forever.

Figure 29: The Transaction tab and Storage Open Transactions
window

The Storage Open Transactions window shows changes that were made during the current session. These records

must be saved by you or they will be lost when you exit LDMS.

Saving records of transactions from the current session:

1. On the Transactions tab, click the    button.
2. Select the transaction(s) that you want to save. Hold down the Ctrl or Shift

key to select multiple transactions.
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3. Click the    button.
4. Enter a comment for each transactions. This comment can be used to

track why you saved a transaction or what was significant about it. If you
do not wish to enter a comment, leave it blank and simply click the Save
button.

5. If you selected multiple transactions, you can use the same comment for
all of them (instead of being prompted for each transaction) by selecting
the Apply comment to all check box.

If there are any transactions that have not been saved, you will be prompted
to view them when you try to leave LDMS Storage    . It's a good idea to
review them and make sure that there are none that you need to save. You
can use the Delete button to remove unsaved transactions that you know
you don't need to save; the Clear button can be used to remove all unsaved
transactions.

To view saved transactions, simply enter your search criteria (such as a date
range or a type of transaction) and click the    button. Saved transactions
will appear at the bottom.

How to view saved transaction comments:

1. Select the transaction that you would like to view.
2. Click the    button from the LDMS toolbar.
3. If you want to modify the comment, you can do so, and then click the

Save button.

Tip:

Want to view a summary of saved transactions and comments? Search
for them and then click the    button from the LDMS toolbar. This will
generate the Storage Transactions Report. If you run this report
without searching, you'll find all saved transactions.

Locating Specimens not in Storage
Accurate storage locations, processing times, storage conditions, and other
information are vital to the long term study of specimens that your laboratory
has in its possession. If the location where a specimen is stored is not
documented using LDMS's Storage    tool, it could be very difficult to locate
it in the future.

Important:

Several clinical trial groups require that all specimens be logged using
LDMS Storage   . Data management centers work with these networks
to monitor the storage status in data that your laboratory has exported,
and may contact laboratories to ensure that the mandates for these
networks are being enforced.

LDMS has a built-in report that will tell you what specimens do not have
a storage location documented in LDMS. You can use this report to find
specimens and add them to storage.

Generating the Specimens Not In Storage Report
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1. Click Tasks > Reports or click the    button from the LDMS toolbar.
2. Select the Storage Reports category, and then select the Specimens

Not in Storage report.
3. Add a group filter at the bottom of the screen if you want to only show

specimens for a specific group.
4. Click the    button from the LDMS toolbar.

If you need a more flexible report, you can also use LDMS's data retrieval tool
to create a custom report. Simply create a report that selects and displays the
global specimen ID, stored, and never store fields, and then sort by the
stored field.

Note:

It is important to look at both the stored and never store fields. The
reason being is that a specimen that has been flagged as never store
would appear as not stored, even though you would never be expected
to store it.

Shipping
In LDMS, shipping specimens is the process of transferring specimen
information from your local LDMS database to the database of another
laboratory. It would be more accurate to say that a shipment in LDMS is
actually a shipping file, not a container of specimens. You are shipping a file
to another laboratory, and they read the file to add specimens to their LDMS
database. It is a parallel process to physically sending specimens to another
laboratory.

LDMS can...

• Prepare a shipping computer file, which must then be sent to the receiving
laboratory (on a CD, via FTP, attached to an email, etc); this file contains
LDMS data for the specimens.

• Read a shipping file received from another laboratory, and add those
specimens to your LDMS database.

• Create and print lists to help you pull specimens being shipped from
storage, as well as manifest lists to include with the physical shipment.

• Provide tools to help verify that the physical specimens received match
those in the shipping file that was received.

• Create shipping files for laboratories not using LDMS.

LDMS can not...

• Transmit shipping files or shipping information directly between
laboratories; users must do this manually (e.g. on a CD-RW packed with
the specimens).

• Keep LDMS databases at laboratories in sync. For example, if an aliquot
is shipped from one laboratory to another where it is later destroyed, the
initial laboratory will still have that specimen marked as "shipped" while the
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receiving laboratory will have it as "destroyed"; the destroyed status does
not get sent back.

• Assist with actual shipping (printing mailing labels, arranging pick-up,
etc); individual laboratories need to develop their own workflows for those
processes.

• Track in-progress shipments or notify the receiving laboratory of incoming
specimens.

To ship something in LDMS is a multi-step process that happens at both the
sending and receiving laboratory. At a high level, the sending laboratory
marks specimens for shipment, then prepares a shipping file and paperwork.
They send the shipping file (through some method outside LDMS) to
the receiving laboratory, along with the actual specimens. The receiving
laboratory imports this data into LDMS and reviews it to make sure the
specimens that were expected were actually received.

Figure 30: Typical workflow for shipping specimens with LDMS

The left side shows the steps performed by the sending laboratory while the right shows the receiving laboratory.

Preparing shipments

Creating a New Shipment
Shipments are organized into batches. A batch is simply one shipment, either
sent or received. Each batch has a batch number, which uniquely identifies
the shipment in your local LDMS database.

Important:

A batch number is not consistent between different LDMS
laboratories. Each batch is assigned a sequential number, with the
first batch starting at 1. When a shipment is imported at a receiving
laboratory, it is assigned the next available batch number at that
laboratory. As a result, the same shipment may have a different batch
number at the sending and receiving laboratories.

Overview of creating a new batch
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1. On the View Shipment tab, select the bottom, blank row from the batch
listing. This row is designated for new shipments.

2. Change to the Setup Shipment tab. You will be prompted whether you
want to ship Specimens (i.e. aliquots) or ship Storage Items, meaning
boxes or other storage containers that contain multiple specimens.

3. Add items to your shipment.

• If shipping a container, select the containers that you want to ship and
click the Add to batch button.

• If selecting individual aliquots to add to the shipment, search for them
and select them.

4. Change to the Shipment Destination tab. Select the person or
laboratory to whom the shipment will be sent.

5. Click the    button from the LDMS toolbar. This step creates the new
(currently unsent) shipment.

The new batch can be found on the View Shipment tab. This batch will be
the last batch on the list. It will have the status of batched, which means it
has been prepared but not yet shipped.

Finding Containers to Ship

It is possible to ship any storage unit in LDMS,1 whether it be a container of
specimens or an entire freezer. Shipping a container is in fact one of the most
expedient ways to send aliquots to another laboratory. Simply add them to
the container in LDMS Storage    , then just ship the container. For many
laboratories, this is a lot more efficient and a lot easier than finding all of the
individual specimens that need to be shipped.

To ship any container, it must be marked for shipping in LDMS Storage   . If
it is not marked in LDMS Storage    , it will not appear as available to Ship.

To select a container to ship, change to the Setup Shipment tab and select
Storage Items button.

1 Although large containers like freezers and shelves can be shipped, they
will require approval. You will automatically be prompted by LDMS to
obtain this approval.
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Figure 31: Adding storage items to a shipment

On the left are marked storage items; on the right are storage items that have been added to the shipping batch. To

move a storage item, select it and click the Add to batch or Remove from batch button respectively.

Finding Specimens to Ship
If you want to individually select specimens to ship (as opposed to shipping a
container from storage), there are a few ways to do it:

• Use a text file containing a list of global specimen IDs
• Use the search features on the Setup Shipment tab
• Use the extended search feature on the Setup Shipment tab
• Scan them with a barcode reader

Figure 32: Selecting individual specimens to ship

The Setup Shipment tab. The selected specimens are those that will be added to the shipping file. Specimens in red are

marked as never store.
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Finding specimens for shipment on the Setup Shipment tab

1. Select Government if you want to ship specimens from a built-in
government group or select Internal to ship specimens from an internal
group at your laboratory.

Note:

You cannot ship government and custom-group specimens together
in the same shipping file. If you need to ship both government
and internal groups, you will need to create two separate shipping
batches.

2. Select a group from the Group drop-down list (simply selecting it adds it
to the criteria to be searched; the group won't appear in the list of search
criteria on the right though).

3. Select a Type (i.e., field) and an ID (i.e., value), and then click the arrow
button to the right to add it to the list of search criteria.

Note:  The Import Specimens button can be used to import lists
of Global Specimen IDs, Specimen IDs, or Other Specimen IDs into
LDMS.

4. After adding all desired search criteria, click the    button from the LDMS
toolbar. This will bring up all the aliquots found that meet your criteria.

5. Click individual aliquots to select them and add them to the shipment.
Hold down the Ctrl and Shift keys to select multiple aliquots.

Important:

If you change the search criteria to something more narrow and then
click the    button again, you'll notice that aliquots that don't meet
your new criteria are still displayed. This is because the search results
are concatenated together. What you need to do is click the   
button, which will clear your previous search results, and then click the 
  button again. Don't click the    button on the LDMS toolbar; that

will actually clear your search and all the criteria, taking you back to
the beginning.

If you need more refined searching (such as using AND/OR logic) you can use
the Extended Search feature, which is accessed by clicking the    button
on the LDMS toolbar. This works the same way as it does in LDMS Specimen
Management   .

Marking Items for Shipping: What's the Point?

You can mark items for shipment in Specimen Management, setting the
intended shipment date and destination. This allows you to specify the intent
to ship while entering a specimen.

You might think that the    button on the LDMS toolbar works the same way
when no search criteria is specified in LDMS Shipping    that it does in LDMS
Assays—that is, it finds all specimens that have been marked for shipping.
This is not the case; if no search criteria is specified, LDMS Shipping will show
you every specimen available at your laboratory.
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Marking an aliquot for shipment is still very useful, you just need to know
where to search. The table below shows how the fields on the Details screen
in Specimen Management correspond to fields that can be searched in LDMS
Shipping   .

Table 14: Fields to search for finding marked specimens

Field in Specimen Management  Field (i.e., Type) to Search in Shipping  

Shipping Category MARKED SHIPMENTS

Intended Shipping Date INTENDED SHIP DATE

Intended Receiving Lab INTENDED REC LAB

While LDMS does not enforce the usage of these fields, you will receive a
warning if you attempt to ship an aliquot to a destination other than the
Intended Receiving Lab.

If you establish a good workflow at your laboratory, marking specimens for
shipment can be a very useful, time-saving tool.

Selecting a Shipment Destination
LDMS shipping files can be generated for any laboratory. If the intended
destination uses LDMS, all you need to do is select it from a list. If the
laboratory is not using LDMS, you will need to enter additional information.
This is done on the Shipment Destination tab.

Shipping to an LDMS Laboratory:

1. Select either the Contact, Lab Number, or Lab Name radio button,
depending on which you want to look for.

2. Select the appropriate contact or laboratory from the drop down list.
3. Review the address information that was populated.
4. Select the person who should receive the shipment at the receiving

laboratory from the Contact at Sending Lab section on the left; you can
also enter in a new contact and telephone number.

5. Enter any additional comments for the recipient into the comments
box; this information will appear on the shipping manifest and should not
contain PHI or PII.

Shipping to a Laboratory without LDMS:

1. Select the Lab Number radio button.
2. Select one of the following:

• Select 0-Unassigned Lab Code if this will be a one-time shipment or
if the shipment is intended for a laboratory using Labware that has not
been assigned an LDMS laboratory ID

• Select 999000 Select to Enter New Address if you want to save the
address for future use.

3. Enter the receiving laboratory's information; the contents of the comments
field will appear on the shipping manifest and should not contain PHI or
PII.
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4. Click the Save Address button.

If you elected to save the address for future use, it will now appear in the
laboratory drop-down with the laboratory ID number 999xxx, where xxx is
the next available number.

If you've selected all the aliquots that you want to ship and the shipping
destination, be sure to click the    button from the LDMS toolbar.

The shipping information for LDMS laboratories

Frontier Science maintains a master database of laboratories using LDMS.
The information that is stored includes the laboratory's shipping address and
individuals working at the laboratory who are authorized to act as points of
contact for receiving shipments.

When laboratories perform a data export, they automatically receive small
database updates. Updates to contact information are one of these important
updates. These updates are released several times each month.

If you need to update the shipping or shipping contact information for your
laboratory or an employee at your laboratory, you can do so on the Frontier
Science Portal. Look for the Submit Contact Changes link under the LDMS
User Support heading.

Setting up the Shipping Container
If you're shipping a marked storage container, LDMS already knows how your
shipping container is organized (the same way it is organized in LDMS Storage

 ) . If you selected individual aliquots to ship, however, you'll need to tell
LDMS about the container that you'll put them in for shipping.

This can be a little confusing because the settings for shipping containers are
found on different tabs in LDMS Shipping   .

Table 15: Shipping container settings

Setting Tab to find setting

Container size Shipment Destination

Using letters or numbers for coordinates Shipment Destination

Use position numbers instead of coordinates Shipment Destination

How specimens will be put into the container Shipment Destination

Specify how specimens are organized to put
into the container

View Shipment

See a visual representation of the container Shipment QA/QC

To view and change settings for the container, go to the Shipment
Destination tab; to set how the specimens are ordered before filling them
into the container, go to the View Shipment tab, and to see the container
itself, go to the Shipment QA/QC tab.

Options available on the Shipment Destination tab for containers
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Reverse Row Reverse the number of columns so that they start at the
bottom instead of the top. This is often applicable when
your fill order is bottom-to-top.

Shipping
Container Fill
Order

How specimens will be put into the container. For
example, Left to Right, Bottom to Top will put
the first aliquot into the bottom-left corner, fill out the
bottom row right to left, then move up towards the top
until all aliquots are in the container.

Label Method Set whether columns and rows are numbers or letters, or
a combination of the two.

Rows &
Columns

Set the height (rows) and width (columns) of the
container. The default is 9x9.
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Figure 33: Normal vs Reverse Rows

This illustrates how the Reverse Row option affects a container. Essentially, it moves (1,1) from the top-left corner to

bottom-left. There is no equivalent option for reversing column numbering.

Fill order (on the Shipment Destination tab) is not the same as the sort
order (on the View Shipment tab). Fill order is where the specimens are
placed into a shipping container; sort order is how the specimens themselves
are organized. The sort order is found on the bottom of the View Shipment
Tab. The sort order will affect both how aliquots are placed in a container and
the order they appear on the manifest report.

Figure 34: Shipping container sort order on the View Shipment tab

A Primary Sort Order is required; the Secondary Sort Order is only
required if the primary sort order is Prot[ocol]/ID2.
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Performing Quality Control on a Shipment
It would be bad practice to not check the contents of a shipment before
shipping it. Aliquots can get misplaced in storage, for example, and a mistake
like that is much easier to correct before it has been shipped.

The process of checking each specimen's label against the information that
LDMS will put on the shipping manifest and in the shipping file is called QA/
QC. This is done in LDMS Shipping    on the Shipment QA/QC tab. QA/QC
should be performed at both the sending and receiving laboratories for the
same shipment, to make certain what was sent is what was received.

Figure 35: The Shipment QA/QC tab

Selecting Pass or Fail will advance automatically to the next aliquot. You can also simply scan the aliquot.

There are two ways to do QA/QC: manually or using barcode scanner. Using a
barcode scanner is by far the easier (and more accurate) method.

Performing QA/QC

1. Select the shipment batch for which you want to perform QA/QC from the
Setup Shipment tab.

2. Select the current container (the one you're currently checking or filling)
from the Container Name list.

3. Pull the first selected aliquot out of the container. Where the first aliquot is
located in the container will depend on the sort order.

4. If you want to assign an other specimen ID or comments, complete the
appropriate field; this information will be appended to aliquots in your
local LDMS database, as well as in the shipping file.

5. Do one of the following

• Compare the aliquot's label to the information on the QA/QC tab. If the
information matches, click the Pass Aliquot button, or press  Alt Z . If
the information does not match, click the Fail Aliquot button, or press 
Alt X .

• Scan the aliquot with a barcode reader; LDMS will pass or fail the
aliquot based on the global specimen ID.
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Note:  If scanning non-LDMS barcodes, check the Scan
Barcodes with Alternative Identifiers? box.

6. Put the aliquot in the shipping container in the correct location.
7. Continue until all aliquots in the container have been checked.
8. Repeat for each container in the Container Name list in the upper-right

corner.
9. After checking every container in the Container Name list, click the   

button from the LDMS toolbar.

The semantics are a little different, depending on whether you are shipping a
storage container or individual aliquots. If you're shipping individual aliquots,
you'll be putting aliquots into a new container, based on the sort order you
selected on the View Shipment tab. If you're shipping a container, you're
pulling the aliquot out of a container, checking it, and putting it back in the
same spot. Other than that, the process is the same.

The QA/QC column on the View Shipment tab displays one of the following to
indicate the status of the batch:

• Complete - All specimens passed QA/QC.
• Complete with Errors - Some specimens passed and some failed QA/QC.
• Not performed - QA/QC has not yet been performed
• In Progress - QA/QC has been started, but is incomplete.

Viewing and Modifying Shipments
On the View Shipment tab, you can view all the shipments that your
laboratory has prepared, sent, and received. Each row on the View
Shipment tab represents one shipment. The status column shows you
the type of shipment it is (with Batched being a shipment that you have
prepared but not sent).

Figure 36: View Shipment Tab

To modify a shipment with the status of Batched, simply select it, then
change to the appropriate tab, such as Shipment Destination to change the
receiving laboratory or Setup Shipment to add more specimens. When you
are done, click the    button from the LDMS toolbar.
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You can modify batches that have been shipped. This is because "shipping" in
LDMS means generating a shipping file—you still likely have the shipment in
your possession after generating the shipping file in LDMS, at least for a little
while. If you discover that you made a mistake, you need to un-ship the batch
in LDMS, which will allow you to make changes and generate a new shipping
file and manifest.

To un-ship a batch after you have created a shipping file, right-click on the
batch on the View Shipment tab and select Unship Batch. This will change
its status from Sent back to Batched so you can edit it again. To change it
back to Sent, you would follow the normal shipping process. You can use the
right-click menu to delete a shipment with the status Batched as well.

Note:

Un-shipping an LDMS batch requires the original shipping file. The
shipping file must be in a directory named with the batch number (e.g.
C:\342\342 for batch number 342); this is the same as the default
location where LDMS creates new shipping files. If you do not have this
shipping file, you will need to re-generate it. This requirement does not
apply to non-LDMS shipping files, such as CSV files

Correcting shipment problems

Shipping file with an incorrect shipment date
When you create an LDMS Shipping File, LDMS will set the shipping date for
the specimens to the current date. This date will be reflected in the shipping
file and only shipping paper work generated by LDMS. If a shipment is created
in LDMS and not shipped on the same day, the shipment date in the LDMS
Shipping File and on paper work will not be correct.

Tip:

To prevent shipping date errors from occurring, be sure to create the
LDMS shipping file on the day the shipment is going to be sent.

If the correct shipment date is today’s date and the sending laboratory has a
copy of the original shipping file, they can correct the error on their own. Un-
ship the batch in LDMS, and then create a new shipping file. The shipment
date will be updated to reflect the current date. If the laboratory does not
have the original shipping file, they will need to contact LDMS User Support
for a challenge password.

If the correct shipping date is a date in the past or if the sending laboratory
no longer has the LDMS shipping file, the sending laboratory cannot correct
the error on their own. They will need contact LDMS User Support for further
assistance.

Error with shipment destination
The receiving laboratory must be specified when creating a shipment in LDMS.
When the receiving laboratory attempts to import the shipping file, LDMS will
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check to verify that the laboratory that was supposed to get the shipment is
that laboratory that received it. This is one way LDMS helps avoid the wrong
laboratory getting the wrong shipment through human error.

It is possible, however, that the laboratory that prepared the shipment
selected the wrong receiving laboratory in LDMS but shipped to the correct
laboratory. If this error is discovered before the shipment was sent, the
sending laboratory can simply unship it and make the correction. If the
shipment has been sent, other steps would be needed.

If the sending laboratory still has a copy of the LDMS shipping file, then they
must change the batch to unshipped, correct the shipment destination and
then re-send the corrected shipping batch file to the receiving laboratory.
If the sending laboratory no longer has a copy of the original, incorrect
shipping file, then the sending laboratory must contact LDMS User Support for
assistance with updating the shipping file.

If the shipment has already been sent, the receiving laboratory will be given a
warning about the discrepancy when trying to import the shipping file. At this
point, the receiving laboratory should chose not to import the file and instead
get a correct file from the sending laboratory. LDMS will allow the receiving
laboratory to import the shipping file with the incorrect destination, but this
issue is much more difficult to correct if the warning is ignored.

Discrepancy between expected and received shipment
When specimens are shipped using LDMS, a printed manifest is also sent. This
printed paperwork, in conjunction with the LDMS Shipping File data, is used
to confirm that the physical specimens that were received match what was
expected. It may be that the specimens were not packaged correctly or the
shipment was prepared incorrectly in LDMS. If there is a discrepancy between
the printed paperwork and the actual specimens that were packaged, the
corrective measure will depend on when the error is discovered.

Tip:

Pay close attention to any specimen comments displayed on the
Shipping Manifest Report. These comments could explain why there are
discrepancies between the specimen label and the Shipping Manifest
Report.

If the discrepancy is caught before the file is imported, the receiving
laboratory should not import the file and instead contact the sending
laboratory to get the correct shipping file. The sending laboratory should
unship, correct, and re-create the shipping file and shipping paperwork, then
send these to the receiving laboratory. The receiving laboratory can then
safely import the corrected shipping file.

If the discrepancy is not caught until after the shipping file is imported, how
to proceed will depend on the nature of the issue.

If the shipping file contained extra specimens that were not part of the
physical shipment, the receiving laboratory now has these specimens listed
at their laboratory in LDMS. Since the sending laboratory didn’t actually send
the physical specimens, the receiving laboratory will need to send those
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specimens back in LDMS. This will move the data for the specimens back to
the sending laboratory, where the specimens are still located.

To do this, the laboratory that received the shipping file with extra specimens
will create a new shipment with those specimens, and then send the shipping
file back to the originating laboratory. Once that laboratory has imported the
shipping file, the data for those specimens will have been successfully moved
back to the laboratory.

If the laboratory received specimens that were not part of a shipping file,
the receiving laboratory must notify the sending laboratory in writing. The
sending laboratory will need to create a shipping file with these specimens
and provide that to the receiving laboratory so that they can be imported.

If there are any discrepancies between the physical specimen labels and the
shipping report, the two laboratories should work together to resolve the
issue appropriately.

Lost or Unsatisfactory Shipment
If the entire shipment is lost and never received, LDMS information needs
to be updated to reflect the event. If this does not happen, one laboratory
will show the specimens have shipped to another laboratory, where those
specimens don’t exist. Later, when the data is viewed later, it won’t be clear
where the specimens are located and what happened to them.

The receiving laboratory should import the affected shipment. During the
import process, you will have the opportunity to adjust the condition of the
specimens. If the shipment was lost, the condition code for all specimens
in the shipment should be changed to LSH (Lost Shipment) and apply the
never store property to all of the specimens. If another condition applies—for
example, if the specimens were left outside during winter and frozen—that
code should be selected. If the specimens are in a state that they will not be
saved, the never story property should also be applied to them.

In either case, if replacement specimens are available, those specimens
should be sent to the receiving laboratory.

Important Shipment Reports
There are a few reports that can be generated on the View Shipment tab.
They are found in the bottom-right corner of the screen. There are more
shipping-related reports available using the LDMS Reports    feature.

Shipment reports

Details the specimens included in a shipment; should be
printed and shipped along with the shipment; this report
must be generated before you can create a shipping file
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Contains the specimens and their storage location, useful
if you've batched specimens together to be shipped but
you still need to pull them from storage

Shows the layout for specimens in shipping containers,
based on the sort order and fill order.

Supported shipping file formats
These are the file formats that are supported for sending and receiving
shipping files.

Table 16: Supported shipping file formats

Format Encrypted? Intended destination

LDMS Yes Laboratories using LDMS (both
web and windows version)

CSV No Laboratories not using LDMS

SeraCare No Specimens being sent to
the Precision Bioscience
Repository

Cross-LIMS Manifest No Laboratories not using LDMS

CSV shipping files
LDMS can generate and accept CSV (comma separated value) shipping files
that meet these requirements.

• The file must be a comma delimited text file with the .csv file extension.
• The first line in the file must be a header row.
• The file must contain, at minimum, all required columns (in any order) to

be processed by LDMS.
• When a CSV shipping file is generated by LDMS, all columns listed in the

following table will be included.

Note:  Field headers in the file are not case-sensitive.

Column
Label

Example
Value

Column
Required
in File

Must be
Defined in
File

Notes

Shipment
Number

145 No No ID number for the shipment.

Sending Lab 500 Yes Yes ID number for the laboratory sending
the shipping file.

Receiving
Lab

143 No No ID number for the laboratory receiving
the shipping file.

Setup Date 05/
Jan/2016

No No Date shipping file was created. Must be
in the format dd/Mmm/YYYY.
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Column
Label

Example
Value

Column
Required
in File

Must be
Defined in
File

Notes

Ship Date 05/
Jan/2016

No No Date specimens were shipped. Must be
in the format dd/Mmm/YYYY.

Temperature Dry Ice No No Temperature of the shipment.

Shipment
Comment

This is a
comment

No No Notes about the shipment.

Container Box #1-1 No No Name of container holding specimen.

Row 1 No No Position of specimen in container. Alpha
and numeric coordinates are allowed.

Column 1 No No Position of specimen in container. Alpha
and numeric coordinates are allowed.

QA
Performed

-- No No Whether shipping file was compared
to the actual shipment to ensure
specimens were correct and included in
the correct container locations.

group FRONTIER Yes Yes Name of group for which the specimen
was collected.

ID1 0111111C Yes Yes Participant or specimen source ID.

ID2 F5309 Yes Yes Protocol ID.

ID3 -- Yes No Sub-protocol ID.

Visit 1 Yes No Visit value.

Visit Unit WK Yes No Unit for visit. Must be a valid LDMS visit
unit code.

Clinic 701 Yes No Clinical site where specimen was
collected.

Specimen
Date

05/
Jan/2016

Yes Yes Collection date. Must be in the format
dd/Mmm/YYYY.

Specimen
Time

15:20 Yes No Collection time. Must be in 24-hour
format.

Received
Date

05/
Jan/2016

Yes Yes Date specimen was received by
laboratory. Must be in the format dd/
Mmm/YYYY.

Received
Time

15:20 No No 24-hour time specimen was received by
laboratory. Must be in 24-hour format.

Specimen
ID

500V05000012No No Specimen ID (used for specimens
entered in LDMS for Windows only).

Global Spec
ID

CEQ0000P-03No No If not specified, a global specimen ID
will be generated automatically when
the shipping file is received in LDMS.

Other Spec
ID

-- No No Other specimen ID.

Primary BLD Yes Yes Specimen primary type. Must be a valid
LDMS primary code.
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Column
Label

Example
Value

Column
Required
in File

Must be
Defined in
File

Notes

Additive EDT Yes Yes Specimen additive. Must be a valid
LDMS additive code.

Derivative PL2 Yes No Specimen derivative. Must be a valid
LDMS derivative.

Sub A/D N/A No No Specimen sub-additive/derivative. Must
be a valid LDMS sub-additive/derivative
code. If not specified, will default to N/
A.

Volume 1.5 Yes Yes Volume of specimen

Volume
Units

ML Yes Yes Units used for specimen volume.

Condition SAT No No Three letter code representing
specimen’s current condition. If not
specified, will default to SAT.

Comments This is a
comment

No No Notes about the specimen

Tests -- No No Assays assigned to the specimen

Processing
Date

05/
Jan/2016

No No

Processing
Time

15:20 No No

Frozen Date 05/
Jan/2016

No No

Frozen Time 15:20 No No

Total Cell
Count

No No

Processing
Tech

No No

Second
condition
code

No No

Freezer No No

Level 1 No No

Level 2 No No

Harvest
Date

05/
Jan/2016

No No

Additional
Time

15:20 No No

Additional
Time Unit

No No

Thaw Count No No
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Column
Label

Example
Value

Column
Required
in File

Must be
Defined in
File

Notes

Internal
comments

This is a
comment

No No Import this field if it's in the file, but do
NOT ship it out from WebLDMS

Reason not
collected

No No

Cross-LIMS shipping files
LDMS can generate and accept cross-LIMS shipping files that meet these
requirements.

• The file must be a tab delimited text file with the .txt file extension.
• The first line in the file must be a header row.
• The file must contain, at minimum, all required columns (in any order) to

be processed by LDMS.
• When a cross-LIMS shipping file is generated by LDMS, all columns listed in

the following table will be included.
• If additional columns are present in a cross-LIMS file, those columns will be

ignored.
• Cross-LIMS shipping import sets the clinic value for VTN records based on

the PID. This allows LDMS labs to receive cross-LIMS shipments of VTN
samples if needed.

Column Label Example Value Required Notes

SHIP_ID 0500-0999-0000000147Yes In the format
[Sending_Lab_ID]-Receiving_Lab_ID]-[Shipment_Number];
leading zeros must be
added to make the ID
the correct length (for
example 500-19-147
is not valid, but
0500-0019-0000000147
is valid)

SHIP_DATE 06-Jan-16 No Date shipped. Date
must be in the format
dd-Mmm-yy

RECIPIENT 999 Yes Receiving laboratory's
ID

SHIPPED_FROM 500 Yes Sending laboratory's
ID

GLOBAL_ID GEQ00017-03 No A valid LDMS global
specimen ID

group FRONTIER Yes The group for which
the specimen was
collected.

PROTOCOL F5309 Yes The protocol (ID2) for
which the specimen
was collected
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Column Label Example Value Required Notes

PID 0777777F Yes The participant
identifier (ID1)

VID 7 Yes The visit value

VID_UNIT Day Yes The visit unit. Must
be a valid LDMS visit
code

COLL_DT_TM 17-Jan-05 09:12 Yes Collection date and
time, in the format
dd-Mmm-yy HH:mm,
using 24-hour clock

PRIM BLD Yes Primary type. Must be
a valid LDMS primary
code.

DER PL2 Yes Derivative type. Must
be a valid LDMS
derivative code.

SUBDER N/A Yes Sub-additive/
derivative type. Must
be a valid LDMS sub-
additive/derivative
code.

ADD EDT Yes Additive type. Must be
a valid LDMS additive
code

QTY 1 Yes Volume of the
specimen collected.

QTY_UNIT ML Yes Volume unit. Must be
a valid LDMS volume
unit code.

CONDITION SAT No Condition of the
specimen. Must be a
valid LDMS condition
code.

OTHERSPECID VTN No Other Specimen
ID. Must be alpha/
numeric with a max
field length of 17
characters.

TIME 0.00 No Must include the
Additional Time.
Format must be
numeric/decimal
with precision to two
decimals.

TIMEUNIT HRS, TR, or RAN No Must include
Additional Time Unit
Abbreviation. The
field must be three
characters long.

COMMENT This is a comment No A comment about the
specimen.
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Column Label Example Value Required Notes

BOX #1-1 No Name of shipping
container

ROW 1 No Row in shipping
container (from top-
to-bottom)

COL 1 No Column in shipping
container (from left-
to-right)

SeraCare shipping files.
LDMS can generate (but not receive) “SeraCare” shipping files that meet
these requirements.

Column Label Example Value Notes

Global Spec ID 0777-001MWK00-286--

group FRONTIER The group for which the specimen was collected.

PID 0111111C Participant ID (ID1)

VID 8 Visit value.

VID Unit Vst Visit unit.

Collection Date 1-Mar-13 Collection date

Collection Time 1:00 Collection time.

Prim BLD Primary type.

Der BLD Derivative type.

Add ACD Additive type.

Other Spec ID PLORQ --

Volume 1 --

Volume Unit ML --

Custom Local ID -- --

Box BOX 2 Name of shipping container.

Row,Col 1,1 Position in shipping container.

Condition SAT --

Comment This is a
comment

--

Protocol F5308 The protocol (ID2) for which the specimen was collected.

Sub/Der N/A Sub-additive/derivative type.

Sending a Shipment
If a shipment's status is "batched", this means that the shipment has been
prepared, but not sent. Sending a shipment is done on the View Shipment
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tab. You're not technically sending it; what you're doing is changing the
status of the shipment to shipped in LDMS and creating the shipping file.
The shipping file is a computer file that the you will send to the receiving
laboratory to import into LDMS.

1. (When shipping loose specimens) Select the primary sort order from the
bottom of the view shipment tab.

2. (When shipping loose specimens) Select the secondary sort order
3. Generate the shipping manifest by clicking the    button.

Note:

If your shipment contains specimens for MACS or WIHS groups,
you will be prompted to chose between generating the standard
manifest report or the SeraCare manifest. Export the SeraCare
manifest as a CSV file; this is considered a SeraCare shipping file.

4. Select the type of shipping file to generate from the Shipment Type
drop-down in the upper-right corner.

Tip:

It is a very good idea to communicate with the receive laboratory to
determine what software they are using and their preferred shipping
file format. When both laboratories are using LDMS, the standard
LDMS Shipping Batch format should be used.

5. Click the Ship button.
6. When prompted, select the temperature at which the shipment will be

sent.
7. Click the appropriate drive where the shipping file should be created. This

may be a removable media drive, such as a USB-drive or it may be the C:
\ drive.

Note:

At this time, you cannot specify a specific directory to which to write
the shipping file; you can only specify the drive.

8. A separate program called LDMS Data Exchange (sometimes called LDX) will
appear. This program will show you the progress of pulling information
from your LDMS database and creating the shipping file. To start, click the
Exchange button.

8.1. (For LABWARE2 and Cross-LIMS only) Before selecting the
Exchange button, click the Configure button in the Destination
section. Specify the output location for the file.

9. Select the temperature at which you will be shipping the specimens. If you
want to specify more information, use the comments field on the Storage
Destination tab.

LDMS will create a folder named with the batch number in the drive that
was specified (e.g. C:\43\43, where 43 without an extension is the shipping
file). The corresponding batch will now have the status of Sent on the View
Shipment tab.
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Table 17: Available shipping file formats

In the file name examples, the batch number is "43", the sending laboratory is "500", and the receiving laboratory is
"512."

Format File
extension

Encrypted? Example filename

LDMS Shipping Batch None Yes 43

Excel or Comma Separated
Text

.xls or csv No ship43.xls

Cross-LIMS Manifest .txt No 500-512-0000000043.txt

Labware Shipments .csv No 500-512-0000000043.csv

How exactly the shipping file is given to the receiving laboratory will vary,
depending on the group and laboratory. Only LDMS Shipping    Batches are
encrypted; all other formats are, by nature, plain text files that could be read
outside of LDMS.

Creating SeraCare shipping files

Background

Steps

1. On the View Shipment tab, click Manifest Report.
2. In the Choose report format window, click SeraCare.
3. In the toolbar of the Crystal Reports window, click the Export Report

button.
4. Select the following Export settings:

Option Setting to use

Format Separated Values (CSV)

Destination Disk file

5. Select the following Character-Separated Values settings:

Option Setting to use

Separator Character

Character , (a comma)

Delimiter " (double quotation mark)

6. In the Number and Date Format Settings window, leave all options
deselected.

7. When prompted, chose a location and filename for the shipping file.

Result
The *.csv file that was created is the SeraCare shipping file. This is the file
that should be provided to the SeraCare repository.
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Importing received shipment

Importing a Shipment from an LDMS Laboratory
LDMS can receive shipments in all the same shipping file formats that it can
create.

Important:

When the batch is imported into your LDMS, it will be assigned the
next available batch number. It will not have the same batch number
that was assigned to it at the sending laboratory. However, if you are
receiving an LDMS Shipping Batch file, you do need to know the batch
number from the sending laboratory to import it. This is a safeguard to
keep paper manifest consistent with shipping files as they are imported.
The batch number is printed on the LDMS-generated manifest.

Importing a shipping file from another laboratory

1. In LDMS Shipping   , select the bottom, blank row on the View
Shipment tab.

2. Change to the Import tab.
3. Select the type of shipping file that you will be importing from the

Shipment Type drop-down list.
4. (For LDMS Shipping Files) Enter the batch number from the receiving

laboratory into the Shipment No. field. If this does not match the batch
number in the shipping file, it will be rejected.

5. Click the    button and select the shipping file that you received
from the sending laboratory.

6. (For LDMS Shipping Files only) Change to the Shipment QA/QC tab and
perform QA/QC on the shipment.

7. Change back to the Import tab, then click the    button from the
bottom-left of the screen.

8. Change the condition code of one or more specimens as needed to reflect
the condition of the shipment as you received it. Hold down the Ctrl or
Shift key to select more than one specimen, then change the condition
code from the drop-down list.

9. Select whether to Import associated Test (assay) Setup Information.
If yes, aliquots that were assigned a test at the sending laboratory will be
assigned to those tests at your laboratory. If no, test assignments will be
disregarded.

10.Select the temperature at which you received the shipment from the
Select a shipping temperature drop-down list.

11.(If the import as is feature is enabled) Selected whether you want
to automatically import received containers into LDMS as-is. If yes, a
temporary freezer will be created in LDMS Storage    called SHIPPING
IMPORT that contains the specimens from the shipping file. You would then
move the specimens to the appropriate location in storage.

12.If you do not want to ever store the specimens, select the Mark
specimens to never store check box.
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13.(For internal groups only) If the shipment contained an internal group,
you'll be prompted to either create the new group in your local LDMS
database or map the imported group to an existing internal group.

By default, specimens will not be added to your storage automatically after
importing them. The Bulk Add tab in LDMS Storage    has fields that allow
you to search for specimens to store by batch number and received date.

If you would rather add specimens to your LDMS storage automatically when
a shipping file is imported, you must enable the Allow automatic storage of
imported samples option. This is option is found by clicking Administration
> System Configuration and then changing to the Import tab.

Text Shipping File
LDMS is capable of importing specimens from tab-delimited text files. The
filename must be in the format described below. The file must contain all of
the fields listed. A header row should not be included.

Figure 37: Text shipping file filename format

aaa_bbbbbb_ddmmmyyyy.txt
OR
999aaa_bbbbbb_ddmmmyyyy.txt

Where aaa is the sending laboratory's LDMS laboratory ID number, bbbbbb is
the batch number (with leading zeros added, if necessary), and ddmmmyyyy
is the date the batch was created.

Important:

Text shipping files must have exactly 22 columns, and the columns
must be in the order specified below. If there are more or less than 22
columns, LDMS will not be able to correctly read the file. No columns
can be removed, and extra columns cannot be added.

Table 18: Text shipping file fields

Field Field Type/Max
Length

Example Note

group Alpha / 20 ACTG/IMPAACT REQUIRED: The applicable group
must be available in the Specimen
Management at the receiving
laboratory

PID/ID1 Alpha/Numeric /
25

0012345L REQUIRED

Protocol/ID2 Alpha/Numeric /
25

A0000 --

SID/ID3 Alpha/Numeric /
25

A00001234L --

VID Numeric / 6 1.00 Visit number. Format: three numbers
before the decimal and two numbers
after the decimal

VID Unit Alpha / 3 Vst --
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Field Field Type/Max
Length

Example Note

Clinic Numeric / 5 12301 The applicable clinic must be
available in the LDMS

Specimen Date Alpha/Numeric /
9

28May2009 REQUIRED: Format: DDMMMYYYY

Specimen Time Alpha/Numeric /
5

13:00 Format: HH:MM (24-hour military
format)

Received Date Numeric / 9 29May2009 REQUIRED: Format: DDMMMYYYY

Received Time Alpha/Numeric /
5

14:00 Format: HH:MM (24-hour military
format).

Time Numeric / 6 1.00 Format: three numbers before
the decimal and two numbers
after the decimal. Typically used
for pharmacology and metabolic
specimens.

Time Unit Alpha / 3 Hrs Typically used for pharmacology and
metabolic specimens.

Global Specimen
ID

Alpha / 11 A1234567-89 --

Primary Alpha / 3 BLD REQUIRED

Additive Alpha / 3 EDT REQUIRED

Derivative Alpha / 3 PL1 REQUIRED

Sub/Add
Derivative

Alpha / 3 N/A REQUIRED

Volume Alpha/Numeric /
11

10.00 REQUIRED: Format: Nine numbers
before the decimal and two numbers
after the decimal.

Volume Unit Alpha / 3 ML --

Condition Alpha / 3 SAT If blank, LDMS will default to SAT
(satisfactory).

Other Specimen
ID

Alpha/Numeric /
17

-- Optional identifier at specimen level

Removing a Received Shipment
A shipment that you've received in LDMS and imported via the Import tab in
LDMS Shipping    can be removed. To do so, simply find the shipment on the
View Shipment tab, right-click on it, and then select Unimport Batch.

You will be required to contact LDMS User Support to complete this process.
This is because LDMS works under the assumption that your laboratory
reviewed the shipment prior to importing it. If it needs to be removed, that
implies that a serious or unique problem has occurred.
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Compatibility with LDMS for the web
LDMS for Windows is capable of importing shipments that were created using
the web version of LDMS. In order ship files to or receive shipments from
laboratories using web LDMS, you must be using LDMS for Windows version
10.0 or higher.

There are a few key differences between LDMS for Windows and web LDMS
that can affect the shipment of specimens.

• Web LDMS uses a different format for the global specimen ID; however,
the global specimen ID will never be changed during shipment. This means
that the global specimen ID will look different, depending on where the
specimen originated.

• Web LDMS does not assign a specimen ID. If you import a shipment sent
from a WebLDMS laboratory, LDMS for Windows will assign a specimen ID
automatically.

• Web LDMS allows the shipment and storage of primary specimens; LDMS
for Windows does not. If you import a shipment in LDMS for Windows that
contains a primary that has no aliquots, it will automatically be converted
into an aliquot.

For more information about compatibility between LDMS for Windows and
Web LDMS, see the Web LDMS User Manual.

Reports

LDMS as a Database Front-end
LDMS is a specialized database front-end, and while users can't interact with
that data direct there are several ways to extract it. Virtually any set of data
that LDMS stores can be pulled into a user-friendly report, which can then be
printed or exported into a format that can be utilized by another program—
you just need to know how to ask LDMS for it.

One of the most important tools at your disposal for retrieving data is LDMS
Reports tool. To access reports, go to Tasks > Reports, or click the   
button from the LDMS toolbar. Another feature, Data Retrieval, can be
used for more customized reports. Data Retrieval is found in Tools > Data
Retrieval.

Running LDMS's Built-in Reports
LDMS comes with many reports. To run a report, simply select a category
on the left, the name of the report on the right, and then click the    button
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from the LDMS toolbar. After a short time (depending on the size of the
report), a Crystal Reports® viewer window will appear.

Note:

While there are many built-in reports, they may not meet everyone's
needs. You can also use the Data Retrieval Tool to create your own
custom reports.

When you attempt to run a report without criteria, LDMS will give you a
message that the report may take a long time to generate. You'll always
receive this message if you don't select any criteria, even if the report you're
about to generate won't be very big.

You can reduce the amount of information in your report by creating query
criteria to filter it. For example, a filter of Specimen Date >= 24/Apr/2013
would only include records where the specimen date is on or after April 24,
2013 in your report.

Figure 38: Report generation screen

Creating a report query criteria:

1. Select the field that you want to filter from the Field drop-down.
2. Select the operator for your filter from the Operator drop-down.

Note:

LDMS using the Pascal-like <> to indicate ≠ (not equal).
3. Enter a value for your filter.
4. Click the    button.
5. Add more query criteria.
6. Enter a query statement, using the numbers assigned to each query

criteria. If no query statement is entered, the default is to use each query
criteria separated by AND.

7. To save your query for later use, enter a name into the Previous Queries
text box, then click the    button from the LDMS tool bar.
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Table 19: Example query statement

In this example, a query statement of (1 or 2) and 3 would find results where the ACTG Protocol is 003 OR 218,

and the Specimen Date is after April 24, 2013.

# Field Operator Value

1 ACTG Protocol = 003

2 ACTG Protocol = 218

3 Specimen Date > 24/Apr/2013

If you choose to save your query for future use, you can select individual
query criteria and modify or delete them using the    and    buttons
respectively. Saving a report query is helpful if you need to run the same
report on a regular basis.

Using Crystal Reports® Viewer
LDMS uses Crystal Reports to generate and display information retrieved from
its database. Crystal Reports opens in a new window; you cannot return to
using LDMS until you close the Crystal Reports window.

SAP Crystal Reports Viewer

The Crystal Report Viewer is similar to many PDF viewers, with pages and the
ability to zoom. Because Crystal Reports is data-aware, however, you have a
few more options for exporting data so that you can use it for other purposes.
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To export from crystal reports, click the   ; you can select different export
formats from the drop-down at the bottom of the Save As window.

Table 20: Available export file formats for Crystal Reports

Format Extension

Crystal Report rpt

Portable Document Format pdf

Comma separated values csv

Microsoft Excel (97-2003) with headers xls

Microsoft Excel (97-2003) without headers xls

Microsoft Excel (2007+) without headers xlsx

Microsoft Word (97-2003) doc

Editable Microsoft Word rtf

Rich Text rtf

Crystal Reports XML xml

Tab separated text ttx

! Warning:

While it is possible to export all reports generated by LDMS, not all of
them will export nicely into certain formats (all reports will export just
fine into PDF). Some reports will export with formatting issues that
would make the data difficult to use in a program like Microsoft Excel®.
Reports that are in the category Exportable Reports were specifically
designed to be export-friendly. If you need to manipulate and analyze
data with an external program, exportable reports should be you first
choice.

Running Custom Data Retrieval Reports
In addition to the reports that come with LDMS, you can create your own
custom reports. This allows you to create advanced searches. You can find
records based on almost any conceivable search criteria, and also set what
information from those records will appear on the report. If none of the built-
in reports meet your needs, you can probably create your own report that
does.

The Data Retrieval tool is accessed by clicking Tools > Data Retrieval from
the LDMS menu bar.
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Figure 39: Data Retrieval Screen

Drag and drop fields on the left into the boxes on the right to add them. To remove a field from the right side, simply

drag it out of the box.

Creating a data retrieval query

1. Drag a field from the Selectable Fields listing on the left to the
Selection Criteria box on the right.

2. In the Selection Criteria box, select the Op[erator] and Value that you
want to use for your search.

3. Enter the logic for your search criteria into the Criteria Sentence box
using the numbers for each field in the Criteria Selection box.

Note:  To search for ‘NULL’ or missing values, do not enter criteria
in the Value field.

4. Drag fields that you want to be displayed on your report from the
Selectable Fields listing on the left to the Fields to display box on the
right.

5. To determine which fields to sort your results by, drag fields from the
Fields to display list to the Sort Results By list.

6. If needed, select the Distinct option. This means that if there are any
results in your report that are identical (meaning all of the displayed fields
are the same), the duplicates will be discarded.

7. To save your report for future use, enter a name for your report into the
Previous Queries text box, then click the    button from the LDMS
toolbar.

8. Click the    button from the LDMS toolbar to generate your report.

Tip:

You can save your query so that your report can be quickly run at a
later time by typing a name for your report into the Previous Queries
text box, and then click the    button from the LDMS toolbar. To re-run
it, just select the report from that drop-down and click the    button. If
you make changes to it and want to save them, use the    button.

When you run your report, the results will appear in a table at the bottom of
the screen rather than in a separate window. You can change between the
results and the raw SQL statement by using the Query and Results radio
buttons at the bottom of the screen.
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To save the results of your report, select the file format that you want to save
as from the Export As drop-down menu beneath the results, then click the 

  button. If you want (or don't want) the headers for your columns that
shows what data is in that column, toggle the With headers check box.

Descriptions of Built-in Reports
This section describes the reports available using the LDMS Reports    tool,
organized by the categories in which they appear in LDMS. The filtering
criteria available varies from report to report.

Can't find a report you need?

While Frontier Science has attempted to maintain a comprehensive suite of
reports, and the Data Retrieval tool is robust enough for most users, you
may find that you are having difficulty generating a report with the exact
information that you need.

Offering robust report options for laboratories is a priority for LDMS
development. New reports (and new features for existing reports) are
frequently implemented at the request of a user. Contact LDMS User Support
for assistance; they may be able to help you use existing tools to get the
information you need, and if not, they can initiate the process of updating
LDMS.

Admin Reports

User
Permissions

This report provides the user with a summary of all the
users in the LDMS and lists their current permissions
within the LDMS. This report would be useful to print
or reference when trying to track a particular user’s
permissions.

Transaction Log This report provides the user with a summary of
transactions made by users in the LDMS. It can be
filtered to display transactions based on dates, IDs,
types, as well as by User ID and names when creating
the report. This report would be useful for seeing what
has actually been performed in LDMS and by whom.
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Figure 40: Transaction Log Report

Anon Reports

Anonymous
Patient Map

This report shows the relationship between identifying
information in an original specimen and anonymized
specimens. The fields that are displayed are the ones
relevant to anonymization, such as the original and new
PID, and the original and new global specimen ID.

ATN Reports

ATN Repository
Report

This report provides the user with a summary of all the
ATN assigned samples that have been imported into the
local lab’s LDMS. This report would be useful to a user to
track the inventory of imported ATN samples.

Culture Reports

Culture Results
by Protocol

This report provides the user with a list of all the results
for a given culture. The report then groups these results
by Protocol.

Culture
Schedule Report

This report provides the user with the various feed and
harvest schedules and groups them based on the type
of culture it is defined by. This report would be useful to
identify which harvest feed schedules are available and
whether a new schedule is required.

Exportable Reports

WIHS Nuclisens
Control

This report provides the user with a summary of the
controls that are currently available for the Nuclisens
Assay.
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WIHS Nuclisens
Specimen

This report provides the user with a summary of
Nuclisens Assay results for WIHS samples that were
completed in the lab’s database.

Primary
Specimen
Database

This report provides the user with a list of the Primary
LDMS Specimen Numbers and the associated Draw Date
and Received Dates.

CFAR Export
Report

This report provides the user with a list of specimens
that are stored within the local LDMS and provides
information regarding the specimens.

Storage Export
Report

Similar to the CFAR Export report, this report provides
the user with a list of specimens that are stored within
the local LDMS and provides information regarding
the specimens. The major difference is that this report
contains headers and displays the complete storage
location.

WITS Storage
Detail Report

Similar to the Storage Export Report, this report provides
the user with a list of specimens that are stored within
the local LDMS and provides information regarding
the specimens. The major difference is that this report
contains Global Specimen ID’s as opposed to LDMS
Specimen ID’s.

Abbott SARS-
COV-2 Quant
Export Report

Exportable report that summarizes results from the
Abbott SARS-COV-2 Quant assay.

Abbott SARS-
COV-2 Quant
Export Report
with Comments

Similar to the Abbott SARS-COV-2 Quant Export Report,
but with two additional data fields for Condition and
Comments.

Abbott SARS-
COV-2 Quant
Export Report
with Sample
Location

Same as the Abbott SARS-COV-2 Quant Export Report,
but with one additional data field for Sample Location.

A5184 Bayer
bDNA HCV RNA
Report

Lab 54 was performing three Assays for Protocol A5184
which are not supported in the LDMS. To make data
entry easier for this lab when submitting the data by
Excel to the DMC, three templates for this data were
added to the LDMS. The lab could generate the Report
with the specimen info (Protocol, PID, Specimen Date,
Specimen ID and Visit) loaded onto the template based
on the search criteria selected. The lab can export
the report(s) into Excel and manually complete the
remaining data portion of the template.
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A5184 Bayer
TMA HCV RNA
Report

Lab 54 was performing three Assays for Protocol A5184
which are not supported in the LDMS. To make data
entry easier for this lab when submitting the data by
Excel to the DMC, three templates for this data were
added to the LDMS. The lab could generate the Report
with the specimen info (Protocol, PID, Specimen Date,
Specimen ID and Visit) loaded onto the template based
on the search criteria selected. The lab can export
the report(s) into Excel and manually complete the
remaining data portion of the template.

A5184 HCV
Genotyping
Report

Lab 54 was performing three Assays for Protocol A5184
which are not supported in the LDMS. To make data
entry easier for this lab when submitting the data by
Excel to the DMC, three templates for this data were
added to the LDMS. The lab could generate the Report
with the specimen info (Protocol, PID, Specimen Date,
Specimen ID and Visit) loaded onto the template based
on the search criteria selected. The lab can export
the report(s) into Excel and manually complete the
remaining data portion of the template.

Westat DNA
Export Report

This report is designed to mimic a DNA Results by
Protocol Report that was not useful for the folks at
Westat, therefore, this report was created to provide
similar DNA result data in a new format.

Westat Roche
Amplicor Export
Report

Similar to the Westat DNA Export Report, this report
is designed to mimic a Roche Amplicor Assay Results
by Protocol Report that was not useful for the folks at
Westat, therefore, this report was created to provide
similar Roche Amplicor Assay result data in a new
format.

Westat Roche
Ultra Export
Report

Similar to the Westat DNA Export Report, this report is
designed to mimic a Roche Ultrasensitive Assay results
by protocol report that was not useful for the folks at
Westat, therefore, this report was created to provide
similar Roche Ultrasensitive Assay result data in a new
format.

Westat PK
Export Report

Similar to the Westat DNA Export Report, this report is
designed to mimic a PK Assay results by protocol report
that was not useful for the folks at Westat, therefore,
this report was created to provide similar PK Assay result
data in a new format.

Quest Import
Manifest Report

This report provides a summary of the batches that have
been received via the LDMS Shipping file. The report will
not list batches that have been received via text file.
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Westat DNA 1.5
Export Report

Similar to the Westat DNA Export Report, this report is
designed to mimic a DNA 1.5 Assay results by protocol
report that was not useful for the folks at Westat,
therefore, this report was created to provide similar DNA
1.5 Assay result data in a new format.

Westat
Nuclisens
Export Report

Similar to the Westat DNA Export Report, this report is
designed to mimic a Nuclisens Assay results by protocol
report that was not useful for the folks at Westat,
therefore, this report was created to provide similar
Nuclisens Assay result data in a new format.

Lab 48 Billing
Report

This report was designed to provide the following
requested fields: Specimen ID, group/protocol, PID/ID1,
Visit/Visit Unit, Specimen Date, and Additive.

SCHARP VGC
Assay Results

This report was designed to be used for reporting assay
results to SCHARP. The first group of fields on the
report contains basic specimen information that will be
populated by LDMS. This is followed by a second group
of fields that LDMS will leave blank and will be filled in by
the lab (these are the assay result fields).

SCHARP GSC
Assay Results

This report was designed to be used for reporting assay
results to SCHARP. The first group of fields on the
report contains basic specimen information that will be
populated by LDMS. This is followed by a second group
of fields that LDMS will leave blank and will be filled in by
the lab (these are the assay result fields).

SCHARP GSS
Assay Results

This report was designed to be used for reporting assay
results to SCHARP. The first group of fields on the
report contains basic specimen information that will be
populated by LDMS. This is followed by a second group
of fields that LDMS will leave blank and will be filled in by
the lab (these are the assay result fields).

Specimen
Export

This report was designed for when a user has logged in
non-government group specimens into the Specimen
Management module and has shipped these specimens
via the shipping module.

Lab 081 Billing
report

This report was designed to provide lab 81 with an
exportable report that they use for billing purposes. The
following were the requested fields: group/Protocol, PID/
ID1, Specimen Date, Derivative, and Global Spec ID.

Lab 081 CNICS
by Date

This report was designed to provide lab 81 with an
exportable report that they use for billing purposes, the
following were the requested fields: group, Non ACTG
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Protocol/ID2, Spec Date, Received Date, Primary, Volume
and Volume Units.

Lab 081 CNICS
General

This report was designed to provide lab 81 with an
exportable report that they use for billing purposes. The
following were the requested fields: Non ACTG Protocol/
ID2, PID/ID1, Specimen Date and Time, Received Date,
Additive, Derivative, Sub Add/Der, Volume and Volume
Units.

SCHARP
Manifest Assay
Results Tool

This report was designed to provide the labs with an
exportable report, that they will be able to generate and
send to SCHARP, which will have the data used for upload
into SCHARP's assay result tool.

WIHS Taqman
RNA Specimen
Export

This report was designed to be similar to the current
WIHS Nuclisens RNA Specimens Export File Report in the
Reports Module, but with information from the Taqman
assay. The report contains a summary of the specimen
and run information.

Aliquot Count
by Primary

This report was designed to provide the user with a list
of the Primaries in the LDMS and provide them with a the
number of aliquots associated with the given Primary.
This report summarizes the inventory within the local
database.

Database Dump
Report

This report provides the user with a complete listing of
all of the specimen information held within a local lab’s
database. This report would be useful to a user if they
need to track a complete summary of their database.

Exportable
Abbott Assay
Report

Similar the RNA Abbott Assay report, this report was
designed to be an exportable RNA Assay Result Report
with the following fields: PID, Visit Value and Visit
Unit, Primary, Specimen ID, Global ID, Specimen Date,
Received Date, Import Date, Assay Date, RunID, Result,
System Censor, User Censor, Run System Censor, and
Run User Censor.

Exportable
Roche Amplicor
Report

Similar to the RNA Abbott Assay report, this report
was designed to be an exportable RNA Assay Result
Report with the following fields: PID, Visit value and Visit
Unit, Primary, Specimen ID, Global ID, Specimen Date,
Received Date, Import Date, Assay Date, RunID, Result,
System Censor, User Censor, Run System Censor, and
Run User Censor.

Exportable
Roche Ultra
Report

Similar to the RNA Abbott Assay report, this report
was designed to be an exportable RNA Assay Result
Report with the following fields: PID, Visit value and Visit
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Unit, Primary, Specimen ID, Global ID, Specimen Date,
Received Date, Import Date, Assay Date, RunID, Result,
System Censor, User Censor, Run System Censor, and
Run User Censor.

CFAR Storage
Report

This report was designed based upon a request by lab 15
for a new storage report that would allow them to send
their CFAR specimen information to their data manager
at the CFAR Repository. This report is export friendly. The
report provides a summary of the storage locations for
specimens in the local lab’s LDMS.

Lab 194 Billing
Report

This report provides an exportable friendly repot of a
summary of all the specimens within the local LDMS.
The report provides the PID/ID1, Specimen ID, Global
Spec ID, other Spec ID, PRI,ADD, DER, Specimen Date,
Specimen Time, VID, VID Unit, Volume, and Volume
Units.

Lab 485 Aliquot
Report

This report was designed to mimic the Specimen Export
Report but to sort the results in the following order-
group, Non ACTG Protocol, Non ACTG PID, Visit Value,
Primary, Additive, Derivative.

Lab 485
Specimen Count

This report provides a count for unique Primary/Additive/
Derivative/Sub-Derivative combinations that can be
ordered by: group/Protocol/PTID/Visit combinations. The
report is then grouped by group/ID2.

Lab 485
Specimen Count
With Volume

Similar to the Lab 485 Specimen Count report, this
report was designed to provide a count for unique
Primary/Additive/Derivative/Sub-Derivative combinations
that can be ordered by: group/Protocol/PTID/Visit
combinations. The report is then grouped by group/ID2.

Lab 188 Storage This report provides a summary of the samples that are
available in the local LDMS database, as well as provide
a summary of what has been stored. The report is sorted
by Global Specimen ID and displays “Not Stored” if
samples have yet to be placed in the virtual storage
structure. This report would be helpful for a user in
tracking of what has been stored and what still needs to
be stored in their LDMS.

Lab 40 LabKey
Report

This report is designed to allow the lab to dump data into
a specified format that can be read/imported into their
LabKey program for some of their internal projects. The
report provides basic specimen information including
processing information, storage data, and shipping
information.
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Sample Counts
for Specified
group

This report is designed to allow the lab to view the
number of samples that are available of a given
specimen type. The report is grouped by the samples
group. This would be helpful to a user to view a summary
of available samples for a given group based on their
sample type.

Exports Reports

Export Status
Report

This report provides the user with a summary of all of
the export transactions that have occurred at the lab.
The report provides information such as export number
and its current status. This report would be useful for
tracking the exports for the lab.

Immunology Reports

Advanced Flow
Codes

This report provides the user with a printable report
that lists the various codes that would be used with the
Advanced Flow assay in the LDMS. These codes include
Anchor Gates, Color Codes, and Subset Marker Codes.

LPA Stimulant
Codes

This report provides the user with a printable report that
lists the LPA Stimulant codes and descriptions that would
be used with the LPA assay in the LDMS.

Apoptosis by
P.I. Summary
Report

This report provides the user with a summary of which
samples have Apoptosis by P.I. results completed. These
results are grouped by group/ID2.

IQA
Cryopreservation
Summary
Report

This report provides the user with a summary of which
samples have IQA Cryopreservation Assay results
completed as well as a viral load. These results are
grouped by group/ID2.

Advanced Flow/
Tunel Summary
Report

This report provides the user with a summary of
which samples have Advanced Flow or TUNEL results
completed. It also provides if results were obtained as
well as the test that was completed on the sample. These
results are grouped by group/ID2.

LPA Summary
Report

This report provides the user with a summary of which
samples have LPA Assay results completed. These results
are grouped by group/ID2.

NK Summary
Report

This report provides the user with a summary of which
samples have NK Assay results completed. These results
are grouped by group/ID2.
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Advanced Flow
Hardcoding
Report

This report provides the user with a summary of
the various anchors, markers, and colors that are
associated with a given protocol/ID2. These fields were
predetermined by the study and what was expected for
the study.

Blank Advanced
Flow Patient
Report

This report provides the user with a blank sheet that
can be printed out that has all the necessary fields for a
given study with the appropriate hardcoded fields already
completed. The user can print this out and complete for
each patient on the given study.

LPA Check
Report

This report provides the user with a summary of the
results for any completed LPA Assay. The report is broken
down on a specimen basis for the user to review.

Advanced
Flow Count By
Protocol

This report provides the user with a simple count of how
many Advanced flow assays have been completed for a
given group/ID2. This report would be helpful to the user
to track work flow within the lab.

LPA Count By
Protocol

This report provides the user with a simple count of
how many LPA assays have been completed for a given
group/ID2. This report would be helpful to the user to
track work flow within the lab.

Advanced Flow
Check Report

This report provides the user with a summary of the
results for any completed Advanced Flow Assay. The
report is broken down on a specimen basis for the user
to review.

IQA Reports

Percent Viable
Recovery-
Summary

This report provides the IQA lab with a summary of the
Percent Viable Recovery at the IQA after the samples
had been thawed for a given month. This report would
be useful for the user to provide a summary of a lab’s
performance in the IQA in a give timeframe for Viable
Recovery.

Percent
Viability-
Summary

This report provides the IQA lab with a summary of the
Percent Viability at the IQA after the samples had been
thawed for a given month. This report would be useful
for the user to provide a summary of a labs performance
in the IQA in a given timeframe for Percent Viability.

IQA Sending
Lab Reports

This report provides the IQA lab with a summary of
the various cryopreservation fields imported from the
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processing labs. This report is searchable by Processing
Lab or Thaw Date.

Miscellaneous Reports

LDMS Prim,
Add, Der and
Sub Add/Der
Codes

This report provides the user with a complete list of all
of the coded values and descriptions for the primaries,
additives, derivatives, and sub additives/derivatives used
within the LDMS. This report would be useful for the user
to print or reference when trying to identify the code
values for the specimens that need to be logged

LDMS
Abbreviated
Codes

This report provides the user with a complete list of all of
the descriptions of the various abbreviated values used
within the LDMS, such as but not limited to Measurement
Units and Visit Units. This report would be useful for the
user to print or reference when trying to identify the
abbreviated codes for the specimens that need to be
logged

LDMS Assay
Censor Codes

This report provides the user with a complete list of all of
the censor codes and their descriptions used within the
LDMS. This report would be useful for the user to print
or reference when trying to identify the censors for the
assays that the lab uses.

Virology and
Immunology
Assay Count, By
Protocol

This report provides the user with a complete count
of how many assays have been run per group/ID2 for
the Virology and Immunology assays used within the
LDMS. This report would be useful for the user to print
or reference when trying to identify the censors for the
assays that the lab uses.

Recommended
Test Add/Der

This report provides the user with the recommended
additives and/or derivatives used when assigning a test
to an aliquot. This report would be useful for the user to
print or reference when trying to identify which codes are
recommended for a given assay.

Clinic Contact
Report

This report provides the user with detailed contact
information for all/selected clinics. This report would be
useful for the user to print or reference when trying to
identify the clinic that a logged sample may have come
from.
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MT-2 Results Reports

MT-2 Results
Report

This report provides the user with a summary of the
MT-2 assay results that have been completed in the
Results tab. This report is grouped by group/ID1.

P24 Antigen Reports

P24 Results by
Study

This report provides the user with a summary of the
various P24 assay results that have been completed in
the Results module. This report is grouped by group/ID1.

Patient Summary Reports

Patient
Identifiers

This report provides the user with a summary of all the
PIDs that have been “enrolled” into the lab’s database.
This report is useful since it provides the user with the
ID2s, ID3s and clinics that have been logged into the
lab’s database (grouped by ID1)

PK (Pharmacology) Reports

LDMS
Participant
Report -
Pharmacology
Assay

This report provides the user with a participant overview.
It includes information at-a-glance for a specific
particpant such as, but not limited to: collection date,
clinic name, specimen ID, primary and additive types. It
will also show available results for analytes, review and/
or sample comments.

Pharmacology
Drug Count

This report provides the user with a count of how many
results are available for a given analyte. The report is
then grouped by group/ID2. This report would be useful
for the user in determining how many results they have
for a given assay to summarize or predict workload.

Pharmacology
Drug List

This report provides the user with a list of all of the
available drug codes currently in the LDMS and provides
the description of what the drug code stands for. This
report would be useful to print or reference when trying
to identify the drugs currently available in the LDMS.

Pharmacology
Proficiency
Results

This report provides the user with a printable report to
summarize the proficiency panel data for a given CPQA
PK round. Results are included and excluded based on
the validity of run censor codes. The lab is generally
required to print out and sign off on this report for CPQA
record keeping purposes.
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PK Drug Limits
By Run

This report provides the user with a list of all the PK
assay runs that have been completed in the LDMS, as
well as the Limits and Units that were entered for each
run. This report would be useful for the user to reference
what Limits have been used in the past.

PK Summary
Report

This report provides the user with a summary of all the
assay results for the PK Assays. The report is grouped
by group/ID1 and provides the Runid’s, Analytes, and
various censors.

PK Summary
with Assay
Name

This report is identical to the PK Summary Report, but
with the addition of the assay name to the report.

PHIA reports

PHIA Time to Freeze QA/QC Summary

This report is identical standard Time to Freeze QA/QC Summary, except
that the expected time value has been changed from 480 minutes to 1600
minutes.

Preload Reports

Preload List This report provides the user with a list of all of the
available preloads that are present in the local LDMS,
including FSTRF-defined preloads. The report also
summarizes all of the details of the preload, including
criteria and output.

RNA PCR Reports

RNA Roche
Amplicor Report

This report provides the user with a summary of all the
assay results for the RNA Roche Amplicor Assays. The
report is grouped by group/ID1 and also provides the
Runid’s and various censors.

RNA Roche
UltraSensitive
Report

This report provides the user with a summary of all the
assay results for the RNA Roche UltraSensitive Assays.
The report is grouped by group/ID1 and also provides
the Runid’s and various censors.

RNA Nuclisens
Report

This report provides the user with a summary of all the
assay results for the RNA Nuclisens Assays. The report is
grouped by group/ID1 and also provides the Runid’s and
various censors.
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RNA Organon
Teknika NASBA
Report

This report provides the user with a summary of all
the assay results for the RNA Organaon Teknika Nasba
Assays. The report is grouped by group/ID1 and also
provides the Runid’s and various censors.

RNA Roche
Amplicor
Patient Report

This report provides the user with a detailed listing of the
assay results for the RNA Roche Amplicor Assays for a
given patient/run. The report provides the Runid’s and
various censors, calculated results and watermarks.

RNA Roche
UltraSensitive
Patient Report

This report provides the user with a detailed listing of the
assay results for the RNA Roche Amplicor Assays for a
given patient/run. The report provides the Runid’s and
various censors, calculated results and watermarks.

Blank Qual
Nuclisens
Report

This report provides an relatively empty report designed
specifically for the Qual Nuclisens assay. The report
would be useful for the user since it provides a report
that can be generated and printed for manual inputs for
lab use.

Amplicor Repeat
and Censored
Run/Samples

This report provides the user with a summary of all the
censored and repeated run for a particular PID. The
report is grouped by group/ID1. This report would be
useful for a user that wants to identify whether they are
having issues running samples for a given PID.

UltraSensitive
Repeat and
Censored Run/
Samples

This report provides the user with a summary of all the
censored and repeated run for a particular PID. The
report is grouped by group/ID1. This report would be
useful for a user that wants to identify whether they are
having issues running samples for a given PID.

RNA Roche
Amplicor Line
Listing

This report provides the user with a summary of all of
the results for a given PID. The report is grouped by PID/
ID1 and also includes some run information, results,
and censors. This report would be useful for a user that
wants to identify all of the results that they currently
have for a particular PID.

RNA Roche Ultra
Lin Listing

This report provides the user with a summary of all of
the results for a given PID. The report is grouped by PID/
ID1 and also includes some run information, results,
and censors. This report would be useful for a user that
wants to identify all of the results that they currently
have for a particular PID.

RNA Runs Not
Reviewed

This report provides the user with a list of all the
different assay runs that have been resulted but have
yet to have been marked to review. This report would be
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useful for a user to identify which RNA assays still need
to be reviewed.

Cobas Amplicor
Patient Report

This report provides the user with a detailed listing of the
assay results for the COBAS Amplicor Assays for a given
patient/run. The report provides the Runid’s and various
censors, calculated results and watermarks

Cobas
Ultrasensitive
Patient Report

This report provides the user with a detailed listing of the
assay results for the COBAS Ultrasensitive Assays for a
given patient/run. The report provides the Runid’s and
various censors, calculated results and watermarks

Roche
Ultrasensitive
Tech Audit
Report

This report provides the user with a list of all the assay
runs for the Roche Ultrasensitive assays, specifically to
list the multiple Technician initials associated with the
Run. This report would be useful to the user to identify
which technicians were associated with a particular run
and/or to list all the runs for a specified technician.

Roche Amplicor
Tech Audit
Report

This report provides the user with a list of all the assay
runs for the Roche Amplicor assays, specifically to list
the multiple Technician initials associated with the Run.
This report would be useful to the user to identify which
technicians were associated with a particular run and/or
to list all the runs for a specified technician.

Abbott Realtime
HIV1 Assay
Report

This report provides the user with a summary of all the
assay results for the Abbott Realtime HIV1 Assays. The
report is grouped by group/ID1 and also provides the
Runid’s and various censors.

Abbott Realtime
HIV1 Patient
Report

This report provides the user with a detailed listing of the
assay results for the Abbott Realtime HIV1 Assays for a
given patient/run. The report provides the Runid’s and
various censors, calculated results and watermarks

TaqMan
Realtime HIV1
Assay Report

This report provides the user with a summary of all the
assay results for the TaqMan Realtime HIV1 Assays. The
report is grouped by group/ID1 and also provides the
Runid’s and various censors.

TaqMan
Realtime HIV1
Patient Report

This report provides the user with a detailed listing of the
assay results for the TaqMan Realtime HIV1 Assays for
a given patient/run. The report provides the Runid’s and
various censors, calculated results and watermarks

Abbott Repeat
and Censored
Run/Samples

This report provides the user with a summary of all the
censored and repeated runs for a particular PID. The
report is grouped by group/ID1. This report would be
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useful for a user that wants to identify if there are issues
running samples for a given PID.

Taqman Repeat
and Censored
Run/Samples

This report provides the user with a summary of all the
censored and repeated runs for a particular PID. The
report is grouped by group/ID1. This report would be
useful for a user that wants to identify if there are issues
running samples for a given PID.

Cobas Amplicor
Assay Report

This report provides the user with a summary of all the
assay results for the COBAS Amplicor Assays. The report
is grouped by group/ID1 and also provides the Runid’s
and various censors.

Cobas
Ultrasensitive
Assay Report

This report provides the user with a summary of all the
assay results for the COBAS UltraSensitive Assays. The
report is grouped by group/ID1 and also provides the
Runid’s and various censors.

HIV RNA Assay
Control Data

This report provides the user with a summary of all of
the control data for a given run. The report is grouped by
assay type and provides a multitude of different pieces of
control data for the associated Runid.

TaqMan
Realtime HCV
Assay Report

This report provides the user with a summary of all the
assay results for the TaqMan Realtime HCV Assays. The
report is grouped by group/ID1 and also provides the
Runid’s and various censors.

TaqMan
Realtime HCV
Patient Report

This report provides the user with a detailed listing of the
assay results for the TaqMan Realtime HCV Assays for a
given patient/run. The report provides the Runid’s and
various censors, calculated results and watermarks

Taqman HCV
Repeat and
Censored Run/
Samples

This report provides the user with a summary of all the
censored and repeated runs for a particular PID. The
report is grouped by group/ID1. This report would be
useful for a user that wants to identify if there are issues
running samples for a given PID.

RNA Reports

HIV DNA PCR
Report

This report provides the user with a summary of all the
assay results for the HIV DNA PCR 1.0 Assays. The report
is grouped by group/ID1 and also provides the Runid’s
and various censors.

HIV DNA PCR
1.5 Report

This report provides the user with a summary of all the
assay results for the HIV DNA PCR 1.5 Assays. The report
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is grouped by group/ID1 and also provides the Runid’s
and various censors.

DNA Patient
Report

This report provides the user with a detailed listing of
the assay results for the DNA PCR 1.0 Assays for a given
patient/run. The report provides the Runid’s and various
censors, results and watermarks

DNA 1.5 Patient
Report

This report provides the user with a detailed listing of
the assay results for the DNA PCR 1.5 Assays for a given
patient/run. The report provides the Runid’s and various
censors, results and watermarks

Unused VQA
blinded control
Report

This report provides the user with a list of all of the
remaining VQA blinded controls that have not been used
on a given DNA PCR run. This report would be useful
to the user to track how many remaining VQA blinded
controls that they have remaining.

DNA 1.5 Tech
Audit Report

This report provides the user with a list of all the
assay runs technician initials for the DNA PCR 1.5
assays, specifically to list the multiple Technician initials
associated with the Run. This report would be useful to
the user to identify which technicians were associated
with a particular run and/or to list all the runs for a
specified technician.

RPID Reports

Random PID
Report

This report provides the user with the linking between
the actual PID and the RPID for a particular specimen.
This report would be useful for a user to have a summary
of the confidential linking in one place.

RPID Specimen
Request

This report provides lab 223 with a mapping of
specimens from a submitted specimen request that
would be dropped down to the labs tableset and provides
the location of the specimens after the RPID program
randomizes the information within the request.

Lab 223 RPID
Oracle Merge
Report

This report is designed strictly for lab 223 with the use
of their local oracle database that is used to track details
about the DNA extraction for the RPID samples. The
data within this database is loaded into a temp table and
merged with the specimens in the LDMS via the Other
Specimen ID field and the sample number held within the
oracle table.

Specimens Not
Arrived

This report provides lab 223 with a list of specimens
that were expected to be sent to lab 223 (based on a
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table request that is dropped to their lab) but have yet to
arrive at the lab.

Lab 223 -
LDMS to Oracle
Mapping

This report provides the linking of the different Other
Specimen ID’s in the LDMS to their associated RPID
based on local LDMS and lab 223’s separate Oracle
database.

Lab 223 Oracle
to LDMS
Mapping

This report provides the linking of the different codes
that are held within lab 223’s separate Oracle database
to the associated fields in the LDMS. This provides the
user with a sample and code from their separate Oracle
database, and compares it to the currently linked Other
Spec ID, and the associated RPID value.

Discrepancy
Report

This report provides the linking of a Specimen ID and
Other Specimen ID for a sample before importing
through the RPID program and the corresponding
Specimen ID and other Specimen ID after the sample
has been moved through the RPID program. This report
is only available for lab 223.

Specimens for
a given Other
Spec ID

This report provides a list of Other Specimen ID’s and
their linking to their associated received Specimens. The
report also provides the specimen type, as well as the
receiving information.

Shipping Reports

Shipped
Specimen
Report - Detail

This report provides the user with a detailed summary of
all the shipments that the lab has completed. This report
would be useful to the user since it provides relatively
detailed information regarding their shipments, including
what specimens were shipped, when they were shipped,
who they were shipped to and the batch number.

Detailed
Imported
Specimen
Report

This report provides the user with a detailed summary of
all the shipments that the lab has imported. This report
would be useful to the user since it provides relatively
detailed information regarding shipments they have
imported, including the specimens that were imported,
when they were Imported, who originally shipped the
batch and the batch number.

Shipping Lab
Contact Report

This report provides the user with a detailed summary of
all of the contact information for a given lab. This report
would be useful to the user when looking for contact
information for a receiving or shipping lab, as well as
contacts for resolving queries for destination labs.
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Imported
Specimen
Report -
Summary

Similar to the Detailed Imported Specimen Report,
this report provides the user with a summary of all
the shipments that the lab has imported but in a more
compact nature. This report would be useful to the user
since it provides information regarding shipments they
have imported, including when it was Imported, who
originally shipped the batch, the batch number, and an
aliquot count per specimen type.

Shipped
Specimen
Report -
Summary

Similar to the Detailed Shipped Specimen Report, this
report provides the user with a summary of all the
shipments that the lab has completed but in a much
more compact nature. This report would be useful to the
user since it provides information regarding shipments
they have shipped, including when they were shipped,
the destination, the batch number, and an aliquot count.

Daily Imported
Specimen Log

This report provides the user with a summary of the
samples that a lab has imported grouped by group/ID1,
and provides the user with information regarding some
of the samples that were imported, when the specimens
were imported, what lab the samples came from and
sample condition. This report would be useful to the user
in that it will provide a easy means of identifying which
samples have been imported for a given protocol, as well
as an idea of when they have been received.

Pending
Specimens
Marked for
Shipping Report

This report provides the user with a summary of all the
samples that the lab has marked to ship in the specimen
management module, but has yet to ship. This report
would prove useful to labs when trying to organize their
shipments, with the ability to identify specimens that
they anticipate on shipping but have yet to do so.

Ambient
Shipments
Report

This report provides the user with a summary of all
of the primaries that have been marked for ambient
shipment. This report would be useful to the user in
that it provides a summary of all of the sample that
have touched the labs LDMS but was not necessarily
processed, and provides information such as specimen
information and intended destinations.

Lab 263
Summary Detail
of Shipped
Specimens

This report provides the user with a summary of the total
volume that has been shipped to a particular destination
for a given (group/Primary/Additive/Derivative/Sub Add/
Der/Volume Unit) This report would be useful to the user
to identify how much of a particular type of specimen has
been shipped for a given group and to their destinations.
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Specimen Management Reports

Specimens for a
Given group

This report provides the user with specimen details, while
grouping the given specimens by the affiliated group,
then ID1 they were assigned when logged. The user
would find this report useful when trying to identify what
specimens they have logged for a given group/ID1.

Primary
Specimens
Received

This report provides the user with a list of all of the
primaries that have been received by a given lab. The
report also summarizes some of the primary details and
includes a total primaries received count. The user would
find this report useful when attempting to identify how
many primaries that they have received into their LDMS.

Specimen Log
Report

This report provides the user with a list of all of the
specimens that the Lab has logged into their LDMS.
The report also provides the primary and associated
aliquot information for a given specimen. The user would
find this report useful when identifying the amount of
specimens that have been logged into their LDMS with
selected criteria.

Specimens
Missing group
Assignments

This report provides the user with a list of all specimens
that do not have a group assigned to them.

Specimen Count
Report

This report provides the user with a summary of the
number of specimens that the lab has logged for a given
group/ID1. The summary also provides the user with
the number of specimens that are stored for the given
group/ID1, as well as the number of aliquots that have
been shipped for the given group/ID1.

Lab 348
Specimen
Report

This report provides the user with the primaries for
the specimens in a given group/ID1 and includes the
condition code and an aliquot count as well. A user would
find this useful to generate the specimens for a given
group report in a more consolidated report.

Specimens for a
Given group 2

This report provides the user with the LDMS specimen
ID’s for a given group/ID1 and includes an aliquot count.
A user would find this useful to generate the specimens
for a given group report in a more consolidated report.

Specimen
Processing
Report

This report provides the user with a specific set of
information for each of their logged specimens. The
report will provide the user with the patient, primary,
and aliquot information for each of their specimens.
The report also provides the user with the processing
information (if available) for the given specimens,
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specifically the Total Cell Count, Processing Date(Primary
and Aliquot), Processing Time(Primary and Aliquot),
Processed By initials, Frozen Date, and Frozen Time.

Time to
Freeze QA/QC
Summary

This report provides the user with a summary of the
Draw Dates and Times, Frozen Dates and Times,
Specimen Types and the calculated amount of time it
took from the time a specimen was drawn to the time
the specimen began the freezing process. The report
also provides the data plotted in a graph for visual
representation. This report would be useful to the user to
identify how quickly the specimen goes from unprocessed
primary to the freezing process of the aliquots.

Time to
Process QA/QC
Summary

This report provides the user with a summary of the
Draw Dates and Times, Process Dates and Times, Frozen
Dates and Times, Specimen Types and the calculated
amount of time it took from the time a specimen started
to be processed to the time the specimen began the
freezing process. The report also provides the data
plotted in a graph for visual representation. This report
would be useful to the user to identify how quickly the
lab is completing processing to the freezing process.

Cell Yield QA/
QC Summary

This report provides the user with a summary of the
Draw Dates and Times, Total Cell Counts, Technician
initials, Total Volumes, Additive Types and the calculated
cell yield for the Viable PBMC’s that are logged into the
lab’s LDMS. The report also provides the data plotted in
a graph for visual representation. This report would be
useful to the user to provide assistance with the Quality
Control and Assurance of the lab by providing the cell
yield for specimens in comparison to other variables
which can identify if further investigation may be needed.

Lab 263
Summary of
Specimens

This report provides the user with a summary of the total
volume for a given (group/Primary/Additive/Derivative/
Sub Add/Der/Volume Unit) This report would be useful
to the user to identify how much of a particular type of
specimen is available for a given group.

Storage Reports

Storage Detail This report provides the user with a summary of all
the specimens that are stored in a particular storage
container in the Storage module. This report would be
useful to the user in that it provides a detailed summary
of the exact specimens and location of all the aliquots
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that are stored in a container held within a lab’s storage
structure hierarchy.

Storage Count
Report By
Freezer

This report provides a count of specimens that are
contained within a given freezer. This report would be
useful in that it provides the user with a summary of the
samples for a given group/ID1/Specimen Type that a
particular Freezer currently holds.

Specimens
Not In Storage
Report

This report provides a summary of all of the specimens
that are currently logged into a lab’s LDMS that have
yet to be logged into a storage container in the storage
module. This report would prove to be useful in that it
would give the user an idea of what specimen still need
to be stored in the storage module.

Specimens
Remaining in
Storage

This report provides a user with a count of the number
of aliquots that are still in the storage module for a given
group/ID1/ID2 sorted by group. This report is useful for
a user that may want to determine how many samples
remain in storage for a given PID and where they are
stored, especially in cases where additional aliquots may
need to be identified.

Specimens in
Storage per PID

This report provides the user with a count of all
specimens that remain in storage a given group/ID1.
This report is useful for a user who may need to know
how many total specimens are in storage for a given PID.

Inactive
Storage
Configurations
Still In Use

This report identifies what storage configurations are no
longer active, but are still being used.

Storage
Container
Location

This report identifies what freezer, shelf, rack a box is on
and what position the box is in. This will allow a lab to
easily confirm boxes are in the correct location.

Shipped
Samples in
Storage

This report provides the user with a location listing of
shipped specimens that are still occupying space in the
lab’s storage structure hierarchy.

Shipped
Samples
in Storage
(Export)

This report provides the user with a location listing of
shipped specimens that are still occupying space in
the lab’s storage structure hierarchy, in an exportable
format.
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VTN Reports

SCHARP Export
Report

This report provides the user with a summary of all of
the specimens in a local LDMS. The user can export this
report and provide a data management center, such as
SCHARP, with a summary of specimens in the local LDMS
with specific fields that make it somewhat different than
a specimen log report.

Guspec and
Storage
Location Report

This report provides the user with a simple linking of all
the specimens that are currently in a local lab’s storage
structure. The report provides the user with the Global
Specimen ID and its corresponding Storage location.

WIHS Reports

Processing Log -
Lab 263

This report provides the user with a list of samples that
fit a predefined criteria set by lab 263. When a certain
subset of Specimen Type and Other Specimen ID entries
are completed, the specimen appears on this report and
provides the processing instructions based upon the
Other Specimen ID code.

Viral Load
Results

This report provides the user with a list of the different
RNA assay runs that the lab has preformed, including
specific details regarding the run (Test type, Control
Information, Samples (including PID, Specimen/Received
Dates, Specimen Type) as well as the results.

WIHS Batch
Report

This report provides the user with details regarding assay
results that have been completed for a given lab on. It
provides summary information about the specimen as
well as summary information about the run itself.

WIHS Visit
Report

This report provides the user with a list of the different
RNA assay runs that the lab has preformed, including
specific details regarding the run (Test type, Control
Information, Samples (including PID, Date, Specimen
Type and Visit) as well as the results.

ZEBES Reports

ZEBS Report This report provides a user with a line listing of Primaries
that include information such as Patid, Specimen Date,
Condition, VID, and Primary. This report is designed to
not include headers or specific formatting for ease of
export.
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ZEBS Amplicor
Report

This report provides a user with a line listing of Primaries
that have a completed Roche Amplicor run for a ZEBS
specimen and includes information such as Patid,
VID/Unit, Viral Load, Censors, Specimen Date, and
Derivative. This report is designed to not include headers
or specific formatting for ease of export.

ZEBS
UltraReport

This report provides a user with a line listing of Primaries
that have a completed Roche Ultrasensitive Assay run
for a ZEBS specimen and includes information such as
Patid, VID/Unit, Viral Load, Censors, Specimen Date, and
Derivative. This report is designed to not include headers
or specific formatting for ease of export.

Commented
Specimens
Report

This report provides a user with a line listing of
specimens that have a comment assigned to them.
It provides fields such as PID, Additive, Specimen ID,
Specimen Date, Derivative, Global Specimen ID, Primary,
Sub Add/Der, Comments, Non ACTG PID/ID1, and
Derivative. This report is designed to not include headers
or specific formatting for ease of export.

Labels

Advanced Label Printing
When you add or modify aliquots in the Specimen Management    task,
you will automatically be prompted to print labels. You can reprint labels in
Specimen Management by right-clicking on an aliquot and selecting Print
Labels for Selected Aliquots.

In Specimen Management   , you can only generate labels for aliquots that
are part of the same record. In contrast, the Labels    task allows you to
search for specimens instead, allowing you to generate multiple labels at
once.

Access the Labels task by clicking the    button from the LDMS toolbar.
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Figure 41: LDMS Labels screen

The labels format screen

Printing labels

1. Select a Group from the drop-down list in the top-left of the screen.
2. Select the label Format from the drop-down list the top-right.
3. Select the label stock (i.e. paper) from the list beneath the Group list.

(Stock that is disabled has too few rows for the label Format selected).
4. If you have a list of global specimen IDs, click the    button. The file

must be a list of Global Specimen IDs, where each line contains exactly
one ID.

5. Select a field from the Field drop-down list.

Note:

At least one of the following fields must be part of your search:

• Specimen ID
• Global Specimen ID
• Received Date
• Harvest Date (cultures only)
• Received Batch Number
• Ship Batch Number

6. Select an Operator for the search term.
7. Select a value to search for in the Value field.
8. Click the    button. This will add your criteria to the list on the left.
9. Once you've added all the criteria you want to add, click the    button

from the LDMS toolbar.

Tip:

Were you printing labels and something went wrong? Rather than re-
printing all of the labels, you can start in the middle to avoid re-printing
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labels that you already printed. Enter the number of labels that you
don't want to print from the beginning of the labels into the Skip field.
These labels won't be added to the labels generated.

Creating a New Label Format
Labels in LDMS are setup like tables. A label consists of an optional barcode,
and rows and columns of fields. Everything on the barcode is center aligned.
For each field, you need to select the row that it will appear in and the column
(or position) in that row. You are limited to four fields per row.

Figure 42: Parts of a label

A typical label, showing how each field corresponds to a row and column. If a barcode is selected, it will always appear

first. Every row is center aligned, so columns may not necessarily be aligned.

Creating a new label format:

1. Select Tasks > Labels from the LDMS menu bar or click the    button
from the LDMS toolbar.

2. Select a group from the Group list.
3. If you want to base your new label on an existing label, select an existing

format from the Format menu, otherwise leave the Format field blank.
4. Click the    button from the LDMS toolbar. You'll be prompted if you want

to create a new label based on the label selected in the Format field (if no
format was selected, LDMS will tell you that you are basing your label on
""). Select Yes or No as appropriate.

5. Enter the name for your label as you want it to appear in LDMS Specimen
Management    into the text box.

Figure 43: Label format settings and label output

The label formatting settings used to achieve an output label.
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This will create a new entry in the Format menu for the selected group. Your
new label format will be blank though, so you need to configure it. This is
done on the right side of the screen. To add a field, select the check box next
to it, and then enter the row and col[umn] where the field should appear.

Format options:

Barcode
Content

The barcode for the label; this always appears at the top
of the label, if selected.

Data Item Name of the field from LDMS to display; click the check
box next to a field to display it.

Length The length of a field (in characters). This is how much
space the field needs to appear on the label.

Row Enter the row on the label where you want the field to
appear.

Col Enter the position in the row where the item should
appear (e.g. 1 for first, 2 for second, etc).

You can see a preview of how your labels will look on a given stock to make
sure that there will be no issues when you print actual labels. To do this,
select your label format, then select a label stock on the left side of the
screen. Next click the    button. This will generated labels without real
data so that you can test your printer with the new label format.

Note:

The available label stock on the left will automatically reflect the label
selected. Each stock is only capable of displaying so many rows (as
shown in the Max Rows column). To learn more about a stock, select it
and click the Label Manufacturer button.

Alignment options

Number of
sample label
rows

Number of labels of display.

Preview Display the labels; this is the same thing you will see
in LDMS Specimen Management when you actually
generate the labels.

Show Field
Names

Display the name of each field; the extra text may cause
readability issues (field names will never appear on
actual labels though).

Show All
Positions

This will show used rows as X and unused (but available)
space as O.
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Once you've finished configuring your label's format, click the    button from
the LDMS toolbar.

Setting the Default Label Size and Format
When you add or modify specimens in LDMS Specimen Management   , you
will be prompted to print new labels for the specimens. You can change the
default label size and format selected for different groups, to avoid needing to
select this information every time. You'll still be given the opportunity before
creating the labels, however, to override the default settings.

Setting the default label size and format for a group

1. Click Administration > Label Setup from the LDMS menu bar.
2. Select the group for which you want to define the default label settings

from the Group drop-down list.
3. Select the desired label format for new specimen labels for this group from

the Label Format drop-down list.
4. Select the desired label stock size from the Label Size list.
5. Click the OK button.

This can be done for multiple groups, meaning the default setting for one
group can be different than another. If you are printing labels for specimens
from different groups (such as co-enrollments), you'll be prompted to print
labels for each group separately with the appropriate default label settings
selected.

Barcodes
LDMS supports different 2D barcode formats on labels. The barcode (if
present) always appears first on the label, and contains the global specimen
ID.

Barcode readers can be used in many different places in LDMS to scan a
barcode and quickly do something with a specimen:

Barcode functions in LDMS

  Specimen
Management

Scanning a barcode in LDMS Specimen Management 
  will jump to the records associated with that Global

Specimen ID.

  Storage Scanning on the Bulk Add tab will select the specimen
for storage; scanning on the Main View tab will bring up
that specimen's storage location.

  Shipping Scanning on the Setup Shipment tab will add the
specimen to a shipping batch; scanning on the QA/
QC tab will mark that specimen as PASSED of FAILED,
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depending on whether or not the global specimen ID
matches.

  Assays Scanning on the Assay Selection tab will add the
specimen to the Specimens Found list.

To set the default barcode reader for LDMS, go to Administration > System
Configuration and change to the Configuration tab. Look for the Barcode
Reader option. For most hardware, the Code Reader option should suffice.

Tip:

Here are a few tips for using barcode readers with LDMS:

• Hold the scanner four to six inches away from the barcode
• Don't scan at a 90 degree angle
• If a barcode doesn't scan, let go of the trigger before trying to read

it again
• Verify that a barcode scans before storing or shipping the specimen

If you need assistance getting a barcode reader to work, contact LDMS
User Support.

Setting the Printer Used to Generate Labels and
Reports
When LDMS generates reports or labels, it uses the driver for your printer to
determine paper size and orientation. LDMS needs to know what printer you
are using before generating any labels. If this crucial step is not performed,
labels will not be sized correctly for your label printer, even if you select the
correct printer to actually print them.

Important:

If you want to modify the paper size or orientation for your printer, this
must be done in your Microsoft Windows® printer settings. If you need
assistance setting up printing hardware, contact LDMS User Support for
assistance.

Configuring the printer used to generate labels and reports:

1. Select Administration > Printer Configuration from the LDMS menu
bar.

2. From the Report Printer list on the left, select the printer's driver that
should be used to generate reports.

3. From the Label Printer list on the right, select the printer's driver that
should be used to generate labels.

4. Click the OK button.
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Printing Test Labels
It is possible to print a set of test labels so that you can see how a specific
label will appear when printed with your hardware. This can be done using
fake information that takes up the maximum amount of space, allowing
you to see if there are any places on your label where the text may not fit
correctly.

1. Open the labels task by clicking the    button from the LDMS toolbar.
2. Select a group from the Group list in the upper-left corner.
3. Select a label format from the Format box on the right.
4. Select a label size from the list of label stock on the left.
5. Click the    button.

The Create Alignment Report window will open. The following options
can be set:

Number of
sample label
rows

This is the number of rows test specimen labels to
generate per page.

Preview Whether or not to generate a preview.

Important:

Do not deselect this option. This option must be
enabled or the test labels will not be generated.

Show field
names

The name of each item on the label will appear next to
it.

! Warning:

This can affect the appearance of the labels,
and should not be used as a representation of
what the labels will actually look like.

Show all
positions

Each row will show the amount of space used by the
current label format and the amount available space,
based on the label stock size. The X on the label
means that information could be printed there, while O
means that it is free space. For example, if a row has
two items and each has a length of 8, then the row will
have 26 X show, and the rest of the row will show O.
This will help you see if your labels have extra spaced
based on the size you are using.

6. When the SAP Crystal Reports Viewer opens, click the Print button from
the toolbar to print the test labels.
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Assays

Running an assay means reading data
The method of getting assay data into LDMS will vary, depending on the assay
and available equipment at your laboratory. There are three ways to get assay
data into LDMS:

1. Read the assay output directly from the instrument
2. Read an output file that was created when the assay was run
3. Enter the assay results data by hand

LDMS does not really run your assay; it is more accurate to say that LDMS
reads assay data, and then stores it. This reading may or may not coincide
with running the assay, since the direct read method is not available for all
assays. Reading assay output using LDMS is also sometimes referred to as
"resulting" an assay in LDMS, since the intent is to get assay results into
LDMS's database for long-term storage.

The process of reading an assay in LDMS varies, depending on the assay
involved. Below are the steps that apply to most assays:

1. Select the assay and create a new run on the Assay Selection tab.
2. Find and chose the specimens in LDMS to be added to the run.
3. Set up the assay. This would include things like defining the locations of

controls on plates, the settings used when running the assay, etc.
4. Run (i.e. read) the assay. The exact method involved will vary by assay.
5. Review and accept assay results.
6. (If the results are for a study where data is managed by Frontier Science)

Perform an export.

Figure 44: Assay Workflow in LDMS
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Supported assays
These are the assays supported by LDMS.

Category Assay Direct
Read2

File
Transfer3

Data
Entry4

Qual. Macro. -- -- X

Qual. Micro -- -- X

Quant. Cell -- -- X
Cultures

Quant Fluid -- -- X

COBAS TaqMan HIV-1 Qual -- X --

Roche HIV DNA PCR X X --DNA PCR

Roche HIV DNA PCR 1.5 X X --

Advanced Flow -- -- X

Apoptosis by P.I. -- -- X

Cryopreservation -- -- X

LPA -- -- X

NK Assay -- -- X

Immunology

TUNEL Assay -- -- X

Misc MT-2 Assay -- -- X

Cult.-Dupont/PerkinElmer X X --

Culture-Abbott X X --

Culture-Coulter X X --

Culture-Organon Teknika X X --

[Teknika] VQA controls prior to 1997 X X --

Culture-ZeptoMetrix X X --

ZeptoMetrix Extended X X --

Dir.-Dupont/PerkinElmer X X --

Direct, Mono-Abbott X X --

Direct, Poly-Abbott X X --

Direct-Coulter X X --

ICD, mono-Abbott X X --

P24 Antigen

ICD, mono-Coulter X X --

2 Assay is capable of being read directly by LDMS using compatible
instruments.

3 Assay produces output that must be copied to the computer with
LDMS; LDMS can read these output files

4 The user must manually enter or copy results into LDMS.
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Category Assay Direct
Read2

File
Transfer3

Data
Entry4

ICD, poly-Abbott X X --

ICD, Dupont/PerkinElmer X X --

PK Assays [Various] -- -- X

Abbott Realtime HIV-1 -- X --

Abbott Realtime HIV-1 with
Calibrators

-- X --

COBAS TaqMan HCV -- X --

COBAS TaqMan HIV-1 -- X --

NASBA HIV RNA QT Assay -- X --

NASBA - No Negative Control -- X --

Nuclisens HIV RNA QT -- X --

Roche Amplicor Monitor HIV RT PCR X X --

Roche Amplicor (Kit Controls) X X --

Roche COBAS Amplicor -- X --

Roche COBAS Amplicor Ampliprep -- X --

Roche COBAS UltraSensitive -- X --

Roche COBAS UltraSensitive
Ampliprep

-- X --

Roche UltraSensitive HIV RT PCR X X --

Roche UltraSensitive (4 control) X X --

Viral Load RNA

Roche UltraSensitive (Kit Control) X X --

Managing assay runs

Assigning assays to specimens
Specimens must be assigned an assay before results for that specimen can be
entered or loaded into LDMS..

If a specimen is not assigned an assay, it will not appear as available to add
to an assay run. There are several ways that an assay can be assigned to a
specimen.

• Right-click the specimen on the Specimen Management screen, and then
click Test Setup.

• Use the Assign Tests tool.
2 Assay is capable of being read directly by LDMS using compatible

instruments.
3 Assay produces output that must be copied to the computer with

LDMS; LDMS can read these output files
4 The user must manually enter or copy results into LDMS.
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• Receive a shipment where the specimens have already been assigned an
assay.

Assigning assays to specimens
Specimens must be flagged for testing on a test before assay results can be
entered in LDMS.

Background

The Assign Tests tool can be used to assign many specimens to an assay
at once. First you indicate the criteria for the specimens that you want to
add. For example, the specimens might be from the same group or within a
specific received date range. Next, you select the specimens that met your
search criteria that you want to assign an assay. Finally, you select the assay
to be assigned.

Tip:  If you have a list of global specimen IDs for specimens that
you want to assign tests to, you can click Load From File instead of
searching for specimens. The list must be a text file with example one
global specimen ID per line.

Figure 45: Assign Tests

Steps

1. On the Tools menu, click Assign Tests.
2. Drag one or more specimen criteria from the Available Criteria list to

the Selection Criteria list.
3. For each criteria selected, do the following.

• In the Op column, select how the criteria should be applied.
• In the Value column, select or enter the value for the criteria.

4. Optional: In the Criteria Sentence box, enter how you want the
criteria applied, using the numbered rows in the Selection Criteria
list.
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If this box is left blank, criteria will be applied as 1 AND 2 AND 3
AND ....

Example

The following example indicates that on specimens for the FRONTIER
group that have the condition SAT or FRO should be listed.

Field Op Value

Condition = SAT

group = FRONTIER

Condition = FRO

Criteria Sentence: 2 AND (1 OR 3)
5. On the Database menu, click Execute.

The specimens available to be assigned an assay will appear in the
Select Samples list.

6. In the Select Samples list, click the specimens to be assigned an
assay.

7. In the Select a Test list, select the assay to be assigned.
8. Click Assign Selected Test.

Pending assay report
The Pending Specimens Report displays what specimens have been assigned
to a test without having results entered.

Background

Specimens that are listed on the Pending Specimens Report still need to be
tested and have results entered or loaded into LDMS. The report displays
basic information about the specimen, including its storage location.

Steps

1. On the Tasks menu, click Assays.
2. In the Assays list, select the assay.
3. On the toolbar, click Generate Report.
4. Click Assay Pending Specimens Report, and then click OK.
5. In the From and To boxes, indicate the received date range for the

specimens to appear on the report, and then click OK.
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Assay Selection tab
The Assay Selection tab is where you select the assay to run and specimens
to test. From this screen you can create new assay runs, customize template-
based assays, and review previously stored assay results.

Figure 46: Assay Selection tab

(1) Available assays and templates, (2) Action to perform, (3) Use currently selected assay and action, (4)

Existing assay runs, (5) Filter specimens below, (6) Find specimens assigned current assay and/or apply filters, (7)

Selected specimens, (8) Add selected specimens to run and open assay-specific setup screen

The typical workflow for navigating this screen is as follows:

1. Select the assay or template from the Assays list.
2. Select what you want to do from the Assay Select Criteria.
3. Click Select Assay.
4. Select specimens to test or continue working on the assay run.

There are various tasks that you can perform on assays listed in the Assay
Selection Criteria section. These will vary based on the assay selected.

Review/Edit Review previously run assays

Terminate/
Unterminate

(For cultures only) Terminate cultures or undo
termination

Design (For template-based assays) Create a new template

New Run/Not
Setup

Create a new assay run

Runs Not
Performed/Not
Terminated

Open an assay run that has been started and saved but
not yet completed

Creating a new assay run
Before specimen test results can be stored in LDMS, you must create a new
assay run. Assay runs are created the same way, regardless of the assay or
template being used.

Steps

1. On the Tasks menu, click Assays.
2. In the Assays box in the upper-left corner, select the assay or

template to be set up.
3. In the Assay Selection Criteria section, select New Run/Not

Setup.
4. In the upper-right corner, click Select Assay.
5. Find aliquots to be tested.

These are two ways to do this:
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• To find specimens assigned the selected assay, click Find
Specimens. Use the Specimen Search Criteria and Specimen
Received Date options to limit the number of specimens shown.

• To find a specific specimen, scan its barcode label.
6. Click to select each aliquot to be added to the new assay run.
7. At the bottom of the screen, click Add to Run.

Result
The new assay run will be created and you will automatically be taken to the
assay or template specific setup screen.

After you are finished
The newly created assay run will not be saved automatically. Save it by
clicking the Save button from the toolbar.

Specimen Thaw Count
All specimens in LDMS have a thaw count property. This property is set
to 0 by default when a specimen is created. The thaw count represents
the number of times that a specimen has been removed from storage and
warmed. There are two places in LDMS where this information is displayed:

• In the Specimen Management task   , thaws are displayed in the Aliquot
Details Window for all aliquots.

• In the Storage Management task   , thaws are displayed by selecting a
specimen in the storage view and clicking the Details button.

Since specimens generally need to be thawed when they are removed from
storage for testing, LDMS will automatically ask if you would like to increment
the thaw count for a specimen when you add it to a new assay run. This will
only happen, however, if you are adding the specimen by scanning it with a
barcode reader. If you are searching for the specimens to test and adding
them manually, LDMS will not ask if you want to increment the thaw count
(you can still do so using Specimen Management or Storage Management).

Adding Specimens and Controls not Logged into LDMS
There may be times where you need to test a specimen or control that is not
entered into LDMS through Specimen Management   . For example, you may
have a control that is used on assay internally at your laboratory.

Adding a specimen or control to an assay that was not logged into LDMS

1. Setup the assay as normal.
2. On the Preview tab, click the    button from the LDMS toolbar.
3. Enter an identifying name into the specimen identifier field. This is not

an LDMS specimen ID (since the specimen was not added to LDMS), but
rather a name for your usage.

Specimens added in this manner will always be placed into the next available
location in your assay setup. These specimens will appear on the assay result
report but will not be available to select for patient reports.
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Opening a saved, incomplete run
Runs that have been created but not completed can be saved and re-opened
later.

Background

In most assays, this is done by clicking the Save button from the LDMS
toolbar or clicking Run Later from the assay-specific setup screen. This may
be done, for example to set up the run in LDMS in advance of testing results
becoming available.

Steps

1. From the LDMS menu bar, click Tasks > Assays.
2. In the Assays box in the upper-left corner, select the assay or

template to be set up.
3. In the Assay Selection Criteria section, select Runs Not

Performed/Not Terminated.
4. In the upper-right corner, click Search.
5. In the Previous Runs Found list, click the run to be opened.
6. In the upper-right corner, click Select Assay.

Generating Layout Reports
For many assays, you need to tell LDMS the location of controls and
specimens on your testing equipment. This is generally done on a grid in
LDMS, where each position corresponds to a position on your instrument.

If you prepared the assay in LDMS before running it on your equipment, it
may be helpful to have a print out of how you set it up in LDMS. This way,
when you are setting up your equipment, you can be sure that it matches
your LDMS setup.

To generate a layout report, click the    button from the LDMS toolbar while
setting up or reviewing an assay before it has been run.

Reviewing Assay Results After They Have Been Read
The results of previously run assays are saved in your laboratory's LDMS
database and can be viewed at any time. You can review data, generate result
reports, censor results, enter review information, etc.

Viewing a previously read assay

1. On the Assay Selection tab, select the assay for the results you want to
review from the Assays list on the left.

2. Select the Review/Edit check box.
3. If known, enter the Run ID for the assay results you're looking for.
4. Click the    button on the right. This will list all assay runs for that

assay in the Previous Runs Found
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5. Select a run from the Previous Runs Found list, and then click the  
button. The assay results will be displayed.

6. Review, modify, or censor the run as needed.

Note:

The Results screen and options available when reviewing results
will vary, depending on the assay selected.

7. If changes were made (including entering reviewer information), click the 
  button from the LDMS toolbar.

Censor Codes
Censor codes can be assigned to specimens, controls and assay runs to
indicate an issue or special condition.

For example, a censor code might indicate a contaminated specimen or
equipment failure. User censors are those that are added by a user. System
censors are those that are added automatically by LDMS when certain
conditions are met.

There are three types of user and system censors:

specimen
censors

These censor a single specimen on a run; other
specimens on the run are unaffected.

run censors These censor the results of an entire assay run. They
indicate that something went wrong with the entire test.

test censors These censors are assigned in LDMS Specimen
Management    and are used to explain why an assay
that was expected to be run for the specimen was not
run.

Correcting Errors in Assay Runs
There may be times that you read an assay output file and, for whatever
reason, there is an error in the run. This might happen, for example, if there
is a discrepancy between the placement of a specimen in LDMS and your
physical assay plate. In this case, there is nothing wrong with the results, but
rather LDMS expects the specimens to be in a different plate location. You
correct the position of specimens on the plate, LDMS will be able to read the
results again, and they will now be correct. For other issues, only a single
specimen by be affected, and it will be more cost efficient to test that one
specimen on another plate to correct it.

This section will describe a few common errors that can occur and how to
correct them.

Controls with OD Ratio Failure

If a control in the assay results receives the system-assigned censor code
D (OD Ratio Failure), the control can be re-detected to validate your assay
results. To do this, you must run the control on another assay run where
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the control was detected correctly and is valid. You will need the following
information from this valid run:

• The LDMS runid
• Control name
• Plate number that the control appeared on
• Position (column) on the plate (e.g. 1 for the first column, 2 for the

second, etc.)

Updating a run with an invalid control due to OD ratio failure:

1. Open the completed run in LDMS Assays   .
2. Right-click on any specimen and select Censor Run.
3. Select the censor code C (control re-run and valid - assay is valid) and

click the OK button.
4. Enter the runid, control name, plate number, and position on the plate

(column) from the valid run into the appropriate fields.

If you look at your results now, you will see that the D or DF system censor is
still applied, but the run is now valid and the user censor code C (corrected)
has been added. The Re-detect Runid field will have the run ID for the run
with the validated control.

Modifying Dilution and Recalculating

If the calculated viral load result for an assay's results is above the upper limit
of the assay, the censor code X4 will be applied. When this happens, you can
modify the dilution and recalculate a specimen.

Updating specimen dilution after an assay has been completed

1. Open the completed run in LDMS Assays   .
2. Right-click on the specimen to be modified and select Modify Specimen.
3. Enter the new dilution into the Sample Dilution field, and click the OK

button.

LDMS will re-calculate the results based on the new dilution factor.

Out of Sequence Errors

An out of sequence error occurs if a well's absorbance values do not decrease
as the dilution factor increases across your plate. For Roche Virology assays,
this is designated by the system-assigned specimen censor codes L(HIV) for
specimens and L(QS) for controls, depending on the type of well.

Manually correcting an out of sequence error:

1. Open the completed run in LDMS Assays   .
2. Click the    button.
3. Select the Reselect Well option and click the OK button.
4. In the Change Selected Well window, select the specimen(s) that must

be updated and make your corrections.
5. Select the reason for your change from the Reason well is being

reselected drop-down list.
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The kit copies per mL will automatically be recalculated, and the censor code
C (corrected) will be applied to the specimen that was modified. The C censor
code will be used to document the change.

Virology assays

Abbott Realtime and COBAS TaqMan
LDMS supports the following Abbott Realtime and COBAS TaqMan assays:

• Abbott Realtime HIV-1
• Abbott Realtime HIV-1 with Calibrators
• Abbott SARS-COV-2 Quant
• COBAS TaqMan HIV-1
• COBAS TaqMan HCV

All of these assays are run relatively the same way in LDMS.

Note:

A note about Abbott Data.

Exporting data from the Abbott assay is done using the Abbott m2000rt
software. For detailed instructions on creating a result file with this
software, refer to the documentation provided with m2000rt. m2000rt
will output a text file with a filename similar to this:

m2000rt serial number_PCR plate name_date_time.txt

Unlike other viral load assays, the Abbott and TaqMan are setup as a line
listing instead of a plate layout on the Preview tab. Each row corresponds
to one control or specimen on the run. To re-arrange the order of specimens
and controls, select the match by position check box, and then use the 

  and    buttons. If match by position is selected, the order of
controls and specimens in LDMS must match the order of specimens and
controls in the output file exactly. If this option is not selected, LDMS will
match specimens to results using the global specimen ID, PID/ID1, or other
specimen ID values. If the match by position option is not selected and the
PID/ID1 is used in the result file, there cannot be more than one specimen
with that ID1 on the same run.
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Figure 47: The Preview tab for the Abbott Realtime HIV-1 assay

Shows the slight differences in the previous screen between the different
assays.

There are a couple of things you may want to do before reading the assay
output:

• Generate the Abbott Assay Run Preview report. This report shows
you the positions of the specimens and controls on the assay run, tube
position, and bar codes for specimens.

• Modify the dilution. This is done by selecting the appropriate cell in the
dilution column and changing the value.

• (Abbott and TaqMan HCV only) Change the sample preparation method.
For Abbott, this can either be manual or using the m2000sp; for TaqMan
HCV, select either manual or automated.

• (TaqMan only) Select the version of the assay that you used.
• Enter the Data Transfer Tech initials. This would be the person who

loaded the assay result file into LDMS (i.e. you).

After reading the assay, the results screen will be displayed. There are a few
things you can do on this screen.

• Review the assay results. Complete the Reviewed by and Reviewed
Date fields, and then click the    button from the LDMS toolbar.

• Add a censor code for a specimen, control, or the entire run. This is done
by right-clicking on the specimen or control and selecting the Censor
Specimen or Censor Run option.

• Change between raw and calculated results using the grid view options in
the bottom-right corner.
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• View and print the assay results report by clicking the    button from the
LDMS toolbar.

• View the patient report for patient specimens included on a valid assay run.
This option is found by clicking the    button.

After it has been run, the assay data will be available within LDMS for future
review.

Creating a required VQA200 control

For certain networks, the VQA200 control is required. LDMS expects that this
control is named exactly VQA200 in the assay output file. To add a VQA200
control:

1. Click the Add VQA Control button.
2. Specify the Control Lot Number by either:

• Selecting a previously used lot number from the list, or
• Entering a new lot number. The lot number must be in the format

VQA<control lot #><AR or RT>. Use AR on the Abbott Realtime
HIV-1 and RT on the COBAS TaqMan HIV-1. For example, enter
VQA11035079AR for a lot number of 11035079 on an Abbottt run.

3. Enter the expected value of 200.
4. Enter the minimum value. For Abbott Realtime HIV-1, enter 64; for

COBAS TaqMan HIV-1, use 98.
5. Enter the maximum value. For Abbott Realtime HIV-1, enter 642; for

COBAS TaqMan HIV-1, use 985.

If you've used the control before, the minimum and maximum values will
be set for you. While it is possible to bypass the VQA200 requirement for
networks that require it, you will need a challenge password from LDMS User
Support.

Kit Entry for Abbott and TaqMan Assays

When you run the Abbott Realtime HIV-1 or COBAS TaqMan HIV-1 assays,
kit information is automatically pulled from the assay result file. Two fields,
however, are not pulled from the result file: Date Rec[eived] and Storage
Temp[erature]. If this is your first time using the kit, you must complete
these fields using the Kit Entry tool.

Abbott SARS-COV-2 Quant
The Abbott SARS-COV-2 Quant assay is setup as a line listing instead of a
plate layout on the Preview tab. Each row corresponds to one control or
specimen on the run. To re-arrange the order of specimens and controls,
select the match by position check box, and then use the    and 

  buttons. If match by position is selected, the order of controls and
specimens in LDMS must match the order of specimens and controls in the
output file exactly. If this option is not selected, LDMS will match specimens
to results using the global specimen ID, PID/ID1, or other specimen ID
values. If the match by position option is not selected and the PID/ID1 is
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used in the result file, there cannot be more than one specimen with that ID1
on the same run.

Figure 48: The Preview tab for the Abbott SARS-COV-2 Quant Assay

There are a couple of things you may want to do before reading the assay
output:

• Generate the Abbott Assay Run Preview report. This report shows
you the positions of the specimens and controls on the assay run, tube
position, and bar codes for specimens.

• Modify the dilution. This is done by selecting the appropriate cell in the
dilution column and changing the value.

• Enter the Data Transfer Tech initials. This would be the person who
loaded the assay result file into LDMS (i.e., you). The Sample Prep. Tech
Initials and Amplification Tech Initials fields are also required.

After reading the assay, the results screen will be displayed. There are a few
things you can do on this screen.

• Review the assay results. Complete the Reviewed by and Reviewed
Date fields, and then click the    button from the LDMS toolbar.

• Add a censor code for a specimen, control, or the entire run. This is done
by right-clicking on the specimen or control and selecting the Censor
Specimen or Censor Run option.

• Change between raw and calculated results using the grid view options in
the bottom-right corner.

• View and print the assay results report by clicking the    button from the
LDMS toolbar.

• View the patient report for patient specimens included on a valid assay run.
This option is found by clicking the    button.
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After it has been run, the assay data will be available within LDMS for future
review.

Kit Entry and VQA Controls

The Abbott SARS-COV-2 Quant assay does not capture any kit information in
LDMS. This information is not parsed from the result file. The LDMS does not
expect any additional controls, such as the VQA200, to be included on Abbott
SARS-COV-2 Quant assay runs. Extra controls can still be added but they are
not required.

COBAS TaqMan HIV-1 Qualitative

Background

The COBAS TaqMan HIV-1 Qualitative assay (not to be confused with the
COBAS TaqMan HIV-1) can be found DNA PCR category. This assay is setup
and the results are read differently than most other assays in LDMS. The
result file is read during the setup process and LDMS will attempt to match
results to individual specimens and controls by global specimen ID or other
specimen ID and will show you any results that could not be automatically
matched. You will have the opportunity to associate unmatched results by
hand or simply ignore them.

You can either setup a 24-item run or a 48-item run. Like the name implies,
these two options set the maximum number of specimens that can be tested
in LDMS to either 24 or 48. Controls are automatically added to runs. The
table below shows the number and types of controls that will automatically be
added to a run.

Table 21: 24 and 48 item run comparisons

Control 24 item run 48 item run

VQA blinded controls Two Four (two per rack)

Kit positive One Two (one per rack)

Kit negative One Two (one per rack)

VQA copy control Four Four

Maximum number of testing specimens (less
controls)

16 36

VQA controls will only be added for certain groups. For example, if you tested
specimens for an internal group, the VQA controls would not be added and
you could test four additional specimens on the run.
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Figure 49: COBAS TaqMan HIV-1 Qualitative Assay

The COBAS TaqMan HIV-1 Qualitative assay after a result file has been selected and matching has taken place;

unmatched results in the result file are displayed on the left.

Steps

1. Create a new COBAS TaqMan HIV-1 Qualitative run and add assigned
specimens to it.

2. Select either 24 item run or 48 item run from the bottom of the
screen.

3. To add more specimens, VQA copy controls, or VQA blinded controls,
click the Add Item button.

4. Select the kit lot number for any VQA copy controls by right-clicking
on the specimen and selecting Select VQA lot number.
You can either select an existing lot number or enter a new one.

5. Specify the VQA blinded control that were used by selecting the
appropriate VQA blinded control from the drop-down list next to each.

6. Click the Select Result File button.
A window will appear allowing you to choose to the result file created
when you ran the assay.

7. Complete specimen matching. Specimens in the result file will
automatically be matched to specimens.

This will be shown by the Result ID column. Specimens without a
result ID listed were not automatically matched. Unmatched results
will appear on the left. To associate a result with a specimen, drag it
from the list on the left to the desired specimen on the right. You can
also drag results back to the unmatched results to remove it, or move
it to a different specimen.

All specimens added to the run in LDMS must have an associated
Result ID, however, there may be unused results in the file that are
not associated with a specimen.

8. In the Assay Version box, select the version of the assay.
9. In the Tech Initials box, enter the initials of the assay technician.

10. In the Run Date box, enter the date that the assay was run.
11. Click Commit Results.
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Result

After committing the results, they will be immediately saved to your LDMS
database. A screen will then appear, showing you the results and any censors
that may have been automatically applied by LDMS. You can enter comments
and reviewer information, and then click the Save button from the LDMS
toolbar.

You can apply a censor to a specimen (or the entire run) by right-clicking on a
specimen and selecting Censor Specimen or Censor Run respectively. To see a
list of what individual censor codes mean, click the Options button. Because
this assay can be run with multiple racks, it is possible for one rack to have a
system assigned censor code applied to it while another rack has no censors.

There are two reports available after the TaqMan HIV-1 Qualitative assay has
been run:

assay results
report

Available by clicking the Reports button from the LDMS
toolbar.

patient report Click the Options button, and then select Print Patient
Report.

These reports can be accessed at any time after results have been read by
using the Review/Edit option on the Assay Selection tab.

Template-based virology assays

Creating a Customized Virology Assay Template

With the exceptions of Abbott and TaqMan, virology assays in LDMS are based
around templates. Templates are custom configurations that you can create
for an assay, with controls and settings for your specific assay needs. The
following virology assays in LDMS utilize templates:

• NASBA HIV RNA QT
• Nuclisens HIV RNA QT
• Roche Amplicor Monitor HIV RT PCR
• Roche COBAS Amplicor
• Roche COBAS UltraSensitive
• Roche UltraSensitive HIV RT PCR
• Roche HIV DNA PCR (versions 1 and 1.5)5

Some templates lock specific features during template creation for certain
assays (for example, you cannot modify the controls on some templates).
User templates are listed under their respective assay, and are shown in the
Assay List in all upper case.

5 This assay appears in LDMS under the category DNA PCR; all other
virology assays are in the category Viral Load RNA.
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Figure 50: Virology assay selection list

In this example, FS ASSAY is a user-created template for the Roche Amplicor assay; Roche Amplicor (Kit Controls)

is a system template that comes with LDMS for the same assay.

Creating a virology assay template:

1. On the Assay Selection tab, find the existing assay that you want to use
as the basis of your customizations.

2. Select the Design check box.
3. Click the    button; this will automatically take you to the Design

tab.
4. Make the changes that you need, such as adding plates, modifying

controls, and toggling wells.
5. Enter a name for your custom assay template into the Assay Name field,

and then click the    button.

! Attention:

You must make all your changes to the assay before clicking the   
button. You cannot modify and re-save assay templates after they have
been created.
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Virology assay template design screen

A typical plate layout. Each cell represents one well on the plate. The Assay
Options window is also shown.

You can use the buttons in the Plate Controls section to add and remove
plates from the assay, as well as change between plates. The current plate
and total number of plates also appears at the bottom of the screen.

Individual wells can be enabled and disabled by selecting them, and then
clicking the    button. Disabled wells appear as black boxes on the plate.
If you want to select multiple rows, hold down the Ctrl key. You can select an
entire column by clicking the header row above the column.

Adding, deleting, and modifying controls is done by clicking the    button.
To add a control, you'll need to specify the Control Number and Expected
Value for the control. While the control number will appear as written on the
well in the template, they are also assigned a sequential control number in
LDMS (1, 2, 3, etc.). If you need to modify or delete a control later, you'll
need to know that sequential number. So, while you can technically enter
anything for the Control Number, it's a good idea to use the number
of the next available control. If you want to see what the next available
control number is, select the Modify a control option, and then look in the
Specimen ID list. That list shows the current controls. Now, change to the
Add a control option and use the next number in the sequence.

Note:

Modifying controls on the assay is not available for all templates. If
the feature is not available for the assay that you have selected, the
Options button will be disabled.
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The Compress and Compress Wells options will remove empty wells by
moving other wells to fill them. Wells will be moved right to left to fill out the
empty space.

Important:

When a new virology template is create, an assay reader device must
be associated with it before it can be run in LDMS.

Running a Template-Based Assay

Important:

While the basic steps in running template-based assays are largely
identical across all virology assays, there are important, assay-specific
differences. Before running an assay, be sure to review the section
specific to that assay for those differences.

Virology assays can be run by using the templates that come with LDMS or by
creating your own template.

Figure 51: The Roche HIV DNA PCR 1.5 assay setup screen

This screen shows the setup screen for the DNA PCR assay (v1.5). Most virology assays will have the features shown,

though there are slight variations between assays.

The assay setup screen shows a visual representation of your assay plate(s).
Each well on the plate corresponds to one cell on the setup screen.

Setting up template based assays

1. On the Assay Selection tab, select the desired assay template from the
Assays list and the specimens to run, then click the    button.

2. If needed, add additional specimen. There are two ways to do this:
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• Return to the Assay Selection tab, select additional specimens from
the Specimens Found list, and then click the    button.

• Click the    button. You can enter a global specimen ID into the
Specimen ID field, and then click the Add button. You can also click
the Import button to import a text file list of global specimen IDs, with
one ID per line.

3. If needed, modify specimens or controls. Do this by right-clicking on the
specimen to modify and selecting Modify Specimen/Control. This is
how you would update the specimen/control's dilution factor, volume, or
expected result.

4. If needed, remove specimens or controls. Do this by right-clicking on the
specimen or control and selecting Delete Specimen/Control or Delete
Specimen/Control (Compress). The Compress option will move wells
from right-to-left to fill the gap created by the deleted specimen/control.

5. If needed, move specimens or controls. Do this by selecting the specimen/
control to move, clicking the    button, and then selecting the
destination well.

6. If needed, add or remove plates by clicking the    or    button
respectively.

7. If needed, enable and disable wells. Do this by selecting the well, and then
clicking the    button.

8. If needed, add controls. Do this by clicking the    button, and
selecting the Add Control option.

Once you have the assay setup exactly as it is on your plate(s), click the 
  button. You will be prompted to select kit and other information,

depending on the assay being run. If you cannot find your assay kit, you need
to enter it into LDMS.

LDMS will begin reading your assay results. When prompted, select the output
file from your assay.

Special information for individual template-based assays
NASBA HIV RNA QT

LDMS comes with two pre-defined templates for the NASBA assay.

Template Number of Controls Expected Values

NASBA HIV RNA QT 4 0 / 15,000 / 150,000 / 1.5e
+006 (i.e. 1,500,000)

NASBA - No Negative Control 3 15,000 / 150,000 / 1.5e+006
(i.e. 1,500,000)

The recommended maximum number of plates for the NASBA assay is three.
If you attempt to add more than three plates, LDMS will prompt you with a
warning message. LDMS will not automatically move or add controls when
specimens are added beyond the first plate.

Nuclisens HIV RNA QT

LDMS comes with one pre-defined templates for the Nuclisens assay.

Frontier Science Foundation 158



LS.0005 | LDMS for Windows - User Manual

Template Number of Controls Expected Values

Nuclisens HIV RNA QT 4 0 / 1,500 / 15,000 / 150,000

The recommended maximum number of plates for the Nuclisens assay is
three. If you attempt to add more than three plates, LDMS will prompt you
with a warning message. LDMS will not automatically move or add controls
when specimens are added beyond the first plate.

Roche Amplicor Monitor HIV RT PCR

LDMS comes with two pre-configured PCR assay templates for the Roche
Amplicor Monitor HIV RT PCR assay

Assay Number of controls Controls/Expected Values

Roche Amplicor Monitor HIV
RT PCR

4 VQA 1, 1,500, 15,000, and 150,000

Roche Amplicor (Kit Controls) 3 KN (kit negative), KLP (kit low
positive), and KHP (kit high
positive)

The expected values for VQA controls will be displayed on the Preview tab
before running the assay. The most plates recommended in a kit control assay
is four. LDMS will automatically move controls to a new plate if a new plate
is added while adding specimens. If there are more than four plates, a VQA
control with an expected value of 1,500 will be added to the fifth (and all
subsequent) plates.

Roche COBAS Amplicor

The Roche COBAS Amplicor is run identically to the Roche Amplicor Monitor
HIV RT PCR assay. For this assay, a plate in LDMS refers to an A-ring on the
real-life instrument. There are two pre-configured templates available for this
assay.

Assay Number of controls Controls/Expected
Values

Serial Dilutions

Roche COBAS
Amplicor

3 KN (kit negative), KLP
(kit low positive), and
KHP (kit high positive)

1:9

Roche COBAS
Amplicor Ampliprep

3 KN (kit negative), KLP
(kit low positive), and
KHP (kit high positive)

1:10

Roche COBAS UltraSensitive

The Roche COBAS UltraSensitive comes with two pre-configured templates.

Assay Number of controls Controls/Expected
Values

Serial Dilutions

Roche COBAS
UltraSensitive

4 VQA 0, 150, 1,500, 15,000 1:9
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Assay Number of controls Controls/Expected
Values

Serial Dilutions

Roche COBAS
UltraSensitive
Ampliprep

4 KN (kit negative), KLP
(kit low positive), KHP
(kit high positive),
and V (VQA control
with expected value of
1500)

1:10

The expected values for VQA controls will be displayed on the Preview tab
before running the assay. The most plates recommended in a kit control assay
is four. LDMS will automatically move controls to a new plate if a new plate
is added while adding specimens. If there are more than four plates, a VQA
control with an expected value of 1,500 will be added to the fifth (and all
subsequent) plates.

Roche UltraSensitive HIV RT PCR

The Roche UltraSensitive HIV RT PCR is run identically to the Roche Amplicor
Monitor HIV RT PCR assay. There are two pre-configured templates available
for this assay.

Assay Number of controls Controls/Expected Values

Roche UltraSensitive 4 KN (kit negative), KLP (kit
low positive), KHP (kit high
positive), and one control with
an expected value of 1,500

Roche UltraSensitive (Kit
Controls)

4 KN (kit negative), KLP (kit low
positive), and KHP (kit high
positive), and one control with
an expected value of 1,500

Roche HIV DNA PCR
LDMS supports version 1.0 and 1.5 of the Roche HIV DNA PCR (version 1.0 is
simply labeled Roche HIV DNA PCR without a version number). These assays
are found under the category DNA PCR on the Assay Selection tab.

Prerequisites

To run a DNA assay in LDMS, you must rename the two VQA blinded controls
at the beginning of the assay plate to match the actual VQA blinded controls
that you will be using. If you add more VQA blinded controls, those will need
to be renamed as well.

Background
Figure 52: Blind control well

A VQA blinded control well as it appears in LDMS. Notice that the expected value (E:) is hidden and the control is

labeled as BLND.
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Steps

1. Do one of the following:

• To rename a control, right-click the well with the VQA blinded
control and select Modify Control.

• To add a new VQA blinded control, click Blinded Controls
2. Enter or select the VQA blinded control.

If you are looking for a VQA blinded control that is not listed, try
performing an export, which will download and install the latest
deploy updates. If that does not work, contact LDMS User Support for
assistance. If you have added more than 10 specimens to a single PCR
assay plate, LDMS expects you to add more VQA blinded control. To
add more VQA blinded control, click Blinded Controls.

Figure 53: Modify control screen for PCR assays

The PCR version 1.0 (left) and version 1.5 (right) screens, accessed by right-clicking on a VQA blinded

control and selecting Modify Control.

Result

When running the assay, LDMS expects 2 different results files: one for the
specimen plate and another for the control plate. Single plate runs require
special consideration and setup.

After reading all plates in the assay's output, LDMS will show you the results
on the Results tab. You can generate an exportable version of these results by
clicking the Reports button from the LDMS toolbar.

Cultures
Creating a culture assay in LDMS is a mult-step process. It involves running
more than one assay, and working with special specimens derived from other
aliquots. The high-level steps involved are below.
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Figure 54: Culture workflow

The steps involved in creating and testing cultures in LDMS.

The rest of this section describes each step in this process in more detail.

Creating Culture Schedules
Culture schedules define the feeding and harvesting timeline for the culture(s)
you are creating. You can create several schedules and reuse them many
times. LDMS also comes preconfigured with a few standard schedules.

Figure 55: The culture schedule design screen

The schedule design screen replaces the assay design screen for cultures. The actual schedule appears in the Culture

Schedule list on the right.

Creating culture schedules

1. On the Assay Selection tab, select the appropriate culture for which you
want to create a schedule from the Assay list on the left side.

2. Select the Design check box.
3. Click the    button to enter design mode. This will automatically take

you to the Design tab.
4. To load a previously saved schedule and edit it, find it from the drop-down

list on the bottom, and then click the    button.
5. Select the Day the event will occur and Culture Event to add.

Note:

The day that the culture is created is considered day 0.
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6. Click the -> button to add the event to the schedule
7. After all events have been added, enter a name for your schedule into the

Assay Name text field.
8. Click the    button. Do not use the    from the LDMS toolbar.

Creating a Culture
Unlike other assays in LDMS, you can only create a culture from a single
aliquot; you cannot select multiple aliquots and create cultures for them
at once. If you need to create multiple cultures, you must create each one
individually.

! Warning:

If you select multiple specimens on the Assay Selection tab, a culture
will only be created for the first specimen selected.

Figure 56: Creating a culture

1. Create a new assay run, selecting the desired culture assay.
2. Enter the Culture Setup Date. This is the date that the culture was

created (i.e. day 0).
3. Select the feeding and harvest Schedule.

Tip:

To view the events on a schedule, select it, and then click the   
button from the LDMS toolbar. To see a list of all available schedules
and associated events, you can run the Culture Schedule Report,
found in Tasks > Reports, and then Culture > Culture Schedule
Report.

4. Select the p24 assay that will be run on the cultures. The p24 assay must
be run on cultures in LDMS.

5. Enter donor information into the Donor # field if you have an established
method for tracking donors for cultures. LDMS does not enforce any
particular usage of this field.

6. Enter the Total Volume and Total Volume Units for the prepared
culture.

Frontier Science Foundation 163



LS.0005 | LDMS for Windows - User Manual

7. (For quantitative cultures only), specify the way harvests from the culture
should be loaded onto p24 assay plates. To add them to the plate top-
bottom/left-right, select A1, B1, C1...; to add them to the plate left-right/
top-bottom, select A1, A2, B1....

8. Click the    button.

Note:

If you need to return to the culture setup later (for example, to update
donor information), select the assay on the Assay Selection tab, and
then select the Runs Not Performed/Not Terminated option.

! Attention:

The    button on the culture setup screen allows you to add
unscheduled feeding and harvest events. This is not recommended, as
these events do not get tracked in LDMS and will not appear on reports.
Unscheduled harvest events will not create additional samples to be
run on p24 assays. If you need to create a custom schedule, it is more
appropriate to delete the culture, create a custom schedule, and create
a new culture.

Creating a culture creates special specimen from the original aliquot. These
special specimens cannot be found in LDMS Specimen Management   ; they
can only be found by looking for specimens assigned to the appropriate p24
assay. They are identified using the same global specimen ID, but will have
different harvest dates—specimen will be created for each harvest event in
the schedule that was used for the culture.

These sub-aliquots are created automatically, but not immediately. For
example, if you create a culture with harvests at days 3 and 10, you will not
find them when trying to set up a p24 assay until you are 10 days past the
culture setup date.

Culture Schedule and Harvest Labels
It may be useful to obtain a list of when cultures need to be fed and
harvested. LDMS has a special report that does just that. This is also the
same mechanism you would use to create printable labels for your culture
harvests.

1. From the Assay Selection tab, click the    button from the LDMS toolbar.
2. Select Harvest Feed.
3. Do one of the following:

• Select the Pending option; this will find all cultures that have not been
terminated.

• Select the Group for which you want to find all cultures.
4. Specify the date range; LDMS will find all culture events that occur within

this date range.
5. Generate the event report or labels by selecting the Generate Report or

Generate Labels button respectively.

Unlike labels for normal specimens, the labels for culture harvests cannot be
customized. If you are planning to permanently store a culture, you'll need
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to create a culture derivative, which will open up the same label and storage
options available to normal specimens.

Running Culture Harvests on a p24 Antigen Assay
When you setup a culture, you were required to select the p24 Antigen assay
to be run. After you have one or more harvests from the culture, you can
begin running that p24 assay. You don't have to have all of the harvests for
the culture when you run the assay (and you can put harvests from different
cultures onto the same assay plate when you run it).

1. Select the appropriate assay from the Assays list on the Assay Selection
tab.

2. Select the New Run/Not Setup option, and then click the    button.
3. Find the culture harvest that you want to test by clicking the    button

from the LDMS toolbar or by using search criteria.
4. All of the culture harvests that are from cultures assigned to the selected

assay will appear in the Specimens Found list.

Note:

You can differentiate harvests by looking at the Culture Day field.
If you do not see all of the harvests that you were expecting,
review the Harvest/Feed Report. Harvests are only created after the
required number of days have passed, per the schedule used.

5. Select the harvest that you will be testing, and then click the   
button.

6. Configure the assay plate(s), wells, and controls like you would configure
virology assays.

7. Click the    button to read the assay output.

Reviewing Results and Terminating Cultures
After running the appropriate p24 antigen assay on your culture harvests, you
must review and accept the results. These results are in two places:

• By selecting the p24 assay and the Review/Edit option
• By selecting the culture assay and the Terminate/Unterminate option.

In LDMS, terminating a culture is the process of reviewing the p24 assay
results and approving them. This typically corresponds to the actual
termination of the culture.

1. Select the appropriate culture from the Assay list on the Assay Selection
tab.

2. Select the Terminate/Unterminate option, and then click the   
button.

3. Select either the All Open Cultures, All Closed Cultures, or All
Cultures option, depending on which cultures you want to review, and
then click the    button from the LDMS toolbar.

Note:
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Closed and open cultures are the same as terminated and not-
terminated cultures respectively.

4. Select the culture(s) you want to review. You can select multiple cultures
and view more than one at the same time. Once they have all been
selected, click the    button.

! Warning:

While you can use the    and    buttons to terminate/
unterminate multiple cultures at once, this is not recommended.
When you terminate a culture, you are saying that you have
reviewed and approved the results; by doing this en masse, you
don't actually review the results.

5. Review the culture results. LDMS has already determined whether or not
the culture is positive or negative based on the status of each harvest
tested on the p24 assay. If you want to override these results, change the
Culture Result option and enter a comment. If multiple cultures were
selected, you can switch between them by using the database navigation
buttons    from the LDMS toolar.

6. Enter the initials of the person terminating the culture into the
Terminated by and your initials into the Reviewed by fields, and then
complete the Reviewed Date.

7. If you want to create an MT-2 supernatant from one of your harvests and
use it to run the MT-2 assay, select the Generate MT-2 supernatant on
termination option. If you do select this option, you will be prompted for
the harvest date of the harvest that you want to use when terminating the
culture.

8. Select the Terminate option to accept the specimen results, the
UnTerminate option to re-open a culture, or the Save option if you do
not want to open or close the culture but want to save other changes.

9. Click the    button from the LDMS toolbar.

How does LDMS determine if a culture result is positive or negative?

When you review a culture's results during the termination process, LDMS
will automatically set the culture result to be pos[itive], neg[ative], or
ind[eterminate] based on the status from the p24 antigen assay result. You
can override this automatic determination, but you may want to know how
LDMS actually figures it out.

p24 Results

14 Day 21 Day

Final Culture Result

Positive Not Run Positive

Negative Positive Positive

Positive Positive Positive

Positive Negative Indeterminate

Negative Not Run Negative

Negative Negative Negative
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The logic for determining if a result is positive or negative is as follows:

• If all p24 results are <30 pg/mL until at least day 28, the result is
considered negative.

• If two consecutive p24 OD values are out of range (greater than or equal
to 2.0 or 3.0, depending on the assay and reader), the result is considered
positive.

• If there are two consecutive p24 values of > 30 pg/mL, and the second
value is at least four times greater than the first value or is out of range,
the result is considered positive.

• If there are three consecutive p24 values of > 30 pg/mL, where the third
value is at least four times greater than the first value.

Entering MT-2 Culture Assay Results Using a Culture
Supernatant
If you selected the option to generate a MT-2 supernatant, one will be
created. The MT2 supernatant is a special specimen derived from the culture
that has the same global specimen ID as the original aliquot (and culture) and
is only viewable within LDMS Assays    when setting up the MT-2 assay.

In LDMS, the MT-2 culture assay in LDMS is a data entry assay used after
your work is completed.

Figure 57: MT-2 Culture Assay screen

1. Select the MT-2 Assay, found in the Assays list in the Misc category, and
click the    button.

2. Find the supernatant that you want to test by clicking the    from the
LDMS toolbar or by using search criteria, then click the    button.

Note:

The supernatant will have the same global specimen ID as the
culture from which it was created.

3. Enter the date that the MT-2 culture was created into the Setup Date
field.

4. Select the results of your testing.

Frontier Science Foundation 167



LS.0005 | LDMS for Windows - User Manual

• If the culture was positive for syncytium-inducing (SI), select SI.
• If the culture was negative and non-syncytium-inducing (NSI), select

NSI.
5. Enter the date that the MT-2 culture was terminated into the Termination

Date field.
6. Enter the passage number of MT-2 cells into the MT2 cell line passage

box; this must be a number between 1 and 100.
7. Enter the results for your controls into the Positive Control and

Negative Control fields.
8. Enter the initials for the person who performed the culture work into the

Assay Setup Initials box.
9. Click the    button from the LDMS toolbar.

If you are testing multiple MT2 cultures, use the database navigation buttons 
  on the LDMS toolbar to find them, then repeat the data entry

process.

Creating a Specimen from a Culture Harvest
You typically can't find cultures and culture harvests in LDMS Specimen
Management   , in Shipping   , or in Storage   . This is due to the way
harvests are derived from an aliquot, and most parts of LDMS were designed
with aliquots as the smallest unit of information.

It is possible to create a special specimen from a culture harvest, allowing
you to utilize LDMS's storage, shipping, etc. features, just like any other
specimen. These special specimens are called culture derivatives.

p24 Antigen Assays
There are two types of p24 antigen assays in LDMS: direct and culture. The
culture version is used with culture harvests created in LDMS Assays. When
you attempt to run the culture version, you will only find culture harvests that
have already been created. Harvests are automatically created based on the
culture's schedule and setup date (e.g. for the day 28 harvest to appear in
LDMS, the current date must be 28 days after the culture's setup date).

The direct version, on the other hand, is used to test specimens that are not
culture harvests. This means that the aliquots must be assigned to the assay
in LDMS Specimen Management    or using the Assign Tests tool.

Other than the source, this assay is read the same way, regardless of
specimen or instrument.

Frontier Science Foundation 168



LS.0005 | LDMS for Windows - User Manual

Immunology assays

Lymphocyte Proliferation Assay (LPA) Assay
The first specimen that was selected on the Assay Selection tab will appear
in the Specimen Info box at the top of the Results tab screen. You can use
the database navigation buttons    to switch between specimens
that were selected on the Assay Selection tab.

Figure 58: Lymphocyte Proliferation Assay (LPA) screen

The LPA assay data entry screen.

1. Complete all of the fields in the Results Questions. All questions are
required.

2. Complete all of the fields in every row in the Results Grid at the bottom
of the screen.

2.1. To add more rows, type a number into the # of rows to add text
box and click the    button.

2.2. To remove a row, select it and then click the    button.
2.3. Enter replicate information into CPM Rep. A/B/C/D columns or,

if a stimulant was not run, select the N/A check box to the left of
that replicate, and then select the appropriate censor code from the
Censor drop-down.

3. Enter your initials into the Data entered by field.
4. Enter the initials of the assay technician into the Assay Tech field.
5. Click the    button from the LDMS toolbar to add the results to LDMS.

To view the LPA Patient Report after entering data for the specimens tested,
click the    button from the LDMS toolbar.

After you've finished with the first specimen, click the    button from
the LDMS tool bar and enter the results for the next specimen. Once all
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specimens have been entered and added, the data entry is complete. You can
now return to the Assay Selection tab to perform more work.

Apoptosis by P.I. Assay
The first specimen that was selected on the Assay Selection tab will appear
in the Specimen Info box at the top of the Results tab screen. You can use
the database navigation buttons    to switch between specimens
that were selected on the Assay Selection tab.

Figure 59: Apoptosis assay screen

Apoptosis assay data entry screen.

Entering Apoptosis results into LDMS

1. Select whether or not results for the specimen were obtained from the
Were results obtained on this specimen radio button.

2. Select the date that the Apoptosis assay was setup in the Enter the
assay setup date box.

3. Enter the time that it took to complete the assay (in hours) in the Enter
the assay duration box.

4. Enter the apoptosis percentage for Replicant A and Replicant B.

• The Mean of replicates will be calculated automatically
• If there are no results for that replicant, select the check box next to it,

then select the appropriate censor from the Censor drop-down.
5. Enter the initials of the assay technician into the Assay Tech field
6. Enter your initials into the Data entered by field.
7. Click the    button from the LDMS toolbar.

To view the LPA Patient Report after entering data for the specimens tested,
click the    button from the LDMS toolbar.

After you've finished with the first specimen, click the    button from
the LDMS tool bar and enter the results for the next specimen. Once all
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specimens have been entered and added, the data entry is complete. You can
now return to the Assay Selection tab to perform more work.

Advanced Flow and TUNEL Assays
The first specimen that was selected on the Assay Selection tab will
appear in the Specimen Info box at the top of the Results tab screen. The
Advanced Flow and TUNEL assays have identical data entry screens. You can
use the database navigation buttons    to switch between specimens
that were selected on the Assay Selection tab.

Figure 60: Advanced Flow and TUNEL assay screens

1. Select whether or not results for the specimen were obtained from the
Were results obtained on this specimen radio button.

2. Indicate whether or not the sample was fresh or frozen in the Indicate
whether the assay was performed on a fresh or frozen specimen
box.

3. Select the gating method from the Indicate the Gating method used
for anchor Immunophenotyping drop-down.

• Method 1 gates all lymphocytes using FL/SS followed by a second gate
on fluorescence histogram to select for the anchor marker.

• Method 2 gates the anchor marker fluorescence versus SS histogram.
4. Complete all of the rows and columns Anchor Gated Analysis section.

• For Anchor Gate <500 cells, LDMS will auto-fill subsequent rows based
on your selections for the first row of data. You can manually change
individual marker sets in other rows if needed.

• Rows can be added or deleted by using the Add Row and Delete Row
buttons to the right.

• If a marker was not run, select the N/A check box at the end of the row
and select the appropriate Censor from the drop-down.
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• The Total Percent field will automatically be calculated. The sum of the
four quandrants should equal 100%; if it does not, the Total Percent
will turn red.

5. Enter the subset marker and colors, and quadrant results into the Total
Lymphocyte Gated Analysis fieldset.

6. Enter the assay technician’s initials into the Assay Tech field.
7. Enter your initials into the Data Entered By field.
8. Click the    button from the LDMS toolbar.

To view the Advanced Flow Patient Report after entering data for the
specimens tested, click the    button from the LDMS toolbar.

After you've finished with the first specimen, click the    button from
the LDMS tool bar and enter the results for the next specimen. Once all
specimens have been entered and added, the data entry is complete. You can
now return to the Assay Selection tab to perform more work.

Natural Killer Cell (NK) Assay
The first specimen that was selected on the Assay Selection tab will appear
in the Specimen Info box at the top of the screen. All fields on the screen
are required. You can use the database navigation buttons    to
switch between specimens that were selected on the Assay Selection tab.

Figure 61: Natural Killer Cell (NK) Assay screen

Natural Killer Cell (NK) assay data entry screen.

1. Indicate whether or not Were the results obtained on this specimen.
If no, select an option from the Specify Reason list.

2. Indicate Was the % viability performed on this sample. If yes, enter
a value into the Indicate the % viability of the sample field.

3. Select a value in the Indicate whether the assay was performed on a
fresh or frozen specimen.

4. Enter the date that the assay was run into the Enter the assay setup
date field.

5. Select the Target Code and Target Name from the drop-down lists.
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6. Select the Effector Code and Effector Name from the drop-down lists.
7. Select the Starting E.T. Ratio. Your selection will change the table below.
8. For each row, enter the E.T. Ratios, Spontaneous, and Maximum values.

If any were not performed, select the N/A check box to the left of the
field, then select the appropriate reason from the Censor drop-down list
in the right column.

9. Indicate whether or not Were NK cells enumerated by flow
cytometry. If yes, enter the % positive NK marker into the field to the
right.

10.Enter comments (optional), the initials of the Assay Tech who performed
the run, and the intials of the person who entered the data into LDMS at
the bottom.

11.Click the    button from the LDMS toolbar.

To view the NK Patient Report after entering data for the specimens tested,
click the    button from the LDMS toolbar.

After you've finished with the first specimen, click the    button from
the LDMS tool bar and enter the results for the next specimen. Once all
specimens have been entered and added, the data entry is complete. You can
now return to the Assay Selection tab to perform more work.

Cryopreservation
The first specimen that was selected on the Assay Selection tab will appear
in the Specimen Info box at the top of the Results tab screen. You can use
the database navigation buttons    to switch between specimens
that were selected on the Assay Selection tab.

Figure 62: The Cryopreservation assay screen

Cryopreservation assay data entry screen.

1. Indicate whether or not Were Results obtained on this specimen. If
No, select the appropriate option from the Specify reason list.
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2. Complete the remaining fields.

• Enter the initials for the person who ran the assay into the Assay Tech
field and the initials of the person entering the results into LDMS into
the Data Entered by field.

• To enable manual entry into the Total viable cell count per visit field,
change the Method for obtaining cell count to manual.

3. Click the    button from the LDMS toolbar.

To view the IQA Cryopreservation Patient Report after entering data for the
specimens tested, click the    button from the LDMS toolbar.

After you've finished with the first specimen, click the    button from
the LDMS tool bar and enter the results for the next specimen. Once all
specimens have been entered and added, the data entry is complete. You can
now return to the Assay Selection tab to perform more work.

Pharmacology assays

Creating PK assay templates
Pharmacology results are stored in LDMS by using the template-based PK
assay feature.

Background

A template defines the drugs to be tested and lower and upper limits. You
must create a new template for every unique drug combination that you will
be testing. You can create a new template from scratch or using an existing
template.

Steps

1. From the LDMS menu bar, click Tasks > Assays.
2. In the Assays box in the upper-left corner, expand PK Assays and do

one of the following:

• To create a new template without using an existing template, select
PK Assay.

• To create a new template based on an existing template, select that
template.
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3. In the Assay Selection Criteria section, select Design.
4. In the upper-right corner, click Select Assay.

If you selected an existing template, you will be asked if you want to
create a new template or modify the existing template. To create a
new template, click Create.
You will be taken to the Design tab.

5. In the Assay Name box, enter the name of the template as you want
it to appear on the Assay Selection tab.

6. In the Number of Drugs box, enter the number of drugs to be tested
using the template.

Note:  You must press the Tab key after entering the number of
drugs to refresh the screen.

The list of drugs will show one row per drug.
7. For each drug, select the Drug, Units, Lower Limit, and Upper

Limit.

Tip:  If you are unsure what a drug abbreviation means, select
it and press Ctrl + H.

8. Click Database > Add.

Entering PK assay results
LDMS cannot read results from PK assays or result files. To store PK results in
LDMS, you must copy the results from a spreadsheet generated by your assay
(preferred) or enter the results manually.

Prerequisites

• Create the necessary PK assay templates (one template per combination of
analytes to be tested).

• Create a new assay run using the appropriate PK assay template.
• If calibration standards or quality controls are needed, these must already

have been created.

Steps

1. On the Preview tab, select the Detection Platform and Run Type.
2. (If needed) Add calibration standards or quality controls by clicking

Add Calibration Standards or Add Quality Controls.
You will be prompted to select the lot and quantity to be added.

3. Move lots and specimens to the correct position using the Move Up
and Move Down buttons.

4. Click Run Now.

Frontier Science Foundation 175



LS.0005 | LDMS for Windows - User Manual

Tip:  If you want to save this run and enter results later, click
Run Later instead.

You will be taken to the Results tab.
5. At the top of the Results tab, select the Assay Date and enter the

Tech Initials.
6. For each specimen and lot, enter its results.

• To enter results by hand for each specimen by selecting each
specimen and entering the results below it, use Traditional View
(this is the default method).

• To copy and paste results from a spreadsheet, use SpreadSheet
View.

• If a result was not obtained, right-click it and select No Result
Obtained.

7. After all results have been entered, click Calculate.
8. After any censor and changes have been applied, save the results by

clicking Database > Save.

Result
LDMS will accept the results entered and apply any system censors, if
applicable.

After you are finished

• (If needed) Assign user censors.
• Generate the PK Assay Result Report by clicking the Generate Report

button in the LDMS toolbar.
• Click Result Options to view a key of censors, display acceptability

details for controls, or modify results (returns the run back to its “run not
performed” state).

• Review and accept the assay results.

Using spreadsheet view
When storing PK assay results in LDMS, you can copy and paste results
directly from a spreadsheet.

Prerequisites

• Set up the PK assay run and open the Preview tab.
• Open the results in your spreadsheet program.
• Change N/A and empty values in your spreadsheet to -1.
• Adjust your spreadsheet so that the columns and order of rows match

LDMS.

Background

There are two ways to enter PK results in LDMS: by selecting individual
specimens and manually entering the results, or by copying and pasting them
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from a spreadsheet. Using the later method can save time and help avoid
data entry errors. In order to copy and paste results from a spreadsheet, the
spreadsheet must have columns and rows that match the order in which they
appear in LDMS. There are two formats this can take:

• one row for each specimen tested, with individual analytes results in
separate columns (multiple result columns)

• one row for each specimen and analyte combination tested (one result
column)

Figure 63: Using spreadsheet view

(1) Select and copy cells in spreadsheet, (2) Select first result in LDMS, (3) Pasted results

Steps

1. In LDMS, with the assay run open on the Preview tab, click
SpreadSheet View.

2. Optional: To switch between one result per specimen or one result per
specimen-analyte combination, click Pivot

3. In your spreadsheet program, select the cells to copy.
4. Copy the selected cells (typically Ctrl + C or [right click] > Copy
5. In LDMS, click the cell with the first result to be copied.
6. Click the Paste button.

Applying user censors to PK runs
User censor censors may be manually applied to individual specimens,
analytes, or entire PK assay runs.

Prerequisites

Set up the PK assay run, enter results, and calculate system censors.

Steps

1. (If SpreadSheet View is open) With the assay run open in the Results
tab, click Traditional View.

2. Right click the result to be censored and select Assign User Censor.
3. In the PK User Censor Codes list, select the needed censor.
4. Click OK.
5. Select the scope to apply the censor.
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6. Optional: If the specimen should be available to be added to future
runs, select Make censored specimen(s) available to place on a
new run.

7. Click OK.

Result

The user censor will be applied as you specified. If you want to quickly see all
censors applied to the run, switch back to SpreadSheet View. System censors
will appear in parenthesis. For example, if a specimen has the censors “(B)P”
applied, B is a system censor and P is a user censor.

Reviewing and accepting PK assay results
For projects that use Frontier Science for data management, you must review
and accept assay results before they can be exported.

Background

Reviewing and accepting the results means that you are attesting that the
data is accurate and should be considered final. For some projects, this also
means that the data will become available to Frontier Science and possibly
other external entities such as group leadership.

Steps

1. From the LDMS menu bar, click Tasks > Assays.
2. In the Assays box in the upper-left corner, select the assay or

template with the results to be reviewed.
3. In the Assay Selection Criteria section, select Review/Edit.
4. In the upper-right corner, click Search.
5. In the Previous Runs Found list, select the run to be reviewed.
6. Click Select Assay.

You will be taken to the Results tab.
7. Review the assay results.

Apply censors or make changes to the results as needed.
8. Complete the Reviewed Date, Reviewed By, and (optionally)

Comment boxes.
9. Click Database > Save.

After you are finished

To ensure that the results can be accessed by Frontier Science, perform an
export.

GeneXpert Assay
LDMS currently only supports the Xpert MTB/RIF assay. This assay is used to
identify mycobacterium tuberculosis (MTB) resistance to rifampicin (RIF).
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Reading a GeneXpert assay result file:

1. Create a new GeneXpert MTB-RIF assay run and add assigned specimens
to it. For instructions, see .

The Preview tab will open.

GeneXpert preview screen

2. Add or modify the Other Spec[imen] ID for specimens in the right pane.
This can be used to help LDMS automatically match specimens in the
result file(s) to specimens in LDMS.

3. Click the    button.

LDMS will prompt you if you want to run the assay. Select Yes. A window
will open to select the result file.

4. Select the GeneXpert result file, and then click the Open button.

After selecting the result file, LDMS will prompt you if you want to load
another file. You can use multiple result files for the same assay run.

Once all result files have been selected, LDMS will attempt to match
results to specimens. Results that it was unable to match will be displayed
in the left pane.

5. Drag and drop unmatched results from the left pane to the specimens in
the right pane.

6. Review the specimens that were automatically matched by LDMS and
ensure that they were matched correctly.

If you find any errors, you can drag and drop the result to a different
specimen to correct it.

7. Enter the initials of the assay technician into the Tech Initials box and
your initials into the Data Transfer Tech Initials box.

8. After all results have been matched to a specimen, click the   
button.

The results screen will open.
9. Review the assay results.
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GeneXpert results screen

By selecting a result on the left, details will be displayed on the right.
Some of the items can be expanded to show more information.

10.To apply a user censor code to a result, right click on the specimen in the
left pane and select Censor Specimen.

11.Click the    button from the LDMS toolbar.

There are two reports that can be generated from the results screen for the
GeneXpert MTB-RIF assay:

GeneXpert MTB-
RIF Report

This report is generated by clicking the    from the
LDMS toolbar. This report provides an overview of the
assay run and the specimens that were tested.

Patient Report This report is generated by clicking the Patient Report
button at the bottom of the results screen. This report
provides detailed information about one or more
specimens on the assay run. You can select which
specimens will appear on the report.

The Test Result Entry tool
The test result entry tool allows you to enter test results for multiple
participants on a single screen. The results of several assays can be entered
at the same time.

The Test Result Entry tool was designed for the PHIA group. This tool is locked
by default and must be unlocked by LDMS User Support for your laboratory.
In addition, you must also assign the appropriate permissions to users who
will need access to this tool.
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Creating a new template
A template determines what assays are required and what group will be used
within the Test Result Entry tool.

Background

In order to use the Test Result Entry tool, you must have a saved template.
If you have not created a template, you will automatically be taken to the
Template tab to create one.

Figure 64: Creating a new Test Result Entry template

Steps

1. On the Tools menu, click Test Result Entry.
2. Click the Template tab.
3. In the Template Name box, enter a name for the template.
4. In the Group box, select a group.
5. In the Geenius Default Settings box, select the desired Geenius

assay settings.

• For POS and IND: The Geenius result will default to N/A if HIVRT
is NEG or VID is EID. Otherwise it will default to blank if VID is any
other value and HIVRT is POS or IND.

• 3 Test Required: Adds a new entry field for Number of Tests;
The Geenius result field will only be enabled when three tests are
selected and VID is not EID.

6. In the QA Testing Scheme box, select the criteria for triggering QA.

• ALL: QA and tests will be blank (rather than N/A) by default for all
results
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• First 15 Only: QA will default to Y for the first 15 results for a
household tester.

• First 15 + All IND. The Schema will flip QA from N to Y for the first
15 instances of a household tester ID, and for any row with ID3
HIVRT = IND

• First 25 + ALL IND: QA will = Y for all non-Geenius tests for the
first 25 rows for a given household tester ID and for any row with
HIVRT = IND

• First 50 + 20 NEG + All IND + All DEC: QA will default to Y for the
first 50 results for a household tester, as well as every 20th NEG
result and all IND results and all DEC results

• First 50 + 20th NEG + ALL IND and POS: QA will default to Y
for the first 50 results for a household tester, as well as every
twentieth NEG result and all IND results and all POS results.

• First 50 + 20th NEG + ALL IND: QA will default to Y for the first 50
results for a household tester, as well as every twentieth NEG result
and all IND results

• First 50 + 20th NEG + POS + ALL IND: QA will default to Y for the
first 50 results for a household tester, as well as every twentieth
result that is NEG or POS, and all IND results

7. Optional: Select the Deactivate the 'First 50' aspect of the QA
scheme option.

If selected, this option will override the QA Testing Schema setting. All
other QA settings will still apply.

8. Optional: to mark a template as inactive, deselect the Active option.

If this option is deselected, the template will not appear in the TREM
results tab template drop down.

9. For each assay for which results will be entered:
9.1. In the Test Suite section, click Add.
9.2. In the Test column, select the assay.
9.3. In the Open for EID column, select Y or N.

This determines whether visits with the EID code (Early Infant
Diagnosis) will have test change from N/A to blank when QA is Y.

Note:

Certain tests include additional special functionality if added to a
template:

Geenius Geenius Tester column will also be added to
the template. The user will have the ability
to manage Geenius results using Geenius
Default settings, Geenius specific filters, and
the Geenius worksheet.

HBV HBV tester column will also be added to
the template. The user will have the ability
to manage HBV results using HBV specific
filters and the HBV worksheet. HBV default
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settings follow special logic associated with
HIVRT=DEC.

Syphilis Syphilis tester column will also be added to
the template. The user will have the ability to
manage Syphilis results using Syphilis specific
filters and the Decliners worksheet. Syphilis
default settings follow special logic associated
with HIVRT=DEC.

CD4 CD4 Done and CD4 Tester columns will also be
added to the template. CD4 Done has special
default logic to set Y where HIVRT=POS or
IND. The user will have the ability to manage
CD4 results using CD4 specific filters and the
CD4 worksheet

Note:  For PHIA, laboratories are expected to enter all results
onto the same template. Geenius should not be put onto a
separate template. When creating templates the Geenius assay
should be added as row 1 and the Open for EID set to Y test as
row 2.

10. Once all tests are added to a template, click the Add button on the
LDMS toolbar.

Modifying an existing template

Steps

1. On the Tools menu, click Test Result Entry.
2. Click the Template tab.
3. From the Saved Template box, select the template to be modified.
4. Modify the template as needed.

• While new tests can be added, tests can only be removed if no
results have been entered for that test.

• The Geenius Default Setting and QA Testing Scheme options
cannot be modified.

5. On the LDMS toolbar, click the Save button.

Entering results
Enter test results by selecting a template, loading expected specimens, and
entering results.

Prerequisites
Before entering test results, you must already have created a template.
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Background
Figure 65: Test Result Entry screen

Steps

1. On the Tools menu, click Test Result Entry.
2. Click the Result tab.
3. In the Select a template box, select a template for data entry.
4. Optional: In the Optional Filter Criteria box, apply any needed

filters on the results to be displayed for entry.
5. Click Load Results.
6. For each row, enter the following information:

• Household tester
• QA tester
• Geenius Tester
• Assay results (one column per assay)
• Final result

Note:

Household tester, QA tester, and Geenius tester must be in the
format 2_lettersS3_numbers (such as AAS123)

! Warning:

Be careful when entering the Household Tester. Total and
negative results are counted per household tester

7. After entering all results, click the Save button in the LDMS toolbar.

Filters
You can filter what records are shown in the Test Result Entry tool.

By default, when you click Load Result, all specimens for the group
associated with the current template will be displayed. Each row will represent
one unique ID1-ID2-ID3-clinic combination.
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To reduce the number of rows displayed, enter filter criteria into the Optional
Filter Criteria section, and then click Load Results.

Instead of using filters, you can also scan a specimen barcode, or upload a file
with Global Specimen IDs or ID1 values. This will find specimens that match
the participant ID and received date for that specimen.

PHIA country-specific template settings
There is special logic built into the Test Result Entry tool for PHIA specimens.

Botswana

• Geenius Default Setting: All POS+IND+KCP
• QA Testing Scheme: First 25 only minus NRT and KCP

Eswatini, Lesotho, Malawi, Mozambique, Uganda, Zambia, Zimbabwe

• Geenius Default Setting: For POS and IND
• QA Testing Scheme: First 25 + ALL IND

Note:  When adding assays to the Test Suite, CD4 (PIMA) and Geenius
should be listed before the household testing algorithm.

Related reference
PHIA on page 226
The PHIA preset group has these requirements

Test Result Entry reports
Several reports can be generated by clicking the Generate Report button
from the LDMS toolbar.

Reports are generated using the currently displayed results. For the QA
Worksheet and Geenius Worksheet, some records may be filtered out of the
report. All displayed records will appear in the tab-delimited text file.

Decliners
Worksheet

Shows records where final result is blank, the HIVRT
is DEC and Syphilis Test result, HBV result, or Geenius
result is blank

QA Worksheet Shows records where final result is blank and QA is Y

QA Worksheet
with Storage
Locations

Same as QA worksheet, with storage location and
specimen barcode added

HBV Worksheet Shows records where the HBV result is blank

CD4 Worksheet Shows records where the CD4 result is blank

Geenius
Worksheet

Show records where the final result is blank, the HIVRT is
POS or IND, and the Geenius result field is applicable
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Tab-delimited
Text File

Generate a plain text file with each field separated by
tabs; this report can be opened in most spreadsheet
programs, such as Microsoft Excel

HCV Worksheet Same as QA worksheet, with storage location and
specimen barcode added

Managing controls

Setting up Assay Kit Information
When reading certain assays in LDMS, you will be required to select kit lot
information. For some of these assays, you will need to manually enter the kit
information into LDMS using the Kit Entry tool; for newer assays, LDMS will
automatically load kit information from your result file (though you will still
need to use the Kit Entry tool to enter a few pieces of information that are not
in assay result files).

The following table shows which assays require kit information when they
are being read. It then breaks those assays down between those where kit
information must have been entered manually prior to reading the assay and
those where kit information can be read automatically from the output file.

Table 22: Assays Requiring Kit Information

Assay Manual Automatic

Abbott Realtime HIV-1 -- X

COBAS TaqMan HCV -- X

COBAS TaqMan HIV-1 -- X

Nuclisens HIV RNA QT X

Roche Amplicor Monitor HIV RT PCR X --

Roche COBAS Amplicor X --

Roche COBAS UltraSensitive X --

Roche UltraSensitive HIV RT PCR X --

Important:

For assays where kit information is pulled from the result file
automatically, you still must use the Kit Entry tool to enter the
Date Rec[eived] and Storage Temp[erature] for the kit, as this
information is not in the result file.
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Figure 66: Kit Lot Entry Screen

The kit entry screen for the Abbott Realtime HIV-1 assay.

Important:

The fields available for kits and types of kits will vary, depending on the
assay selected. The process of using the kit entry tool is the same for
every assay; it is the fields that are unique.

Manually creating a new kit lot:

1. Access the Kit Entry tool by clicking QA/QC > Kit Entry from the LDMS
menu bar.

2. Select the assay for the kit you are creating from the Assay drop-down
list.

3. (If applicable) Select the type of kit from the drop-down list next to the
assay. This field will not be displayed for assays that do not need it.

4. Complete all of the fields at the bottom of the screen using the information
from your kit. The precise fields that are available will vary from assay to
assay.

5. Click the    button from the LDMS toolbar.

Kits can be updated after creating them. If you have read an assay that
automatically collects kit information from the assay output file, modifying
the existing kit is how you would complete the fields that are not read from
the output. This update would only need to be done the first time the kit was
used.

Modifying an existing kit:

1. Access the Kit Entry tool by clicking QA/QC > Kit Entry from the LDMS
menu bar.

2. Select the assay for the kit you are modiying from the Assay drop-down
list.

3. (If applicable) Select the type of kit from the drop-down list next to the
assay. This field will not be displayed for assays that do not need it.
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4. Select the kit that you want to modify from the list of existing kits. The
fields at the bottom of the screen will be populated with the values for the
selected kit.

5. Make the necessary changes to the kit fields.
6. Click the    button from the LDMS toolbar.

One of the options available when modifying kits is to deactivate them. This
prevents them from being selected when reading an assay without actually
removing the kit from LDMS. If a kit has not yet been used, it can also be
deleted by selecting the kit, and then clicking the    button from the LDMS
toolbar. Once an assay has been run with a kit, however, that kit cannot be
deleted.

Setting up VQA Kits
The following table show the VQA controls in LDMS and the applicable assays
for those controls.

VQA RNA Control Applicable Assay

Abbott VQA Controls Abbott Realtime HIV-1

COBAS TaqMan VQA Controls COBAS TaqMan HIV-1

COBAS UltraSensitive VQA Controls Roche COBAS UltraSensitive HIV-1

Standard VQA Nuclisens Controls Nuclisens

Standard VQA RNA Controls Roche Amplicor Monitor HIV RT PCR

UltraSensitive VQA RNA Controls Roche UltraSensitive HIV RT PCR Assay

Figure 67: VQA Control Login Screen

Creating a new VQA control. This image shows the creation of a VQA200 control.

Creating a new VQA Kit:

1. Access the VQA Control Entry tool by clicking QA/QC > VQA Control
Login from the LDMS menu bar.

2. Select the desired control from the VQA RNA Control list.
3. Enter the VQA lot number into the Lot Number field.
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4. Enter the expected value for the control into the Expected value field at
the bottom of the screen, and then click the    button.

5. Complete the minimum value and maximum value fields.
6. Click the    button from the LDMS toolbar.

VQA controls can be modified by selected the desired VQA RNA Control and
Lot Number, making any changes, and then clicking the    button from the
LDMS toolbar.

Pharmacology Control Charting
PK control charting is a feature in LDMS that allows you to evaluate your
laboratory's control performance over a specified time, and generate a variety
of reports. To access PK control charting reports in LDMS, select QA/QC > PK
Control Charting from the LDMS menu bar.

1. From the PK Analytes, Lot Type, and Lot #, select the applicable
analyte, lot type, and lot number.

2. To limit to runs within a specific date, use the Run Date From and To
boxes.

3. Click Search.
4. Under Rounds found, select the runs that you want to appear on

the report, and then click the    below the list to move it to Runs
selected.

5. In the Reports list, select the report that you want to generate.
6. Click Generate.

Virology Control Charting
Control charting is a feature in LDMS that allows you to evaluate your
laboratory's control performance over a specified time for virology assays.
This tool generates Levey-Jennings charts. To access control charting in
LDMS, select QA/QC > Control Charting from the LDMS menu bar.

Creating a Levey-Jennings chart in LDMS

1. Select the virology assay with the control you want to chart from the
Assay drop-down list.

2. Select the date range within which you want to view controls in the Date
From and Date To fields.

3. Select the control that you want to chart from the Control Name list.
4. Select the desired kit and control lots from the Kit Lot Number and

Control Lot fields.

Note:

If the Kit Lot Number and Control Lot fields are disabled, no
controls were found within the date range specified. Try broadening
your date scope.

5. Click the    button from the LDMS toolbar.
6. Select desired control from the Search Results listing, and then click the 

  button below the list. This will move the control to the Selected
Controls list.
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7. Select one or more controls from the Selected Controls list. Hold down
the Ctrl or Shift key to select multiple control.

8. Click the    button.

Up to seven distinct control lots can be displayed on the Levey-Jennings chart
generated by LDMS. If multiple controls were selected, the chart will display
both controls on the same chart. Use the key to the right to distinguish each
control.

Figure 68: Control Charting Report

A Levey-Jennings Report generated by the control charting tool in LDMS, showing data for two controls.

Pharmacology QC and Calibration Lot Entry
PK control and calibration lots can be entered into LDMS. This allows you to
use lots when entering PK assay results in LDMS.

Steps

1. On the QA/QC menu, select PK QA Lot Entry or PK Calibrator Lot
Entry.

2. Enter the following information for your lot.

• Lot #
• Creation date
• Expiration date
• Storage temperature (in Celsius)
• Derivative or matrix type
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3. For each control or calibration standard you want to add, do the
following.
3.1. Next to the Controls or Calibration Standards box, click Add.
3.2. Select the control or calibration standard from the Control or

Calibrator column.
3.3. Optional: Enter a Custom Name.

4. For each analyte for this lot, do the following.
4.1. Next to the Analytes box, click Add.
4.2. Select an analyte from the Analyte column.
4.3. In the Target and Unit columns, select the appropriate target

values for the analyte.
5. On the toolbar, click the Add button.

After you are finished
Once the lot has been successfully added, you can modify it by selecting it
from the Saved Lots list, making your changes, and then clicking the Save
button from the LDMS tool bar. Once a lot has been used, it can no longer be
modified. If you want to discontinue a lot so that it can no longer be selected
when entering PK results in LDMS, select the Deactivate option for the lot.

Using assay device readers

Associating an Assay with a Reader
For assays in LDMS that read instrument output, you must associate the
assay with a reader device.

1. Click Administration > System Configuration from the LDMS menu
bar.

2. Change to the Assays tab.
3. Select the assay or assay template to be associated with a reader from the

Assays list.
4. Select the reader hardware that you will be using from the Device list.

Note:

Devices named  Device Name (From Disk) are to be used in
conjunction with LDMS Remote Reader.

5. Select the configuration that you want to use. The available configurations
are based on the device selected.

6. Click the    button from the LDMS toolbar. This will add the association to
the list at the bottom of the screen.
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Figure 69: Assay reader configuration in LDMS

Associating an assay with a reader device in LDMS

Table 23: Reader hardware supported by LDMS

Remote Reader Device File6 Remote Reader
File7

Direct Read8

Abbott PPC X

Abbott Quantum II X

Abbott Quantumatic X

Abbott Realtime HIV-1 m2000 X

AD 340C Absorbance Detector X

BioTek EL311 X

BioTek EL312 X

BioTek ELx800 X

BioTek Powerwave XS X

Chiron Assay Reader X

COBAS Amplicor Analyzer X

Coulter MR5000 X X

Coulter UVMax X X

Dupont VMax X X

Dynatech MR5000 X X

6 LDMS can read an output file with the results from the reader
device

7 Output from LDMS Remote Reader
8 LDMS can read output directly from a device reader, without

using an output file as an intermediary
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Remote Reader Device File6 Remote Reader
File7

Direct Read8

Molecular Devices X

Molecular Devices UVMax X X

MultiSkan Ascent X

NASBA/Nuclisens AXP X

Organon Teknika 520 X X

Roche AMPLILINK 1.3, 2.41, and 3.2
(for COBAS Amplicor Analyzer)

X

Roche ELX800 with Gen5 X

SoftMax X

SoftMax New X

SoftMax Partial Plate X

SpectraMax 250 X

Tecan Sunrise X

Creating a Reader Configuration
Before you can use a reader device, you must tell LDMS how you have it
setup. This is done on an individual instrument basis. You can either configure
LDMS to read output from the device directly, or you can utilize LDMS Remote
Reader to read the assay output on a different computer and then manually
transfer the output to the computer with LDMS.

6 LDMS can read an output file with the results from the reader
device

7 Output from LDMS Remote Reader
8 LDMS can read output directly from a device reader, without

using an output file as an intermediary
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Figure 70: Instrument configuration in LDMS

The configuration screen for the Coulter MR5000. The Read Device Data From Disk option indicates that LDMS

Remote Reader will be used.

Creating or modifying a reader configuration

1. Click Administration > Instrument Setup >  Device Name  from the
LDMS menu bar.

2. Type a name for your configuration into the Configuration Name box
or select an existing configuration from the Configuration Name box to
edit.

3. Change the Read Device Data From Disk option as follows:

• If you want LDMS to read assay output directly from the device (i.e. it
is connected to the same computer as LDMS), select No.

• If you want to utilize LDMS Remote Reader, select Yes. You will need to
configure LDMS Remote Reader to read from the device.

4. (For direct read only) Complete the appropriate Communication Port
Settings and Reader Configuration settings for your setup.

5. Click the    button.
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Once you have created a configuration for a device, that configuration can be
selected when associating the hardware with an assay.

LDMS Remote Reader

What is LDMS Remote Reader
LDMS Remote Reader is a program separate from LDMS that can be used
to read assay data and save it in a format that can be read by LDMS. It is
capable of reading assay output directly from the instrument or device reader,
and then generating an output file that can be read by LDMS. The purpose of
LDMS Remote Reader is to read assay data when it is not possible to connect
an instrument directly to the computer that is running LDMS. LDMS Remote
Reader has significantly lower system requirements than LDMS, which makes
it suitable for running on older hardware as well.

LDMS Remote Reader creates an output file after reading the assay from the
instrument. You must manually transfer the output file to the computer with
LDMS installed.

To obtain LDMS Remote Reader, contact LDMS User Support.

Configuring LDMS to use LDMS Remote Reader
To use LDMS Remote Reader with LDMS, you must first tell LDMS that you
want to read an assay reader device on a remote computer.

1. (For instruments that can be read directly by LDMS only) Create a new
configuration for the instrument

1.1. Click Administration > Instrument Setup >  Device Name  from
the LDMS menu bar.

1.2. Enter a name for your configuration into the Configuration
Name field. An easy name to help remember the purpose of the
configuration is REMOTE.

1.3. Click the OK button.
2. Click Administration > System Configuration from the LDMS menu

bar.
3. Change to the Assays tab.
4. Select the assay to be read using LDMS Remote Reader from the Assays

list.
5. Select the reader device from the Device list.

Note:

Devices that can only be read using LDMS Remote Reader are
labeled as  Assay Name (From Disk).

6. Select the appropriate configuration from the Configurations list.
For instruments that could be read directly by LDMS, this will be the
configuration that you created in Step 1.

7. Click the    button from the LDMS toolbar.
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Configuring LDMS Remote Reader
When you first start LDMS Remote Reader, it will show you the currently
selected device and configuration. When you read an assay, this is the device
reader that will be used. Before using an reader devices to read an assay, you
must configure your hardware.

Figure 71: LDMS Remote Reader device menu

Configuring a reader device

1. From the menu bar, click Device.
2. Select the device that you want to configure.
3. Select the configuration that you want to modify. If you are creating a new

configuration, select <Default>.
4. Change the settings for your device.
5. Save your configuration by doing one of the following:

• To save your changes to the configuration that you previously selected,
click the OK button.

• To save a new configuration, click the Save As button.

! Warning:

If you selected the <Default> configuration, this saving changes will
overwrite the default settings. You cannot undo this change.
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Figure 72: Device Configuration screen

Assay configuration screen in LDMS Remote Reader has the same options as LDMS.

After creating or modifying a configuration, that reader device and
configuration will automatically become your current reader. This means that
when you go to read an assay, these are the settings that will be used.

If you have more than one reader device connected to the computer (or more
than one configuration for a device), you will need to specify which one to
use.

Changing the current device and configuration used by LDMS Remote
Reader:

1. From the menu bar, select Device > Select Current Device/
Configuration....

2. Select the reader device that you want to read from the Select Device
list.

3. Select the configuration that you want to use from the Select
Configuration list.

Reading Assay Output using LDMS Remote Reader
LDMS Remote Reader acts as a go-between when the computer connected
to your assay reader does not have LDMS installer. LDMS Remote Reader
reads the device reader output, much like LDMS would read it, and creates an
output file that you can transfer to the computer with LDMS.
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Figure 73: LDMS Remote Reader workflow

This diagram shows the basic steps involved in using LDMS Remote Reader to get assay output into LDMS.

After reading the assay output using a device reader, the output file is
transferred to the computer with LDMS. Often, this is as simple as putting the
output file on a removable USB drive.

Reading assay output using Remote Reader Software:

1. On the computer with LDMS, setup the assay to be read.
2. In LDMS, generate a plate layout report for the assay by clicking the   

button from the LDMS toolbar while on the assay Preview tab.

Important:

The plate layout report is required to use LDMS Remote Reader.
3. On the computer with LDMS Remote Reader, start LDMS Remote Reader.
4. Click Device > Read Device from the menu bar.
5. Verify that the Device is correct.
6. Verify that the Run Date is correct, and adjust it if necessary.
7. In the Run ID field, enter the system generated run ID from the Plate

Layout Report.
8. In the Sequence Number field, enter the plate number from your Plate

Layout Report.
9. Select the drive where you want the output file to be written from the

Output Drive list. For example, if you have a removable USB drive
connected as the E:, select that drive.

10.Click OK to begin reading the assay output.
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Figure 74: Reading and assay with LDMS Remote Reader

Reading an assay using LDMS Remote Reader.

Once LDMS Remote Reader has finished reading the assay output from your
device reader, a directory called devdata will be created in the drive you
selected for the output (e.g. E:\devdata). This directory will contain your
assay run data file. Files will be named according to the run ID and sequence
number. These are the files that you will need to transfer to the computer with
LDMS installed.

Now that you have the assay output, you need to read it using LDMS.

Reading assay output captured by LDMS Remote Reader with LDMS:

1. Copy the desired assay output files from the devdata directory to a
removable media, then connect the removable media to the computer
running the full version of LDMS.

2. In LDMS, click Tasks > Assays or the    button from the LDMS toolbar.
3. On the Assay Selection tab, find the assay that you ran in the Assays

list on the left.
4. Select the Runs not Performed/Not Terminated radio button.
5. Enter the run ID into the Run ID field. This number is found on the Plate

Layout Report and entered in LDMS Remote Reader.
6. Click the    button. All assay runs that were set up but have not been

run will be listed under Previous Runs Found.
7. Select the assay for which you will be reading data, and then click the 

 .
8. Change to the Preview tab. (LDMS may change to this tab automatically

after selecting an assay).
9. Enter run information as appropriate, depending on the assay.

• For some assays, complete fields on the Preview tab, such as Tech
Initials and Sample Prep. Method, then click the    button.

• For some assays, you don't complete anything on the Preview tab.
Instead, click the    button. The Enter Run Information window
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will appear with the fields that you must enter to complete the run.
After entering this information, click the    button.

10.A window will appear to select the assay output data file. Navigate to
the location of your devdata directory (e.g. a USB drive) and select the
appropriate file.

Printers
This section will describe how to setup various printers that are known to
work with LDMS.

Setting up the Brady IP300 printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

• Contact LDMS User Support to receive a specific update to Crystal Reports
that is required to use this printer.

Background

This printer is known to work with the following label and stock settings in
LDMS:

label stock THT-183-461

LDMS label Barcode label 7

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right-click the IP300 icon, and then click Printing preferences.
3. Click Advanced.
4. Next to Paper Size, click Properties.
5. In the Paper Size box, select the appropriate paper size.
6. On the control panel in front of the printer, change the printer head to

+10mm for the X axis and -3.0mm for the Y axis
These head adjustments have been tested with the THT-183-461
label stock. Other label stocks may require different printer head
adjustments.
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7. In LDMS, set the printer as your label printer.

Setting up the Brady® MVP 300 printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer, and click Printing preferences.
3. Set the stock size.

3.1. Expand the Paper/Output settings
3.2. In the Paper Size box, select User Defined.
3.3. Click Customize.
3.4. In the Width and Height boxes, entered the dimensions of your

label stock.
3.5. In the Unit of Measure box, select Inches.
3.6. Click OK.

4. In the Devices and Printers window, right click the printer icon, and
click Properties.

5. On the Printer tab, change the following settings:
5.1. In the Device Options > Head Settings > Print Darkness

section, change the Print Darkness setting to 22.
5.2. In the Speed Settings, enter the following settings:

Print speed 2.00 in/sec

Slew speed 2.00 in/sec

Back feed
speed

2.00 in/sec

6. On the Ports tab, click Configure Port and enter the following
settings:

Bits per
second

115200

Data bits 8

Parity None

Stop bits 1

Flow control Xon/Xoff

7. In LDMS, set the printer as your label printer.
8. Configure the printer hardware.

8.1. Open the printer and remove the protective plate that is covering
the ribbon sensor.
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8.2. Slide the transmissive sensor protector to the outside of the
adjustable transmissive sensor.

8.3. Place the ribbon on the ribbon supply spindle.

Note:  The shiny side of the ribbon must be facing up.

8.4. Feed the ribbon through the ribbon sensor and around the print
head assembly.

8.5. Wrap the ribbon around the ribbon take-up spindle until it is
tight.

Tip:  Attach a piece of tape to the end of the ribbon to
help keep it tight during the loading process.

8.6. Place the labels on the media supply spindle.
The printable side of the label must be face-up.

8.7. Place the labels through the media guide and align the notch
between labels with the tear-off plate of the printer.

8.8. Adjust the ribbon sensor so that the notch of the label will cross
the ribbon sensor.
The ribbon sensor is the red light under the label.

8.9. Close the print head and ensure that the ribbon is aligned with
the left side of the label.
This adjustment may require you to slide the ribbon across the
print head assembly.

8.10.Close the printer.
9. On the control pad on front of the printer, do the following:

9.1. Press the Setup/Exit button.
9.2. Press the + button until the printer displays Manual Calibrate.
9.3. Press the Select button.
9.4. Press the + button.

The printer will re-calibrate its label settings.
9.5. Press the Setup/Exit button, and then press the + button to

save the changes.

Setting up the LabXpert printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer, and click Printing preferences.
3. Expand the Paper/Output settings, and click Properties text to

Paper Size.
4. In the Paper Size box, select the appropriate paper size.
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5. In the Devices and Printers window, right click the LabXpert icon,
and click Properties.

6. On the Ports tab, enter the following settings:

Bits per
second

115200

Data bits 8

Parity None

Stop bits 1

Flow control Xon/Xoff

7. Configure the printer to accept input from your LDMS computer.

Important:  This step must be completed every time the
printer is turned on.

7.1. On the printer, press the Menu button.
7.2. Press the Next button three times.
7.3. Press the PC button.

8. In LDMS, set the printer as your label printer.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Zebra® GX 430t printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

• Load the printer with label stock and ribbon according to the printer’s
manual.

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer, and click Printing preferences.
3. On the Options tab, change the Speed to 2.
4. Change the Print Darkness to about 27.

This setting should be adjusted up or down, depending on whether
labels are too light or too dark.
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5. In Paper format, select inches.
6. In Paper Size, set the Width to 4.00 and the Height to 1.75.
7. On the Advanced Setup tab, click Calibrate.
8. On the Advanced Setup tab, verify that the Tracking Mode is set to

Web Sensing.
9. In LDMS, set the printer as your label printer.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Brady BBP11-34L printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Background

This printer is known to work with the following label and stock settings in
LDMS:

label stock THT-183-461-0.5-SC

LDMS label Barcode Label 9

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer, and click Printing preferences.
3. On the Page Setup tab, under Stock click New.
4. Enter the dimensions 1.75″ × 1.00″.

These are the dimensions for the THT-183-461-0.5-SC label stock. If
you are using a different stock, enter the appropriate dimensions.

5. Click Advanced Options, and verify that the horizontal and vertical
offset options are set to 0″.

6. On the Stock tab, enter the following into the Media settings:

Method Thermal transfer

Type Labels with marks

Mark height 0.08 in

Mark offset 0.00 in

7. On the Options tab, enter the following into the Printer options:

Print speed 2.00 in/sec

Darkness 10
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8. Click OK.
9. In LDMS, set the printer as your label printer.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Brady® BBP33 printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

Background

This printer is known to work with the following label and stock settings in
LDMS:

label stock B33-179-482 (1″x1″)

LDMS label Barcodelabel19

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer, and click Printing preferences.
3. Click Advanced.
4. Next to Paper Size, click Properties.
5. In the Paper Size box, select the appropriate paper size.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.
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Setting up the Brady BMP53 printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

Background

This printer is known to work with the following label and stock settings in
LDMS:

Cartridge M-156-492

LDMS label Barcode Label 16

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the BMP51(53) icon, and click Printing preferences.
3. Click Advanced.
4. Next to Paper Size, click Properties.
5. In LDMS, set the printer as your label printer.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Brady BP-PR 300 printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.
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2. Right click the Brady PR 300 PLUS icon, and click Properties.
3. In the Size section, change the Width and Height to the size of your

label stock.
4. In LDMS, set the printer as your label printer.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Zebra ZD620 Printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

• Load the printer with label stock and ribbon according to the printer's
manual.

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer and click Printing Preferences.
3. On the Print Options tab, change the Speed to 4. This setting should

be adjusted accordingly.
4. Change the Print Darkness to about 20. This setting should be

adjusted up or down, depending on whether labels are too light or too
dark.

5. In the Page Setup, set the Width and Height according to labels
used. Ex.: Width: 2.75" Height: 1"

6. In LDMS, set the printer as your label printer.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.
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Setting up other printers
Label printers that do not have specific instructions provided in this manual
may still work with LDMS, however they will not have been tested by LDMS
User Support.

Steps (completed in any order)

• Contact LDMS User Support for assistance.
• Consult the most current list of supported printers.
• If you are using a printer not listed in this manual, let LDMS User Support

know so that it can be added.

Preset groups
Preset groups are groups that are built into LDMS that have special rules and
requirements.

Preset groups and their requirements cannot be modified or removed by
users. These groups and designed based on the needs of a specific group
working with Frontier Science. An example of a preset group is ACTG/
IMPAACT. Specimens created until this group have specific requirements,
which are defined by ACTG and IMPAACT. These requirements are
implemented in LDMS to accommodate the needs of the group.

The rules for preset groups fall into two categories:

• Validation rules that can be enforced by LDMS, such as requiring that ID1
be formatted a certain way

• Requirements that cannot be enforced by LDMS, such as requiring
specimens to be entered within a certain period of time after they are
received by your laboratory.

Important:  The information for individual groups provided here are
for convenience only. Always refer to guidance provided by the group
for the most up-to-date instructions.
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ACTG/IMPAACT
The ACTG/IMPAACT preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required* 8 characters long, 7 numbers and one letter
between A and L; if the PID does not have 7
numbers, add leading zeros to the front of it.

*This requirement can be disabled by Frontier
Science for certain studies.

ID2 (Protocol) Required Select from the pre-defined list of protocols.

ID3 Optional LDMS will remember previously entered ID3s
and automatically populate ID3 when the same
group-PID-protocol combination is entered.

Visit Required Select from pre-defined list of visit units.

OPID Available --

Clinic Required LDMS will automatically populate the clinic
using one previously entered for the same PID,
protocol, and SID combination.

Specimen Time Depends If you do not have a specimen time recorded
on your CRF, contact the clinic that collected
the specimen from the participant. This field is
required for specimens with a specimen date
of 01 January 2004 or later; it is optional for
specimens prior to that date. This requirement
can be overridden for specimens after this
date, if necessary.

Received Time Optional --

Notes

• ACTG/IMPAACT uses the standard LDMS Shipping File format to ship
between ACTG and IMPAACT laboratories using LDMS.

• ACTG/IMPAACT requires specimens to be labeled with a 2D barcode and
label from LDMS; LDMS comes with label formats for ACTG setup and
ready to use.

• ACTG and IMPAACT are listed as a combined group throughout LDMS
(ACTG/IMPAACT).

• Preloads are permitted for the ACTG/IMPAACT group, but users are not
permitted to create their own. All ACTG preloads are created by Frontier
Science in collaboration with network leadership.
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AERAS
The AERAS preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 11-digits of any combination of letters and
numbers.

ID2 (Study) Required Selected from pre-populated list. Once
selected, the LDMS will check that the PID is
associated with the selected protocol.

ID3 Disabled This field is not used by Aeras

Visit Required Select from pre-defined list of visit units.

OPID Disabled This field is not used by AERAS

Clinic Required AERAS clinics are in the format ARSXX, where
XX are the 5th and 6th digits from the PID

Specimen Time Required --

Received Time Optional --

Notes

Quick Add templates can be used for Aeras.

AIEDRP
The AIEDRP preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must either pass the ACTG/IMPAACT or HPTN
ID1 validation check, depending on the
protocol

ID2 (Protocol) Required Will determine what ID1 format should be used

ID3 (SID) Required Must be NOSID or pass the ID1 validation

Visit Required --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --
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Protocol and ID1 check used

Protocol ID1 validation used

I03005 ACTG/IMPAACT

I03006 ACTG/IMPAACT

I03007 ACTG/IMPAACT

I03008 ACTG/IMPAACT

I03010 Either

I03011 Either

CORE01 Either

AIN501 Either

AIN502 Either

AIN503 Either

AIN504 Either

AIS
The AIS (Nigeria State Level ART Impact Survey) preset group has these
requirements.

Data entry requirements

Field Required? Note

ID1 (PTID) Required Must be length 9. First 4 characters are letters
only and last 5 characters are numeric only
(e.g., ABCD12345)

ID2 (Country) Required "Nigeria" is the only available option

ID3 (HIVRT) Required Pick list of specific options

Collection Time Required --

Received Date and
Received Time

Required --

Clinic Required Must require the clinic be formatted like
NG### where the first 2 characters are the
letters NG and the next 3 characters are
numbers. (e.g., NG000 or NG031)
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AMC
The AMC preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (ID1) Required --

ID2 (PROTOCOL) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

ATN
The ATN preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required A 6-digit number between 10001 and 999999.
If the PID is less than 6 digits, leading zeros
will automatically be added. LDMS will check
that the PID is valid.

ID2 (Protocol) Required Must be a 3 digit number between 004 and
999

ID3 (SID) Required An 8-digit number between 40001 and
999999999. If the SID is less than 8-digits,
leading zeros will automatically be added. 7-
digit SIDs can still be imported by LDMS. If
the same PID-protocol combination has been
entered, LDMS will automatically default to the
previously used SID. NOSID is a valid entry for
ATN.

Visit Required Select from pre-defined list of visit units.

OPID Available --

Clinic Optional --

Specimen Time Required --

Received Time Optional --
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Notes

Quick Add templates can be used for ATN.

BHP
The BHP preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 characters long, 7 numbers and one letter
between A and L; if the PID does not have 7
numbers, add leading zeros to the front of it.

ID2 (Study) Required The only available choice in the drop down
menu is 'Tatelo'.

ID3 (Step) Required Available choices in drop down menu are 0, 1,
2, or 3.

Visit Required Select from pre-defined list of visit units.

OPID Optional --

Clinic Required Any clinic may be set.

Specimen Time Required --

Received Date Required --

Received Time Required --

Notes

• User Quick Add templates are not permitted for BHP.

BM
The BM preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (studyID) Required Must be in the BM studyID format

ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --
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BM ID1 format
BM-XXX-Y

BM Must be “BM”

XXX Any 3 digits

Y 0 for mother; 1 to 9 for child

Botswana MOH
The Botswana MOH preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be in the Botswana MOH PID format

ID2 (Study) Required Default option is IBBS3

ID3 (HIVRT) Required Select from a list of predefined HIV status
value

Clinics Optional --

Notes

• The application must allow FSTRF-defined preloads for this project.

Botswana MOH PID format
XXYYNNNNNN

XX District (alphabet, length 2)

YY KP type (numeric, length 2)

NNNNNN Participant (numeric, length 6)

CEMALB
The CEMALB preset group must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be 5 characters

ID2 (Protocol) Required --

ID3 (Visit) Optional --

Visit Optional --

OPID Optional --
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Field Required? Note

Clinic Optional --

Draw Time Optional --

Received Time Optional --

CHAVI
The CHAVI preset group must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must pass HPTN ID1 validation and must be 9
characters in length

ID2 (Protocol) Required Validated using ID1, where ID2 is embedded
into ID1 as either the 4th or 4th and 5th digits,
depending on the protocol

ID3 (ID3) Optional --

Visit Required --

OPID Optional Must be empty until the protocol is 008A

Clinic Optional --

Draw Time Optional --

Received Time Required --

CIPRA-HT
The CIPRA-HT preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must pass HPTN ID1 validation

ID2 (Protocol) Required --

ID3 (SID) Required Must pass the historical ACTG/IMPAACT ID3
validation

Visit Optional --

OPID Optional --

Clinic Required --

Draw Time Optional --

Received Time Optional --
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CIPRA-ZA
The CIPRA-ZA group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (CP#) Optional --

ID3 (SID) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

CIPRA
The CIPRA preset group must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be 9 characters in the CIPRA ID1 format

ID2 (Protocol) Required In the format P[0-10]

ID3 (ID3) Optional --

Visit Required --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

CIPRA ID1 format
AABBCCCCD

AA 01 to 99

BB 01 to 99

CCCC 0001 to 9999

D 0 to 9
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CONTROL
The CONTROL preset group must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (CONTROLNAME) Required --

ID2 (PROTOCOL) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

CoVPN
The CoVPN (COVID-19 Vaccine and Prevention Network) preset group must
meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PATID) Required Study 3008 has a predefined ID1/PATID check.

ID2 (Study) Required --

ID3 (ID3) Optional --

Visit Required --

Clinic Required --

Specimen Time Required --

Received Time Required --

Notes

• Information for study CoVPN 5001 should be logged under VTN study
5001.

• Labels are restricted to all supported VTN formats.
• CoVPN has a checkbox for Collected Outside Protocol Requirements.
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CPCRA
The CPCRA preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Study) Optional --

ID3 (Bth/Sex) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

CPQA
The CPQA preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PanelID) Required Must be five characters in length in the format
[Round_#][Panel_alpha_ID][2_numbers],
such as 22A00

ID2 (RoundNo) Required This is the same as the first 2 digits of the
PanelID. This field will automatically be
populated by LDMS.

ID3 (ExpDate) Optional --

Visit Optional Select from pre-defined list of visit units.

OPID Optional --

Clinic Optional --

Specimen Time Optional --

Received Time Optional --

Notes

• CPQA use the LDMS shipping file format
• There are CPQA barcode options available in LDMS.
• Quick Add templates can be used for CPQA, however users are not

expected to use this feature.
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• The Pharmacology Proficiency Results report can be generated from
LDMS for Clinical Laboratory Improvement Amendments (CLIA). This is
sometimes referred to as the “CLIA Report”.

FACTS
The FACTS preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required A 7-digit number. LDMS will verify that the PID
is valid.

ID2 (Study) Required Select from pre-populated list

ID3 Disabled This field is not used by FACTS

Visit Required Select from pre-defined list of visit units.

OPID Disabled This field is not used by FACTS

Clinic Disabled This field is not used by FACTS

Specimen Time Required --

Received Time Optional --

Notes

• Quick Add templates can be used for FACTS.

HN
The HN preset group must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (studyID) Required --

ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --
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HPTN
The HPTN preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required LDMS performs a checks to make sure the
PID is valid. Based on the protocol, LDMS will
determine whether a 9-digit or 10-digit PID
must be used.

ID2 (Protocol) Required Special PID checks are enforced if the protocol
is 043.0. For 043.0, the visit will also be
set to 2.0 VST, and the user will not be able
to modify it. This field allows dashes (e.g.,
084-01)

ID3 Optional Special ID3 checks are enforced if the protocol
is 043.0. For 043.0, this field allows up to 12
characters, and should be scanned from the
blood ID number.

Visit Required Defaults to the visit unit of VST. Interim,
unscheduled visits should be entered by
incrementing the visit value (e.g. 1.10 for the
first unscheduled visit, 1.20 for the second,
etc.). If the protocol is 043.0, the visit will also
be set to 2.0 VST, and the user will not be able
to modify it.

OPID Disabled --

Clinic Optional Any clinic may be set.

Specimen Time Required --

Received Time Optional --

Notes

• There are several HPTN label formats available.
• Primary and aliquot volumes with default to ML.
• Quick Add templates are not permitted for HPTN.
• Old records may have a clinic set retroactively if not set at the time of

entry
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IPREX
The IPREX preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must by 5 to 7 characters long and a valid
IPREX PID; NOPID is a valid PID, unless the
SID is NOSID.

ID2 (Protocol) Required --

ID3 (SID) Required Must be 11 characters long, with the first
2 digits being the clinic and the last five
being the screening number in the range
80001-99999

Visit Required --

OPID Optional --

Clinic Required Must be 3 characters long in the format I[86 to
97] (such as I92)

Draw Time Optional --

Received Time Optional --

Notes

• IPREX using the LDMS Shipping File format.
• When entering sero-conversion visits, use the visit unit SC. The visit value

should be the same as the originally scheduled visit.
• When entering sero-positive visits, use the visit unit SP. The visit value

should be the number of weeks after the seroconversion visit.

IQA
The IQA preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --
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Field Required? Note

Received Time Optional --

IRC
The IRC preset group has these requirements

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Protocol) Required --

ID3 (SID) Required --

Visit Required --

OPID Optional --

Clinic Required --

Collection Time Required Only required if the collection date is after 01-
Jan-2004

Received Time Optional --

KENPHIA2
The KENPHIA2 preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PTID) Required Must be length 8. First 2 characters are letters
only (KE) and last 6 characters are numeric
only (e.g., KE123456)

ID2 (Country) Required "KENYA" is the only available option

ID3 (HIVRT) Required Pick list of specific options

Collection Time Required --

Received Date and
Received Time

Required --

Clinic Required Must be formatted like XX### where the first
2 characters are the letters KE and the next 3
characters are numeric (e.g., KE101)
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MACS
The MACS preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (MACSID) Required MACS Identifier

ID2 (Study) Required --

ID3 Optional Previously entered ID3s will be automatically
populated by LDMS for the MACSID and study
combination

Visit Optional Select from pre-defined list of visit units.

OPID Optional --

Clinic Optional Previously entered clinics will be automatically
populated by LDMS for the MACSID and study
combination

Specimen Time Optional --

Received Time Optional --

Notes

• Quick Add templates are permitted for MACS.
• MACS shipments being sent to Precision Bioservices (formally SeraCare)

use the SeraCare shipping file format.

MAVRC
The MAVRC preset group must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Protocol) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --
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mStudy
The mStudy preset group must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 6 digit numeric format

ID2 (Study) Required Pre-populated with value = MSTUDY

ID3 (ID3) Optional --

Visit Required --

OPID Optional --

Clinic Required --

Draw Time Required --

Received Time Required --

MTCT
The MTCT preset group has these requirements

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Protocol) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

MTN
The MTN preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 9 characters long

ID2 (Protocol) Required Select from a pre-populated list
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Field Required? Note

ID3 Disabled Not used for MTN

Visit Required Visit unit defaults to VST, but this can be
overridden

OPID Disabled Not used for MTN

Clinic Optional --

Specimen Time Optional This field is not required, but recommended

Received Time Optional This field is not required, but recommended

Notes

• Primary and aliquot volume will default to ML for MTN specimens.
• There are two label options available for MTN, one with a barcode and one

without.
• Quick Add templates are permitted for MTN.

MWCCS
The MWCCS preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 digits long

ID2 (Study) Required Select from a pre-populated list (e.g., MWCCS)

ID3 Optional --

Visit Optional --

OPID Optional --

Clinic Required Select from pre-populated list. Correct options
defined as XNNN (e.g., X206)

Specimen Time Optional This field is not required, but recommended

Received Time Optional This field is not required, but recommended

Notes

• The cross-LIMS shipping file format should be used for all shipments going
to Precision Biosciences (lab 512).
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NICHD-Westat
The NICHD-Westat has the same requirements the ACTG/IMPAACT group.

PHACS
The PHACS preset group has these requirements

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 characters long, 7 numbers with a letter at
the end

ID2 (Protocol) Required Select from a pre-populated list; all protocols
are in the format PHXXX (e.g. PH200).

ID3 N/A Not used by PHACS

Visit Required Select from pre-defined list of visit units.

OPID Optional --

Clinic Required Will automatically populate using the previous
clinic for the group, PID, and protocol
combination entered; PHACS clinics range
between 1 and 24. LDMS will check that a valid
clinic was selected.

Specimen Time Optional This field is optional, but recommended

Received Time Optional This field is optional, but recommended

Notes

• PHACS uses the standard LDMS shipping file format.
• There are two label options for PHACS specimens, one with a barcode and

one without.
• Quick Add templates can be applied for PHACS, but users are not permitted

to create their own templates. All PHACS templates are created by Frontier
Science in collaboration with PHACS leadership.

PHIA
The PHIA preset group has these requirements

Data entry requirements

Field Required? Note

ID1 (PTID) Required [Country_Code][6_digits] (Example:
ZW123456)

Frontier Science Foundation 226



LS.0005 | LDMS for Windows - User Manual

Field Required? Note

ID2 (Country) Required Automatically populated based on country
code in PTID; SW (Swaziland) differs from the
ISO 3166 country code (SZ)

ID3 (HIVRT) Required Testing result (POS, NEG, or IND)

Visit Required --

OPID Optional --

Clinic Required A warning will appear if the country codes in
the PTID and clinic do not match

Specimen Time Required --

Received Time Required --

Notes

• Quick Add templates cannot be created for this group.
• Quick Add templates can be used for this group.

Related reference
PHIA country-specific template settings on page 185
There is special logic built into the Test Result Entry tool for PHIA specimens.

REPRIEVE
The REPRIEVE preset group has the same requirements as the ACTG/
IMPACCT group.

SHIMS
The SHIMS preset group must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Nine characters long that meets the SHIMS
ID1 requirements

ID2 (Study) Required --

ID3 (Rapid Test) Required --

Visit Required --

OPID Optional --

Clinic Optional --

Draw Time Required --

Received Time Required --
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SHIMS ID1 format
RAAAhhcpp

R 1 to 4

AAA 001 to 599

hh 01 to 26

c Check digit

pp 01 to 99

SNRP
The SNRP preset group has these requirements

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Study) Optional --

ID3 (SID) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

TIES
The TIES preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 characters long, 7 numbers and one letter
between A and L; if the PID does not have 7
numbers, add leading zeros to the front of it.

ID2 (Protocol) Required Select from the pre-defined list of protocols.

ID3 (ID3) Available ID3 is not used by this group

Visit Required Select from pre-defined list of visit units.

OPID Available --

Clinic Required In the format T[Clinic_Number]

Specimen Date Required --
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Field Required? Note

Specimen Time Required --

Received Date Required --

Received Time Optional --

VQA
The VQA preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PanelID) Required LDMS will determine if this field is valid.
Specimens entered or received in a shipping
file prior to 01-July-2007 will not be validated.

ID2 N/A This field is not used by VQA

ID3 N/A This field is not used by VQA

Visit N/A This field is not used by VQA

OPID N/A This field is not used by VQA

Clinic N/A This field is not used by VQA

Specimen Time N/A This field is not used by VQA

Received Time N/A This field is not used by VQA

PanelID format
[Assay_Category][Panel_Number][Panel_Subtype].[Num]Panel_Configuration

Assay_Category RNA, DNA, or CUL

Panel_Number A number between 000 and 999

Panel_Subtype
UM Ultrasensitive RNA

SM Standard RNA

RT DNA proficiency panel

PQ DNA pre-qualification panel

CC Culture panel

Num A number between 01 and 99

Panel_ConfigurationA, B, or C
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VTN
The VTN preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required LDMS checks that the PID is valid. Must
be 9 or 10 characters. A PID cannot be
changed without approval from VTN Laboratory
Leadership.

ID2 (Protocol) Required LDMS checks that the PID and protocol
combination are valid.

ID3 Disabled --

Visit Required Use VST for routine HIV diagnostic visits,
otherwise use the appropriate visit unit. This
visit unit is used by certain laboratories for
driving testing algorithms.

OPID Disabled --

Clinic Required The clinic is automatically populated based
on the PID; the same clinical location can be
associated with multiple clinic IDs (e.g. for
Phase I/II or Phase II/III). VTN clinics start
with the letter V (such as V101 instead of
101). LDMS will verify that a VTN clinic was
selected.

Specimen Time Required --

Received Time Required --

Notes

• Throughout LDMS, HVTN is listed as VTN.
• The volume for VTN specimens will default to ML.
• Within VTN, LDMS Shipping files are sometimes called “e-manifests”.
• Barcodes must be printed on labels for VTN specimens.
• Quick Add templates are not permitted for VTN specimens.
• Information for study CoVPN 5001 should be logged under VTN study

5001.

WHIN
The WHIN preset group must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (ParticipantID) Required --

Frontier Science Foundation 230



LS.0005 | LDMS for Windows - User Manual

Field Required? Note

ID2 (Protocol) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

WIHS
The WIHS preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must meet WIHS PID format requirements

ID2 (Protocol) Required Select from pre-populated list

ID3 (SID) Optional --

Visit Required The visit unit will default to VST, and the visit
number will be automatically populated based
on an algorithm that uses the current date

OPID Optional --

Clinic Optional --

Specimen Time Optional --

Received Time Optional --

WIHS PID format
[Site_Number][Recruitment_Number][Participant_Number][Check_Digit]

Site_Number
1 NYC (Bronx)

2 Brooklyn

3 Washington, D.C.

4 Los Angeles

5 San Francisco

6 Chicago

Recruitment_Number
2B New recruit

0B Original recruit
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1B Original recruit

Check_Digit Any character; an algorithm will determine if the
character is valid based on the read of the PID.

Notes

• WIHS shipments being sent to Precision Bioservices (formally SeraCare)
use the SeraCare shipping file format.

• Quick Add templates are permitted for WIHS, and users are expected to
create and use template for WIHS data entry.

• Collection Date and Received Date will automatically be set to your local
date.

WITS
The WITS preset group has these requirements

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

WITSRepos
The WITSRepos preset group must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (Subject ID) Required --

ID2 (Study ID) Optional --

ID3 Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Frontier Science Foundation 232



LS.0005 | LDMS for Windows - User Manual

Field Required? Note

Draw Time Optional --

Received Time Optional --

ZEBS
The ZEBS preset group has these requirements

Data entry requirements

Field Required? Note

ID1 (STUDYID) Required --

ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

ZIP
The ZIP preset group has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be a 6-digit (for ID2=ZIP) or 7-digit
(for other ID2 values). Following the digits,
there must be a letter. A hard check should
run to ensure the first two digits match to a
corresponding ZIP clinic code ZXX.

ID2 (Study) Required Use allowed studies (ZIP, Z1.0, or Z2.0)

ID3 (Screening ID) Required It must be in the format SAAXXXX, where AA
is a valid clinic number (i.e., ZAA) and XXXX is
any numeric number.

Visit Value and Vist
Unit

Required --

Clinic Required The LDMS will automatically populate the
correct, corresponding clinic ID based off of
the entered PID. If a corresponding clinic ID
is not found, leave the clinic field blank and
select a value.

Specimen Date Required --

Frontier Science Foundation 233



LS.0005 | LDMS for Windows - User Manual

Field Required? Note

Specimen Time Required --

Received Date Required --

Received Time Required --

Notes

• The application must allow FSTRF and user defined preloads for this
project.

• The application must not restrict the user from co-enrolling specimens for
this project.

Administration and maintenance

System Configuration
This is a description of the options found in Administration > System
Configuration.

Configuration tab

Module Login (Default = not enabled) If selected, users will need to
re-enter their username and password to access almost
every feature in LDMS. This security feature is useful
if you want to prevent users from using LDMS while
another person is logged in.

Idle Time Out (Default = enabled) If selected, LDMS will automatically
lock after the specified amount of time of inactivity.
LDMS will ask for a user name and password (it need not
be the same as the user last using LDMS when it locked)
before it will open again.

Auditor Mode This option is not available to users.

Date Format This option is not available to users. LDMS uses the date
format dd/Mon/yyyy (e.g. 09/Apr/2013).

Date Separator This option is not available for use.

Barcode Reader Set the barcode reader used by LDMS. For most
hardware, the Code Reader option will work.
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Process Tech
Initials default
to current user

(Default = enabled) The initials for the current user will
be entered automatically in fields for the tech's initials
throughout LDMS.

Internet tab

These settings should not be modified by users.

Storage tab

Permanent
Delete Default
Setting

(Default = enabled) If enabled, specimens will be
assigned the never store property when being removed
from storage.

Set Frozen
Date/Time to
Current Date/
Time

(Default = not enabled) If enabled, the frozen date and
time of specimens will be set to the current date and
time when the specimens are stored.

Assays

Associate an assay in LDMS with assay reader hardware.

Import

Allow automatic
storage of
imported
samples

(Default = not enabled) If enabled, LDMS will add the
storage items in received shipments to a specimen
import freezer in storage. The Import configuration
option overrides can be set to change settings of
storage items that are added in this way.

Managing users

Creating New Users
LDMS is a user-based system. LDMS cannot be used without a valid user
name and password. User names and passwords in LDMS are not tied to your
computer's login credentials. By using individual user accounts, it is possible
to keep track of who did what in LDMS, and prevent users from accessing
advanced features that they should not be using.

When LDMS is installed, it comes with one default account, ADMIN (the
password is also admin). The first time you start LDMS, you should
immediately create one or more user accounts, and then remove the admin
account.

Important:
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Using the ADMIN account for daily work is strongly discouraged. It
should be deleted as soon as you have added at least one user with
system administrative privileges.

Adding a new user account

1. Click Administration > User Configuration from the LDMS menu bar.
2. On the User Configuration screen, click the    button.
3. Complete the User Name field. This field must be unique among other

user names at your laboratory.
4. Enter the user's Real Name. This field can contain spaces.
5. Enter the user's Initials.
6. Enter the password for the new user.

Note:

Passwords in LDMS are not case-sensitive.

By default, a user's Initials will be used throughout LDMS to populate fields
with the user's initials when appropriate. This behavior can be changed.

Adjusting User Permissions
Every user in LDMS is assigned privileges. When you create a new user, you
should review the default privileges that are assigned to all new users and
adjust them accordingly.

Every privilege corresponds to a menu item in LDMS. For example, the Kit
Entry permission controls access to QA/QC > Kit Entry. If you want to know
what a particular permission does, find the LDMS menu item of the same
name.

Modifying a user's permissions

1. Click Administration > User Configuration from the LDMS menu bar.
2. Select the user that you want to modify from the User ID drop-down list.
3. Select the permissions desired.

• The View permission allows a user to see the records (e.g. viewing
aliquots in Specimen Management   ).

• The delete permission allows a user to remove records (e.g. deleting
an aliquot).

• The modify permission allows a user to change records (e.g. changing
an aliquot's volume); the view permission would also be required
separately.

• The add permission allows a user to create new records (e.g. adding
new specimens); this can be independent of the ability to view records,
so a person could enter data without being able to see existing data.

• The full permission is the same as giving a user access to view, add,
modify, and delete.

4. To make a user a system administrator, select the System Administrator
Capabilities option.

5. Click the    button from the LDMS toolbar.
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Tip:

Click on a column header to select or unselect all of the permissions
in that column. This is useful if you want to quickly give someone full
permission to everything in LDMS.

System Administrator Capabilities

At least one user at your laboratory must have System Administrator
Capabilities. This gives the user access the certain features:

• Reset and change passwords for other users
• Lock out and unlock user accounts
• Delete users
• Designate other system administrators

By default, the original ADMIN account has system administrator privileges.
Before deleting the ADMIN account, make certain that at least one user has
system administrator capabilities.

Modifying Users and Passwords
While a user's login name cannot be modified, their full name and initials can.
You would need to do this, for example, if a user's last name changed.

Updating a user

1. Click Administrator > User Configuration from the LDMS menu bar.
2. Select the user to modify from the User ID drop-down list.
3. Do one of the following:

• To update the user's full name or initials, click the    button.
• To delete the user's account, click the    button.
• To change the user's password without the current password, click the 

  button (requires system administrator capabilities).
• To prevent the user from logging in without deleting the account, click

the    button (requires system administrator capabilities).

Note:

The message entered when locking out a user will be displayed if
that user attempts to log in.

• To change the user's password when you know the current password,
click the    button.

4. Click the    button from the LDMS toolbar.

Tip:

If you want to allow users to change their own passwords without being
able to make any other user account changes, give them view access
to User Configuration. They will only be able to access the   
button for their own account.
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Adjusting Login Security
In addition to adjusting individual user permissions, there are a few security
settings that you can change to help prevent users for using LDMS under
another person's user account:

• Require login when trying to use a specific feature. Even if users are logged
into LDMS, they will still be required to provide their password to move
between tasks.

• Adjust the time frame when LDMS will automatically lock. A username and
password will be required to access LDMS again.

• Train laboratory staff to lock LDMS manually when leaving a workstation.
This is done by clicking Administration > Session Lock from the LDMS
menu bar, or by pressing Ctrl + Shift + L.

group Configuration
LDMS has many hard-coded groups (typically government-sponsored
networks like ACTG and IMPAACT). When one of these groups is selected in
LDMS Specimen Management   , LDMS enforces certain rules specific to that
network on what fields are required and what are valid entries. These groups
are defined by Frontier Science in collaboration with individual networks, and
cannot be modified by users.

Laboratories can, however, add their own groups for internal use. Internal
groups can be modified and used as a laboratory sees fit.

To view groups and add new internal groups, click Administration > Group
Configuration. You'll see a list of all groups in your LDMS installation, along
with the labels for the ID1, ID2, and ID3 fields in Specimen Management   .
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Figure 75: group Configuration

Viewing and configuring groups in LDMS; only internal created by your laboratory can groups can be modified.

Adding a new internal group to LDMS:

1. Click Administration > Group Configuration from the LDMS menu bar.
2. Click the    button to add a new row to the listing of groups.
3. Enter the name for the group as you want it to appear throughout LDMS

into the Group field.
4. Enter a description for your group into the Group Desc[ription] field.

This information will appear if a user presses  Ctrl H  with your group
selected.

5. Enter the label that you want to use for the ID1, ID2, and (optionally)
ID3 fields in LDMS Specimen Management    into the Patient ID,
Study, and Secondary ID fields respectively.

6. Click the    button from the LDMS toolbar.

You can only modify groups that you have created. If you attempt to modify a
group that is hard-coded into LDMS, you will receive an error message.

Internal Groups and shipping

Since internal groups are created at individual laboratories, only that
laboratory has the group available. If you want to ship specimens in an
internal group to another laboratory, there are a few options:

• The group from the sending laboratory can be mapped to an existing group
at the receiving laboratory

• A new group can be created at the receiving laboratory

The receiving laboratory will automatically be prompted to do one of these
when the shipping file is imported.
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This distinction between internal and government groups prevents the two
from be added to the same shipping file in LDMS.

Backups
When bad things happen, a recent backup can be the difference between
simply copying a few files to re-entering hundreds of specimens. This is not
an overstatement. Every year, inevitably, several laboratories experience a
hardware failure and their most recent backup stored off of the computer is
outdated.

To help avoid this painful scenario, LDMS automatically creates a backup of
your database once per day. By default, these backups are generated every
day at noon and placed in C:\fstrf\backup. Since this backup is stored
locally on the same computer as LDMS, you'll need to copy it to another
location. If you want to change the time that auto backups are created,
contact LDMS User Support for assistance.

LDMS backup filename format

[LabID]_[year][month][day].BK

Important:

LDMS only keeps its automatic backups files in C:\fstrf\backup
for seven days. After that, the oldest backups will be deleted to help
conserve hard drive space.

Frontier Science strongly recommends that laboratories copy the latest
backup file in C:\fstrf\backup to a safe location at least once each week. It
is a good idea to keep backups on removable media, such as a tape or CD-
RW, since backups that are on the same computer as LDMS will not be helpful
if you experience a computer failure.

In addition to back-up files that are automatically generated every day at
noon, it is possible to manually generate a new backup file. This is useful if
you performed a significant amount of work in LDMS in the afternoon and
want to ensure that you have a backup file for that work.

Manually generating a backup file:

1. Click Administration > Backup Tracking from the LDMS menu bar.
2. Click the Create backup button in the upper-right corner.

A Windows command prompt window will open. This is the backup tool in
LDMS.

3. Wait until the backup tool finishes creating the backup.

The backup file will appear in the same location as backup files automatically
generated by LDMS.

Verifying the integrity of a backup file:

1. Make a copy of the backup file
2. Open the backup file with a ZIP archive program.
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If you want to open the backup file using Windows, change the file
extension of the backup file from .BK to .ZIP. This will allow you to open it
using Windows Explorer.

3. Open the backup log file.

The log file will have the same names as the backup file, with the
file extension .export added. For example, if you open a backup
file named 999_20140418120001.bk, the log file in it will be named
999_20140418120001.dmp.export.

4. Look at the last line of the log file.

If the last line reads as follows, the backup was successful:
Job successfully completed at [time backup ran]

If the log file ends with anything else, the backup was a failure and should
not be saved.

Important:

Do not retain the copy of the backup file that you opened. If the backup
is confirmed to be complete, save the original instead.

LDMS has a mechanism for manually tracking when you have copied a backup
file to a safe location, and will show a list of automatic backups.

Using the Backup Tracking tool:

1. After copying the most recent backup file from C:\fstrf\backup, click
Administration > Backup Tracking from the LDMS menu bar.

2. Enter the date that the backup was created by LDMS into the Backup
Date field.

3. Enter the initials of the person who copied the backup into the Tech
Initials field.

4. Enter how you copied the database backup into the Method field. This
might be an external filesystem location, removable media, etc.

5. Enter any additional information into the Comment field. This could be
used, for example, if your laboratory has a system for uniquely identifying
backups.

6. Click the    button from the LDMS toolbar.

Exports and Updates
Data you collect and enter into LDMS at your laboratory exists only in your
laboratory's database. It is not automatically transferred, sent to anyone,
or synchronized with other laboratories. For many research groups, Frontier
Science performs data management services and maintains a central
database of specimen information for the group. The process of sending this
centrally managed data from your laboratory to Frontier Science is called
exporting.
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Exporting does not back up your local LDMS database. Only a portion of your
laboratory's data is sent through an export; it is not possible to reconstruct
your laboratory's database using exported data.

When your laboratory performs an export, LDMS will check to see if there are
any minor updates (called deploys) available. If there are updates, LDMS will
automatically download and install them. These updates include changes to
laboratory contact information, new preloads, specimen code updates, etc.

Note:

The types of updates that LDMS can download automatically are small,
incremental changes. LDMS will not download or install major LDMS
upgrades (in other words, if you are running LDMS 11.0, you will not
automatically be upgraded to LDMS 11.1 after exporting). Larger
LDMS updates that require you to download and run an installer are
announced by Frontier Science when they are released.

Exporting data to Frontier Science

Exporting data to Frontier Science and downloading LDMS updates

1. Click Tasks > Export from the LDMS menu bar or click the    button
from the LDMS toolbar.

2. Click the    button. A series of messages will appear as the export is
created and then transferred.

There may be occasions when you cannot perform an export as intended.
For example, if your laboratory is located in a region with sporadic Internet
connectivity, it may be difficult to reliably perform an export. While it is not
optimal, it is possible to manually create and send exportable data to Frontier
Science. Before attempting to do this, you should contact LDMS User Support
as they will need to be involved in several steps.

Manually exporting data to Frontier Science

1. Click Tasks > Export from the LDMS menu bar or click the    button
from the LDMS toolbar.

2. Generate an export file by clicking the    button. If there is already an
existing file in the Files to Transfer list, skip this step.
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3. Select the export from the Files to Transfer section, and then click
the    button. You will be prompted to save the export file to your
computer.

4. Contact LDMS User support. They will work with you to determine the
most convenient method for transferring the export file to Frontier
Science.

5. After the export file has been acquired by LDMS User Support, LDMS
User Support will provide you with a password. With the export tool
open, select the file that was transferred manually and click the Mark
button. You will be prompted to enter the password supplied by LDMS User
Support. The manual export is now complete.

If you perform a manual export, keep in mind that you will not have received
any deploy updates. It is possible for LDMS Use Support to manually provide
these updates for you. For more information, contact LDMS User Support.

What is and is not Exported

Exporting is the only process in LDMS where data is transmitted between
Frontier Science and a laboratory. This isn't just a process for sending data
to Frontier Science, but also the easiest way for your laboratory will receive
important incremental LDMS updates. For this reason, it's important for
every laboratory to perform regular exports, even if Frontier Science is not
managing your data.

You might be wondering what data is sent when you export. The following
information is exported to Frontier Science from all laboratories:

• All specimen and assay data for the following groups: ANON, ACTG/
IMPAACT, VQA, AIEDRP, HPTN, VTN, ATN, CPQA, CHAVI, VIP, PHACS, MTN,
IPREX, WITSRepos, IRC, SHIMS, AERAS, FACTS, CONTROL, CIPRA, RPID.

• Reagent information
• Oracle database usage statistics (e.g. database size, number of records)
• LDMS user account information, such as names and initials

The following information is not exported:

• LDMS user passwords
• Data for groups not listed above
• Data for internal groups that you created at your laboratory
• Data and information stored on your computer not related to LDMS.

You can identify if an individual specimen will be exported in Specimen
Management   . Any primary or aliquot with the Details code E will be
exported.

Activity Log
LDMS keeps an activity log while the user is working. This log is displayed for
the current session only, and once LDMS is closed, it is no longer accessible to
users. This information is always displayed at the bottom of LDMS, organized
by the type of activity.
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Shows all activities

Show only error messages (sometimes referred to as
"hard warnings")

Show only warning messages (sometimes referred to as
"soft warnings")

Show only informational messages

It is possible to extract and save this information from the current session.

1. Select the type of logs you want to save by clicking the appropriate tab to
the left. I you want all logs, select the  tab.

2. Right-click anywhere in the log window, then select Export As >
[Format], where [Format] is the file format to save the logs as.

3. Follow the prompts on your screen to save the file to your computer.

The Export As menu is actually available in many places throughout LDMS.
Because the feature is not context-sensitive (that is, it attempts to pull raw
data from LDMS and automatically format it), the output may not always be
optimal. In general, you should utilize the built-in reports and feature-specific
reports that are available throughout LDMS instead.

Recovering from an Unexpected Shutdown
While every effort has been made to test LDMS in a variety of working
conditions, it is possible that there may be unexpected behavior in the
program that could cause a problem for your laboratory. It is also possible
that an issue unrelated to LDMS may affect how LDMS runs. For example, an
unreliable Internet connection may cause a problem with how LDMS exports
data to Frontier Science. Likewise a power failure at your laboratory during a
critical moment could cause an issue with your laboratory’s database.

If LDMS shuts down unexpectedly, you will see the window shown below.
Please provide a detailed description of how you were using LDMS at the
time that it shut down unexpectedly. For example if LDMS shutdown when
you were trying to save a change to an existing specimen, providing that
information can better help LDMS User Support diagnose the issue. The more
details that you can provide about what you were doing, the more likely it will
be that Frontier Science will be able to permanently fix the issue.
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Figure 76: System Shutdown Dialog Window

The dialog window that appears if LDMS shuts down unexpectedly. Provide as many details as you can in the space

provided.

If LDMS does shutdown unexpectedly, it will lock. The next time you attempt
to start LDMS, you will be provided with the details of the shutdown and
prompted to contact LDMS User Support to obtain a challenge password.
Copy and paste the details of the shutdown and provide them to LDMS User
Support. LDMS User Support needs the details of the shutdown before they
can provide you with a password to unlock LDMS.

Important:

Never close LDMS by terminating it using the Windows Task Manager
(typically accessed by pressing  Ctrl Alt Delete ). Doing so could cause
damage to your LDMS database. If LDMS becomes unresponsive,
contact LDMS User Support for assistance instead of trying to close it
on your own.

If you have LDMS installed in a network and one of the client machines shuts
down unexpectedly, all LDMS computers on the network will be locked as well.
The unlocking process only needs to be completed on one computer to unlock
all of the LDMS machines on the network.
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Frequently asked questions

Frequently Asked Questions about LDMS

About LDMS Development and Frontier Science

Q: What is the difference between LDMS and Frontier Science?

A: LDMS is a computer program; Frontier Science is the company that created
and maintains LDMS.

Q: Can I request a change or new feature for LDMS?

A: Yes. Many features are added to LDMS specifically at the request of an
individual laboratory or group. For more information, see the section called
Getting Help.

Q: How often is LDMS Updated?

A: New versions of LDMS are released, several times each year. Small
incremental updates, however, are made available to laboratories several
times each month. These small updates (sometimes referred to as "deploy
files") are downloaded and installed during an export. For more information,
see the section called Exports and Updates.

Administrative Issues

Q: What are the minimum computer requirements for LDMS?

A: For guidance on what hardware to select for using LDMS, see the section
called Computer requirements and recommendations for LDMS.

Q: What Operating Systems does LDMS support?

A: LDMS is only compatibly with Microsoft Windows. LDMS is not compatible
with Home Editions of Windows, OS X, Linux, or other operating systems at
this time. For a list of supported versions, see the section called Computer
requirements and recommendations for LDMS.

Q: How long are LDMS licenses issued?

A: LDMS licenses are typically issued for up to one year. When the license
expires, you will be prompted by LDMS to contact LDMS User Support. The
re-licensing process will vary, depending on the research groups with which
you are affiliated.

General LDMS Usage

Q: I received a message telling me to contact LDMS User Support to unlock
LDMS. What happened?

A: LDMS is automatically locks under certain conditions. For example, if you
recently performed an upgrade or if LDMS shutdown unexpectedly, LDMS will
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lock. By calling LDMS User Support, this allows them to verify that there are
no database problems. Certain features are also locked to users and require
approval to access. For more information, see the section called LDMS and
Challenge Passwords.

Q: I locked myself out of LDMS on a weekend. How can I unlock LDMS?

A: While LDMS User Support has regular hours, they are available on-call 24-
hours a day, every day of the week (including all holidays). See the section
called Getting Help.

Q: I made a mistake—does LDMS have an undo button?

A: No. When you make a change in LDMS and save it, that change is
permanent. If you made a change to a screen but have no yet saved it, you
can sometimes clear you entries by clicking the Refresh button from the
LDMS toolbar.

Q: I'm creating a query statement or executing a search, and I see >< listed
as an operator. What does this mean?

A: The operator >< in this case means "not equal to". This is Pascal-like
syntax, and is used throughout LDMS.

Q: How can I get help on using LDMS?

A: Frontier Science offers a number of resources to LDMS users, including
trainings, video tutorials, documentation, and 24-hour user support. You can
also request See the section called Getting Help.

Specimen Management Questions

Q: What is the difference between a specimen ID and a global specimen ID?

A: While both can be used to identify a specimen, the global specimen ID will
always be unique for each aliquot. The global specimen ID will also show the
relationship between primary and aliquot, since they will share a predictable
ID number. For more information on these two identifies, see the section
called Specimen Identifiers.

Q: How can I ship a primary that hasn't been processed into aliquots?

A: You have two options: use the ambient ship feature or create a single
aliquot that is identical to the primary. For instructions on shipping primaries,
see the section called The Primary Grid.

Q: We need to correct some specimens that we've already entered into LDMS.
How do you make these types of changes?

A: It can vary. Certain groups want LDMS users to make changes for their
data one way; other groups will want it done another way. Consult with the
data center or group for specific instructions. For general instructions on how
to change specimen records in LDMS, see the section called Correcting a
Specimen Entry Error.

Q: What do all those letters on the button in the Details column mean?
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A: They are codes that indicate that certain properties have been set for that
specimen row. If you click on that button, you will see a key that explains
what each code means.

Q: I have a specimen that was drawn for two different studies. How do I enter
this in LDMS?

A: This is referred to as a co-enrolled primary. In the participant grid in the
top portion of the Specimen Management screen, enter one enrollment in
each row. When you are adding your aliquots, select the appropriate study
from the group/ID field in the aliquot grid. For more information, see the
section called The Patient Grid.

Q: We have two tubes of blood drawn from a participant with the same
additive from the same visit that were collected at the same time, and both
tubes were collected at the same time. Since they are essentially identical,
can we pool them together in LDMS?

A: Yes. For example, if you have two blood primaries with the same additive,
and both tubes are 10 mL, you can enter one primary with a volume of 20
mL.

Shipping Questions

Q: How to I update the shipping information for our laboratory or our shipping
contacts?

A: You can request a change to your contact information by using the Submit
Contact Changes link on the Frontier Science web portal. You can use this tool
to view and update contact information for your laboratory.

Q: All of the specimens that I want to ship are in the same box, and I already
have their storage location in LDMS. Can I just ship the box?

A: Yes. In fact, many users find this to be the easiest way to setup shipments
in LDMS. For instructions, see the section called Finding Containers to Ship.

Q: I marked a storage container for shipment, but it was the wrong container.
How do I un-mark it for shipment?

A: In Storage , select the storage unit that you need to un-mark and click the
Details button. Now, click the Unship button.

Q: I shipped some specimens that were in storage at out laboratory. Those
specimens still appear in storage, even though they are no longer in our
possession. How can I remove them?

A: There is a special feature in Storage to remove these specimens. See the
section called How LDMS Storage Handles Shipped Specimens.

Q: What is the difference between a shipment batch and an export batch?

A: A shipping batch refers to a shipment that has been prepared in LDMS, but
you have not yet generated a shipping file to send to another laboratory. An
export batch reports to data that has been sent to Frontier Science for groups
that utilize Frontier Science as a central data management center.

Q: What does it mean when a shipment has the status received disk?
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A: A shipment with the status received disk means that the shipment was
imported from another laboratory.

Specimen Storage

Q: Our laboratory performs work for a group that requires all specimens to
have a storage location documented in LDMS. Is there an easy way to find out
what specimens were entered into LDMS using Specimen Management, but
not Storage?

A: Yes. LDMS has a built-in report for getting this information. Click button
from the LDMS toolbar, and then run the Specimens Not In Storage report
under the Storage Reports category. For more information about finding these
specimens, see the section called Locating Specimens not in Storage.

Labels and Printing

Q: Why do my labels look strange when I create them?

A: LDMS pulls information about paper size directly from the printer's driver
when generating the preview of the labels. Since the preview is pulled directly
from the printer, the preview should look just like the actual results when
you print them. However, if you don't tell LDMS what printer you are using, it
will generate labels for the wrong printer. See the section called Setting the
Printer Used to Generate Labels and Reports.

Q: Is it possible to print labels in bulk instead of individually (e.g. printing
labels for all of the specimens for a particular shipment)?

A: Yes. Use the Labels feature. For instructions, see the section called
Advanced Label Printing.

Assaying Specimens

Q: I've already setup an assay in LDMS to read the output file, but now I see
that I missed a specimen when setting it up in LDMS. How do I add another
specimen so that LDMS will read the output file correctly?

A: Open the assay run, just as you would to run it. Once you have clicked the
Select Assay button, change back to the Assay Selection tab. Now, search
for the specimens that you need to add. Once this is done, click the Add to
Run button and continue to read the assay as normal.

Q: How do I set up the blinded controls on a DNA assay?

A: In Assays, on the Preview tab, right-click on the control and select Modify
Control. For more information see the section called Roche HIV DNA PCR.

Q: How do I add a VQA200 control to an RNA assay run?

A: For instructions on how to do this, see the section called Abbott Realtime
and COBAS TaqMan.

Q: When I click the Run Now  button to run an assay, I receive the following
message: "Please define a default device for each assay." What does this
message mean?
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A: This message will appear if no assay reader device has been associated
with the assay. Without this information, LDMS doesn't know where and
how to read your assay. Every assay that reads an input file must have an
associated device. For instructions on associating an assay with a device, see
the section called Associating an Assay with a Reader.

Q: I'm trying to add a specimen to an assay run. I know that I entered the
specimen in LDMS Specimen Management but I don't see it in LDMS Assays .
Why can't I find it?

A: To add a specimen to an assay run, you must assign it the assay first;
simply adding the specimen to LDMS is not enough. For instructions on
assigning assays, see the section called Assigning Assays to Aliquots.

Q: Our laboratory is having trouble adding results for a specific assay to
LDMS. What can we do?

A: LDMS User Support or the LDMS Training Team can assist you with specific
assays. See the section called Getting Help.

System Configuration

Q: When configuring users, what does System Administrator Capabilities give
a user?

A: It allows the user to reset and change passwords for other users, lock out
users, delete users, and designate other administrators. Your laboratory must
have at least one user with these capabilities. See the section called Adjusting
User Permissions.

Codes, units, and abbreviations
This section lists the codes, units and abbreviations that are used in LDMS for
various entry fields, such as visits and specimen types. These codes are used
by both LDMS and LDMS for Windows.

Specimen type codes
These are the codes use for primary, additive, and derivative types.

Primary codes
This section lists all of the available primary codes in LDMS

Code Description

ADG Adrenal Glands

ADP Adipose

AHR Non-Occipital scalp hair

AMN Amniotic Fluid
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Code Description

ANL Anal

AOR Aorta

APP Air Pollution Particles

ARB Rectal Biopsy by Anoscopy

ARL Breast Areola

ART Arterial Blood Draw

ASC Ascending Colon

BAL Bronchoalveolar Lavage

BHR Hair, Body

BLA Bladder

BLC Blood Clots

BLD Blood (Whole - Venous)

BMA Bone Marrow Aspirate

BMC Bone Marrow Core Biopsy

BMK Human Milk

BML Human Milk - Left

BMR Human Milk - Right

BNE Bone

BNM Bone Marrow

BRB Bronchoscopy Brush

BRN Brain Tissue

BRS Breast Tissue

BSG Basal Ganglia

BUC Buccal

BUG bulbourethral glands

CAT Coronary Artery

CCD Common Carotid

CDE Caudate

CER Cervix

CLL Colon (left)

CLR Colon (right)

CLS Sigmoid Colon

CRB Cerebellum

CRD Cord Blood

CRN Colorectal Neoplasm
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Code Description

CSC Cervical Secretion

CSF Cerebro-Spinal Fluid

CVB Cervical Biopsy/Aspirate

CVF Cervicovaginal Fluid

CVL Cervical Vaginal Lavage

CVM Cervical Mucous

CXC Cervical Culturette

CXS Cervical Swab

DDM Duodenum

DIA Dialysate

DMM DMEM

DPL Dried Plasma

DRG Dorsal Root Ganglia

DSC Descending Colon

DTC Distal Colon

DWB Dried Whole Blood

DWM Deep White Matter

EBC Exhaled Breath Condensate

END Endometrium

ENV Environmental

EPI Epididymus

EPS Expressed Prostatic Secretions

ESO Esophagus

EVX Endocervix

EYE Corneal Tissue

FAT Femoral Artery

FCM Frontal Cortex (motor)

FCP Frontal Cortex (pre-motor)

FGN Finger Nails

FHR Hair, Facial

FLT Fallopian Tubes

FSC Sigmoid Colon Biopsy by Flexible Sigmoidoscopy

FSI Penis Foreskin, Inner Tissue

FSK Penis Foreskin, Whole Tissue

FSO Penis Foreskin, Outer Tissue
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Code Description

FSR Rectal Biopsy by Flexible Sigmoidoscopy

FST Blood from Fingerstick (capillary)

GAS Gastric Secretions

GCF Gingival Crevicular Fluid

GLN Glans

GLS Glycerol Stock

GLU Genital Lesion/Ulcer

GMI Gastro Intestinal Mucosa

HAR Hair

HPC Hippocampus

HRT Heart

HST Blood from Heelstick (capillary)

ICD Internal Carotid

ILM Ileum

INT Intestinal Biopsy/Aspirate

INW Induction Waste

IVR Intra-vaginal Ring

IVS Intraventricular Septum

JJM Jejunum

KDY Kidney

KID Kidney Biopsy

LAL Lymph Node Axillary-left

LAR Lymph Node Axillary-right

LAT Left Atrium

LBL Large Bowel

LBT Lateral Border of the Tongue

LIL Lymph Node Inguinal-left

LIR Lymph Node Inguinal-right

LIV Liver Tissue

LNA Lymph Node (aortic)

LNC Lymph Node (cervical)

LNE Pre-auricular Lymph Node

LNF Infraclavicular Lymph Node

LNG Lung

LNI Inguinal Lymph Node
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Code Description

LNK Popliteal Lymph Node

LNM Lymph Node (mediastinal)

LNO Lymph Node (other)

LNP Lymph Node (per-hilar)

LNR Para-aortic Lymph Node

LNS Supraclavicular Lymph Node

LNT Mesenteric Lymph Node

LNX Lymph Node (axillary)

LPK Leukopak

LSG Labial Salivary Gland

LUE Lung, Excised

LUF Lung, Filter Paper

LVE Left Ventricle

LYM Lymph Node Biopsy/Aspirate

MBR Midbrain Consists of Cerebral Penduncles and Tectum

MCP Prefrontal Medial Cortex

MEC Meconium

MED Medulla

MEN Dura Mater – Meninges

MES Mesentery

MFP Placenta Membranes

MSB Main Stem Bronchus Wash

MTC Motor Cortex

NAS Nasal

NPH Nasopharyngeal

NPW Nasopharyngeal Wash

NRH Naso-oropharyngeal

NSB Nasal brush

OCC Occip Cortex

OCL Ocular

OHR Occipital scalp hair

OPW Oropharyngeal Wash

ORH Oropharyngeal

ORL Oral

OTH Other
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Code Description

OVR Ovaries

PAD Adipose (pericardial)

PAN Perianal

PCF Pericardial Fluid

PCT Perietal Cortex

PEN Penis

PFL Pleural Fluid

PFR Parotid Flow

PHR Hair, Pubic

PHX Pharynx

PLC Placental Tissue

PLM Placenta - Membrane Slice

PLN Peritrach Lymph Nodes

PLP Polyp

PLQ Plaque

PMD Plasmids

PNC Pancreas

PON Pons

PPK Plasmapak

PRC Premotor Cortex

PRO Prostate

PRT Prostate Tissue Biopsy

PTF Peritoneal Fluid

PTY Parathyroid

RAT Right Atrium

RCT Rectum

REC Rectal

RSC Rectosigmoid Colon

RVE Right Ventricle

SAD Subcutaneous Adipose

SAL Saliva

SCC Spinal Cord Cervical

SCL Spinal Cord Lumbosacral

SCR Scrotum

SCT Spinal Cord Thoracic
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Code Description

SEM Semen

SHR Hair, Scalp

SIN Sputum, Induced Non-Select

SIS Sputum, Induced Select

SKN Skin

SLU Skin Lesion

SMD Skeletal Muscle (distal)

SMP Skeletal Muscle (proximal)

SMV Seminal Vesicle

SPI Sputum, Induced

SPL Spleen

SPS Sputum, Spontaneous

SPT Sputum

SSN Sputum, Spontaneous Non-Select

SSS Sputum, Spontaneous Select

STL Stool

STM Stomach

SVG Salivary Glands

TBD Specimen type to be defined

TCA Tracheal Aspirate

TCX Temporal Cortex

TER Tears

THD Thoracic Duct

THL Thalamus

THR Throat Swab

THW Throat Wash

THY Thymus

TIL Terminal Ileum

TNA Toe Nails

TNG Tongue

TON Tonsillar Biopsy/Aspirate

TRN Transverse

TST Testes

TTH Tooth

TUM Tumor
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Code Description

TVC Transverse colon

TYD Thyroid

UMB Placenta - Cord Slice

UNK Unknown Primary

URN Urine

UTH Urethra

UTS Uterus

VAG Vaginal Swab

VCS Cervicovaginal Secretions

VGL Vaginal

VGN Vagina

VSC Vaginal Secretions

VUL Vulva

WAR Warts

Additive codes
This section lists all of the additive codes available in LDMS.

Code Description

ACD Acid Citrate Dextrose

AG1 ESAT 6-free cocktail 1

AG2 ESAT 6-free Cherry pick

AHP Ammonium Heparin

APT Allprotect

ATM Abbott Transport Medium

BBL CultureSwab Kit

BFM Bacterial Freezing Media

BOR Boric Acid

BSA Bovine Serum Albumin

BTM Biopsy Transport Media

CPD Citrate Phosphate Dextrose

CPH Cell Preparation Tube Heparin

CPS Cell Preparation Tube SCI

CTK Culture Transport Kit

DFA Desferoxamine

DHP Double dosage of Heparin

DPE Spray Dried EDTA
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Code Description

DSE Spray Dried Sodium EDTA

EDT EDTA

ELB elution buffer

END Endometrial Tissue

ETH Ethanol

FFN Fetal Fibronectin Buffer

FFP Formalin-Fixed, Paraffin Embedded

FMD Formaldehyde

FOR Formalin

GEN GenAptima Media

GIT Guanidine Isothiocyanate (GITC)

GLT Glutaraldehyde

GRB Guanidine Reduction Buffer

H2O Water

HEP Heparin

HPV Human Papilloma Virus

HVS High Virginial Swab

ISO Isohelix kit

IST Internal Standard

LHG Lithium Heparin and Gel for Plasma

LHP Lithium Heparin

LIN LoBind tube lined with 5% BSA

LOB LoBind Tube

LPE Liquid Potassium EDTA

LSE Liquid Sodium EDTA

LYB Lysis Buffer

MBK Microbank tube

MPA Metaphosphoric Acid

MSA Mannitol Salt Agar

NOH Sodium Hydroxide

NON None

NOR Normasol

NSL Normal Saline

NUC NUNC Tube

OCT Optimum Cutting Temperature Medium
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Code Description

OMN Omnigen Collection Tube

ORA OraSure Collection Container

ORG Oragene Collection Container

OTH Other

PAC Port-a-cul Transport Tube

PAX PAXgene Blood RNA tube

PBS Phosphate Buffered Saline

PCT PreservCyt: ThinPrep collection media

PED Potassium EDTA

PFM Paraformaldahyde

PI1 S8820 Sigma SIGMAFAST? Protease Inhibitor Tablets

PIA Pseudomonas Isolation Agar

PLP PLP Fixative

PPT Plasma Preparation Tube

PRO ProbeTec Media

PXD Paxgene tube DNA Extraction

QAG QFT-TB Ag Red Cap

QMT QFT-Mitogen Purple Cap

QNL QFT-Nil Grey Cap

QTF QuantiFERON-TB Gold Assay

QTG QFT-TB1 Ag Green Cap

QTY QFT-TB2 Ag Yellow Cap

RBE Royal blue - EDTA

RBN Royal blue - no anticoagulant

RLS Ringer's Lactate Solution

RNL RNALater

RNP RNAprotect

ROC Roche Media

RPM RPMI 1640 Medium

SBC Sodium Bicarbonate

SCC Steck Cyto-Chex tubes - stabilized

SCI Sodium Citrate

SED Sodium EDTA

SFE Sodium Fluoride/Na2EDTA

SFL Sodium Fluoride

Frontier Science Foundation 259



LS.0005 | LDMS for Windows - User Manual

Code Description

SIA Sulfite Iron Agar

SKM Skim Milk

SNP Snap/Flash Freeze

SPH Sucrose Phosphate

SPO Sodium Fluoride/Potassium Oxalate

SPS Sodium Polyanetholesulfonate

SST Serum Separator

STG Skim milk-Tryptone-Glucose-Glycerin Medium (STGG)

TAL Blood Bag Tail

TBD Specimen type to be defined

TBS Tris-Buffered Saline

TCD tween chlorhexidine digluconate

TEM Tempus Tube

TFM Tissue Freezing Medium

TFX Tissue Fix

THM Thrombin

TMS Transport Medium-Stuarts

TRC TruCulture Tube

TVT TransFix Vacuum Blood Collection Tube

UNK Unknown Additive

URM Urine Transport Media

UTM Universal Transport Media

VTM Viral Transport Media

ZRD Zymo RNA/DNA shield

Derivative codes
This section lists the derivative codes available in LDMS.

Code Description

A4N Activated CD4+ without Tregs

AD4 Activated CD4

AD8 Activated CD8 Derivative

ADG Adrenal Glands

ADL Adipose Tissue Layer

ADP Adipose (abdominal)

AHR Non-Occipital scalp hair

AMN Amniotic Fluid
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Code Description

AOR Aorta

APL Applicator Tip

ASP Aspirate

BAC Bacterial Isolate

BAL Bronchoalveolar Lavage

BCL B-cell Lymphoblastoid Cell Line

BHR Hair, Body

BLA Bladder

BLC Blood Clots

BLD Blood (Whole - Venous)

BLK Tissue Block

BMA Bone Marrow Aspirate

BMC Bone Marrow Core Biopsy

BMK Human Milk

BML Human Milk - Left

BMR Human Milk - Right

BMS Human Milk - Spun

BMW Human Milk - Whole

BNM Bone Marrow

BPS Biopsy

BRN Brain Tissue

BRS Breast Tissue

BSG Basal Ganglia

BUC Buccal

BUF Unficolled Cryopreserved Buffy Coat, Viable

BUG Bulbourethral Glands

CAN Candida

CCC Cryopreserved Cells from a Culture, Viable

CD4 CD4 Positive T-Cells

CD8 CD8 cells

CDE Caudate

CDN Copy DNA

CDP Dry Pellet from a Culture, Non Viable

CEL PBMC Cells, Viable

CEN Fresh Cells from a Non-Blood Spec. Type
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Code Description

CER Cervix

CGN Cells in GITC

CIO Cells in Other (Solution), Non-Viable

CLI Cell Lines

CLL Colon (left)

CLN Cryopreserved primary cells from Non-Blood Spec Type, Viable

CLR Colon (right)

CLS Sigmoid Colon

CMV CytoMegaloVirus Isolate

CRB Cerebellum

CRY Generic Cryptococcus

CSF Cerebro-Spinal Fluid

CSR Serum - Chilled

CTB Cytobrush

CTC Cells from a CTL Assay

CTS Supernatant generated from a CTL Assay

CUP Cup

CVL Cervical Vaginal Lavage

CVS CVL Supernatant

CXS Cervical Swab

DBE Dried Blood Extract

DBS Dried Blood Spot

DDM Duodenum

DPE Plasma, Dried Extract

DPL Plasma, Dried

DPS Dried Plasma Spot

DSP Digested Sputum

DUR Dried Urine

DWB Dried Whole Blood

ED4 Effector Memory CD4 T-cells

END Endometrial Tissue

EPI Epididymus

EPP Endodontic Paper Point

ESO Esophagus

EYE Eye
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Code Description

FCM Frontal Cortex (motor)

FCP Frontal Cortex (pre-motor)

FGN Finger Nails

FHR Hair, Facial

FLD Fluid Portion from a Non-Blood Specimen Type

FLS Flocked Swab

FLT Fallopian Tubes

FPL Plasma, Filtered

FSI Penis Foreskin, Inner Tissue

FSO Penis Foreskin, Outer Tissue

FSR Rectal Biopsy by Flexible Sigmoidoscopy

FTP Filter Paper

GLS Glycerol Stock

GMI Gastro Intestinal Mucosa

GRN Granulocytes

HAR Hair

HPC Hippocampus

HRT Heart

ICK Supernatant generated from Inducible Cytokines

ILM Ileum

IPK Methanol Extract Supernatant

IPT Immunophenotyping

IVR Intra vaginal Ring

IVS Intraventricular Septum

JJM Jejunum

KDY Kidney

LAT Left Atrium

LAV Lavage

LDB Leukodepleted blood

LIV Liver Tissue

LNA Lymph Node (aortic)

LNC Lymph Node (cervical)

LNE Pre-auricular Lymph Node

LNF Infraclavicular Lymph Node

LNG Lung
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Code Description

LNI Inguinal Lymph Node

LNK Popliteal Lymph Node

LNM Lymph Node (mediastinal)

LNO Lymph Node (other)

LNP Lymph Node (per-hilar)

LNR Para-aortic Lymph Node

LNS Supraclavicular Lymph Node

LNT Mesenteric Lymph Node

LNX Lymph Node (axillary)

LPD Lipid Layer

LPK Leukopak

LVE Left Ventricle

LYM Lymph Node Biopsy/Aspirate

LYS Lysed whole blood

MBR Midbrain Consists of Cerebral Penduncles and Tectum

MCL Macrophage Cells - Viable

MCS Microbiology Culture Slant

MD4 Central Memory CD4 T-cells

MDC Myeloid Dendritic Cells

MEC Meconium

MED Medulla

MNO Monocytes

MPE Macrophage Dried Cell Pellet, Non Viable

MTB MTB Isolates

MUC Mucins

MUS Mucous

N/A Not Applicable - Same as Primary Specimen Type

NA4 Non-activated CD4

NA8 Non-activated CD8

NCL Neutrophil (PMN) - Viable cells

ND4 Naive CD4 T-cells

NKC Natural Killer Cells

NON None

NPE Neutrophil (PMN) Dried Cell Pellet, Non Viable

NPW Nasopharyngeal Wash
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Code Description

NTM Nontuberculous mycobacteria

NXD Non-extracted DNA

OCC Occipital Cortex

OHR Occipital scalp hair

OPC Ova & Parasite Concentrate

OTH Other

OVR Ovaries

PAD Adipose (pericardial)

PCC Culture Supernatant and Cells

PCF Pericardial Fluid

PCT Parietal Cortex

PDC Plasmacytoid Dendritic Cells

PED Dried Pellet - Digene

PEL Non-viable PBMC s

PEN Non-viable cells from non-blood specimen type

PEO Wet Pellet Prep - Organon Teknika

PER Dried Pellet - Roche

PFR Parotid Flow

PHR Hair, Pubic

PL* Plasma, All

PL1 Plasma, Single-Spun

PL2 Plasma, Double-Spun

PLA Plasma, Unspecified/Other

PLC Placental Tissue

PLH Plasma High Spin

PLM Placenta - Membrane Slice

PLP Supernatant & Cells from a Quantitative Culture

PLQ Plaque

PLT Placenta - Placenta Slice

PMD Plasmids

PMN polymorphnuclear leukocytes

PON Pons

PNC Pancreas

PPK Plasmapak

PPS Periopaper Strip
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Code Description

PRO Prostate

PTF Peritoneal Fluid

PTY Parathyroid

RAT Right Atrium

RBC Red Blood Cells

RCT Rectum

RD4 Resting CD4 T-cells

REC Rectal

RVE Right Ventricle

SAL Saliva

SCC Spinal Cord Cervical

SCL Spinal Cord Lumbosacral

SCP Scraping

SCT Spinal Cord Thoracic

SDI Supernatant Dermis, Inner

SDO Supernatant Dermis, Outer

SEC Secretions

SEI Supernatant Epidermis, Inner

SEM Semen

SEO Supernatant Epidermis, Outer

SER Serum

SHR Hair, Scalp

SKN Skin

SLD Slide from a primary sample

SMD Skeletal Muscle (distal)

SMP Skeletal Muscle (proximal)

SMR Smear

SMV Seminal Vesicle

SNO SNO - Strip

SPG Sponge

SPI Unfractioned Sputum, Induced

SPL Spleen

SPQ Supernatant from a Quantitative Culture

SPT Unfractioned Sputum

SRH Serum - High Speed Spun
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Code Description

STK Quantitative Culture Held beyond 14 Days

STL Stool

STM Stomach

STP Sterile Tooth Pick

SUP Culture Supernatant

SVG salivary glands

SWB Swab

SWS Stimulated Whole Saliva

TBD Specimen type to be defined

TCX Temporal Cortex

TD4 Transitional Memory CD4 T-cells

TFS Tear-Flo Strips

THL Thalamus

THW Throat Wash

THY Thymus

TIS Tissue

TNA Toe Nails

TON Tonsillar Biopsy/Aspirate

TR4 T regs CD4+

TRC Trucount

TRN Transverse

TST Testes

TTH Tooth

TUM Tumor

TYD Thyroid

UMB Placenta - Cord Slice

UNK Unknown Derivative

URN Urine

UTS Uterus

UWS Unstimulated Whole Saliva

VAG Vaginal

VCP Vaginal Cup

VGN Vagina

VTM Viral Transport Media

W/D Wet/Dry
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Code Description

WBP Whole Blood Pellet, Specify Methodology

WEK Wick/Wek Cell Sponge

WFC Unstimulated whole blood cell, lysed , fixed, frozen (with DMSO) for flow

WFS Stimulated whole blood cells, lysed, fixed, frozen (with DMSO) for flow

WPK Whole Blood Packed

XDA Extracted DNA

XFL Extracted Fluid from RNA RT PCR for Sequencing

XPA Extracted RNA

XPD Extracted Pellet from DNA PCR for Sequencing

XPR Extracted Pellet from RNA RT PCR for Sequencing

XTN Extracted total nucleic acid

Sub additive/derivative codes
This section lists the sub additive/derivative codes available in LDMS.

Code Description

01C 1 o'clock biopsy position

02C 2 o'clock biopsy position

03C 3 o'clock biopsy position

04C 4 o'clock biopsy position

05C 5 o'clock biopsy position

06C 6 o'clock biopsy position

07C 7 o'clock biopsy position

08C 8 o'clock biopsy position

09C 9 o'clock biopsy position

10C 10 o'clock biopsy position

11C 11 o'clock biopsy position

12C 12 o'clock biopsy position

14D Tooth #14 Distal Buccal

14M Tooth #14 Mesial Buccal

19D Tooth #19 Distal Buccal

19M Tooth #19 Mesial Buccal

24M Tooth #24 Mesial Buccal

25D Tooth #25 Distal Buccal

30D Tooth #30 Distal Buccal

30M Tooth #30Mesial Buccal
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Code Description

3DB Tooth #3 Distal Buccal

3MB Tooth #3 Mesial Buccal

562 K562 Cell Line

8MB Tooth #8 Mesial Buccal

9DB Tooth #9 Distal Buccal

ACD Acid Citrate Dextrose

ADA Adenosine Deaminase

ADJ Adjuvant

AEB Qiagen AE Buffer

AFS Alsever's Freezing Solution

AG1 ESAT 6-free cocktail 1

AG2 ESAT 6-free Cherry pick

AMB Amber Vial

ANT Antigen

APR Aprotinin

ASC Ascorbate (Vit C)

ATC Animal Tumor Cell Line

ATG TB Antigen

AUO Auramine O

AVE Qiagen Buffer AVE

BCG Bacille Calmette-Guï¿½rin

BCL B-cell Lymphoblastoid Cell Line

BFM Bacterial Freezing Media

BHT Butylated hydroxytoluene

BLK Tissue Block

BML Breast - Left

BMR Breast - Right

BSA Bovine Serum Albumin

BSS Blood Stabilizing Solution

BTM Biopsy Transfer Media

CAN Candida (CASTA)

CBS Cellbanker Solution

CCM CareHPV Collection Medium

CD4 CD4 cells

CD8 CD8 cells
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Code Description

CDN cDNA

CFM Cell Freezing Media

CME Culture Media

CMV CytoMegaloVirus

CON Control

CSC Cervical secretions

CSP Cytospin Slides

CVA Complete Vaccine

CYT Cytokines

DCF 2 - deoxycoformycin.

DEA DEACTIVATED

DMS DMSO used in cryopreservation solution (CPS)

DOD Day of Donation

DOT Day of Tail

DPH Wyeth Ayerst Diphtheria Antigen

DPL Depleted Cell Populations

DTM Digene/Qiagen Specimen Transport Medium

DTT Dithiothreitol

EDT EDTA

ETH Ethanol

FBS Fetal Bovine Serum

FMA Formic Acid

FMD Formaldehyde

FOR Formalin

FPR Filter Paper

FRS First Spin

FRZ Frozen

FUN Fungal Broth

GAG HIV GAG envelope peptide

GIT Guanidine Isothiocyanate (GITC)

GLM Glycerol Media

GLT Glutaraldehyde

GLY 20% Glycerol

GMS Giemsa Staining

GRS Gram Stain
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Code Description

H&E Hematoxylin and Eosin stain

H2O Water

HBS Hank's Balanced Salt Solution

HCl Hydrochloric Acid

HPA Hep A

HPS Human Pappilloma Virus Serology

HPV Human Pappilloma Virus

HTC Human Tumor Cell Line

I18 IL-18

I1b IL-1b

IAP Iodoacetic Acid/Phenanthrolene

IgG Immunoglobulin G

IL2 IL-2, Interleukin 2

IL6 Interleukin6

ILA IL-12/IL-15, Interleukin-12/Interleukin-15

INK India Ink

IPD PBMCs for Intact Proviral DNA testing

LAA L-ascorbic Acid

LES Lesion

LFT Left

LPS Lipopolysaccaride

LSM Lymphocyte Separation Media

LVT L-var Target

LYB Lysis Buffer

M2V M2VP

MA1 MAC 101

MAC MAC Antigen

MAF MAC LR114F Culture Filtrate

MAS M. Avium Sensitin

MCH Mechanical Homogenization

MDB Middlebrook broth

MET Methanol

MFS Malaria Freezing Solution

MIF Merthoilate Formalin/Merthiolate-Iodine Formalin (MF/MIF)

MIT Quantiferon Gold and/or Quantiferon Gold Plus Mitogen tube
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Code Description

MPP For a mega peptide pool

MRN Messenger RNA

MT2 MT2 Cell Line

MTV For an MTB vaccine

MUC Mucins

N/A Not Applicable

NAS Nucleic Acid Stabilization Solution

NAT Sodium thioglycolate

NCL N-acetyl-L-cysteine

NDN NDVNS1, Newcastle disease virus with NS1 influenza protein

NDV NDVB1, Newcastle disease virus wild type

NDW Newcastle disease virus with W influenza protein

NIL Quantiferon Gold and/or Quantiferon Gold Plus Nil tube

NKC Natural Killer cells

NOH Sodium Hydroxide

NON None

NPI Neuropepsidase Inhibitor

NSK New Skin Lesion

NSL Normal Saline

NUC Nucleotides

OCT Optimum Cutting Temperature Medium

OKT OKT3 Treated

ORI Oricol

OTH Other

P24 P24

PAE Pseudomonas aeruginosa

PAR Parrafin

PBS Phosphate Buffered Saline

PCS PreserveCytSolution

PEI Pre-Infusion

PFM Paraformaldahyde

PHA PHA-Treated

PI1 S8820 Sigma SIGMAFAST Protease Inhibitor Tablets

PIC Protease Inhibitor Cocktail

PLC Placenta Tissue
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Code Description

PLD Plasma, Depleted

PLM Placenta Membrance

PMI Phorbol Myristate Acetate-Ionomycin

PPA Phosphoric Acid

PRS Protamine Sulfate

PTI Post-Infusion

PTK Proteinase-K

PTY Parathyroid

PVA Polyvinyl alcohol

PWM Pokeweed Mitogen

QAG QFT-TB Ag Red Cap

QMT QFT-Mitogen Purple Cap

QNL QFT-Nil Grey Cap

QTG QFT-TB1 Ag Green Cap

QTY QFT-TB2 Ag Yellow Cap

RDS RNA/DNA shield

RFW RNAse free water

RGT Right

RLT Buffer RLT Plus

RNL RNAlater

RNP RNA Protect

RPM RPMI 1640 Medium

RTB Reverse Transcriptase buffer

S52 Sendai 52 virus with defective infectious particules

SAU Staph aureus

SBC Sodium Bicarbonate

SCB Sodium Carbonate

SDS Second Spin

SEB Sigma Staphylococcus Enterotoxin B

SLD Slide from a primary sample

SNP Snap/Flash Freeze

SPG Sponge

SPN Streptococcus pneumoniae

SPS SMART TUBE INC Proteomic Stabilizer

STG Skim milk-Tryptone-Glucose-Glycerin Medium (STGG)
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STM Stimulated by Multiple Antigens

SUB Sub Gingival Plaque

SUG Supragingival Plaque

SUP Cultural Supernatant

TB4 Quantiferon Gold and/or Quantiferon Gold Plus CD4 tube

TB8 Quantiferon Gold Plus (only) CD8 tube

TBD Specimen type to be defined

TBS Tris-Buffered Saline

TCA 1% Thimersol/ 6.6% EACA (Epsilon Amino Caproic Acid)

TCL T-cell Lymphoblastoid Cell Line

TCM Trichrome stain

TEB Tris-EDTA Buffer

TEM Tempus Tube

TFM Tissue Freezing Medium

TMD Myeloid dendritic cell non infected and treated with TSST

TMS Transport Medium-Stuarts

TND Myeloid dendritic cell infected with NDVW and treated with TSST

TNN TSST with NDVNS1

TNV TSST with NDVB1

TOC Tocopherol (Vit E)

TPB Trypan Blue

TRI TriReagent

TRX Triton X

TRZ Trizol

TSC Myeloid dendritic cell infect w/ Sendai Cantell & treat w/ TSST

TSS TSST, Toxic-Shock Syndrome Toxin

TTX Tetanus Toxoid treated

UCT Urine cartridge

ULQ Upper Left Quadrant

UMB Placenta cord slice

UNK Unknown Sub A/D

UNT Untreated / Unstimulated

URE Urea

URQ Upper Right Quadrant

VCS Cervicovaginal Secretions
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VIB Veal Infusion Broth

VIR Virus

VPS VP Stimulator

VPT VP Target

VTM Viral Transport Media

ZLN Ziehl Neelsen

Condition codes
This section lists the specimen condition codes available in LDMS.

Code Description

ANM Sample Anonymized

ANP Aliquot not prepared

BKV Broken or cracked vial

BLD Bloody

CDT Consumed During Testing

CLT Clotted

CMB Combined Aliquots

COC Combination of Conditions (Explain)

CTM Contaminated

DCF Data Clarification Form

DCG Discharge present

DFB Difficult Bleed

DIM Dry Ice Melted

DMG Damaged container

DSH Delayed Shipment

DSR Destroyed

EQF Equipment Failure

EXP Expired

FRO Frozen

HEM Hemolyzed

HUM Exposed to high humidity

ICT Icteric (Excess Bilirubin)

INT Incorrect Tube

INV Invalid Specimen

LBE Lab Error
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LIP Lipemic

LKD Leaked

LLT Local Lab Testing

LSH Lost Shipment

LYS Lysed

NOT No Test Performed

NQA RT QA for viability and recovery NOT done due to low volume

NST Did Not Consent to Storage

OPR Sample drawn outside protocol requirements

OSW Specimen drawn outside of protocol-defined visit window

OTH Other (Explain)

PST Processed after Specified Time

QNS Quantity Not Sufficient

REF Refrigerated

RLB Re-labeled

SAT Satisfactory

SHV Short volume

SNC Sample not collected

SNP Specimen not processed

SNR Sample Not Received,CRF Received

TNO Shipping/storage temperature not optimal/warmed

TRM Testing Remnant

TWD Thawed

UNK Unknown condition

VPL Viability percent may be less than the expected parameter

VRU Viable recovery may be outside expected parameters (higher or lower)

YST Did Consent to Storage
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Unit codes
Unit codes, such as visits, measurements, and time units.

Measurement codes
This section lists the measurement codes available for specimen units
available in LDMS.

Code Description

CEL CEL Cells

CM CM Centimeters

CRD Cards

CTN CTN Container

EA EA Each

GR GR Grams

MG MG Milligrams

ML ML Milliliters

MM MM Millimeter

N/A N/A Not Applicable

PG PG Picograms

pg/10^6
cells

picogram per 10^6 cells

UG UG Micrograms

UL UL Microliters

UNK UNK Unknown Units

Time unit codes
This section lists the time unit codes available in LDMS.

Code Description

Day Day

Fst Fasting

Hrs Hours

Min Minutes

Mo Months

MRN Morning

Nft Non-Fasting

Pol Pooled

Prd Predialyzer

PRI Pre-Infusion
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Pre Pre-Dose

Psd Postdialyzer

Pst Post-Fasting

PTC Post-Challenge

PTI Post-Infusion

PTV Post-Vaccination

Ran Random

RPD Random Post-Dose

Sec Seconds

SRL Serial

Tr Trough

UNK Unknown time unit

Visit codes
This section lists the visit unit codes available in LDMS.

Code Description

-2 -2

A A

Aut Autopsy

B B

B/L Baseline

Bth Birth

Cb Cord Blood

CFM Post Study Confirmation Test

CFU Core Follow Up

Ch Challenge

CRW Crosswalk

DAV Dose Adjustment Visit

Day Days

DEL Delivery

DVL DBS Viral Load

EDV Event Driven Visit

EID Early Infant Diagnosis

EIT End of Intensive Treatment

Ent Entry/Baseline

EOR End of Study & redraw
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Eos End-Of-Study

EOT End of Treatment

EOX Evaluation of Seroreactivity and Recent Exposure

EPH Extension Phase

EWD Early Withdrawal

Exp Recent Exposure

Ext Exit/Discontinuation

FCF Failure Confirmation

FUP Follow-up Test

Gel On study without gel

Inf Infected Participant Testing

IOT Initiation of Treatment

LSF Long-term Safety and Followup

L&D Labor & Delivery

Mo Months

NDL New Delivery

NON Not Pregnant

NPG New Pregnancy

OFP Off PrEP

OMB Oral MB

ONP On PrEP

PDT Product Discontinuation

PE Pre-entry

PFT PFT

PK PK

POR Post study & redraw

Pos Post-Study

POX Post study & possible recent exposure

PPt Post Partum

Prf Proficiency

PRG Pregnancy

Pri Pre-Infusion

Pst Post-Infusion

PTD Premature Treatment Discontinuation

PVL Plasma Viral Load
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Qul Qualification

Rdw Redraw

RRV Retrospective

RWK R+ Week

SC Seroconversion

SCK Sick

Scr Screening

SD Study Day

SHR Short

SP Sero Positive

Sps Special Studies

SRV Post Study Service Test

TRI Trimester

UnK Unknown

Uns Unscheduled

V V

Vst Visit

Wk Weeks

Yr Years

Assay Codes
Codes used for assays, such as system and user censors.

Reasons for not running an assay censor codes
This section lists the censor codes that can be used on an assigned test when
the test will not be performed.

Code Description Numeric Value

COR COR Controls Out of Range 10431

CTM Contaminated 10430

EQF Equipment Failure 10432

LBA Laboratory Accident 10434

LBE Lab Error 10433

MSW Missing Well 10435

NPA Sample Drawn Without Participant Adherence to
Regimen

10440

OUT Resulted outside LDMS 10439
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Code Description Numeric Value

PSW Sample not Drawn Within Protocol Specified Window 10441

QNS Quantity Not Sufficient 10436

STO Specimen too old to run on test 10442

WCT Wrong Controls 10437

Immunology assay codes
Codes for immunology assays.

Reasons why results were not obtained for immunology assays
This section lists the censor codes that can be applied to immunology assays
tests when a result was not obtained.

Code Description Numeric Value

A Wrong Anticoagulant 65804

C Contamination 65800

E Tech Error/Lab Error 65801

K Kit/Reagent Problem 65806

P Results Reported Under A Different Protocol 65807

S Quantity Not Sufficient 65802

U Unsatisfactory Sample 65803

V Poor Viability 65805

Immunology user censor codes
This section lists the immunology assay user censor codes available in LDMS.

Code Description Numeric Value

C Contamination 10,000.000000

E Tech error/Lab error 100.000000

K Kit/Reagent problem 100,000.000000

N Not done 1.000000

R Not required 10.000000

S Quantity not sufficient 1,000.000000

V Poor viability 1,000,000.000000

Virology assay codes
Codes for virology assays.

Virology user censor codes
This section lists the virology assay user censor codes available in LDMS.

Code Description Validity Numeric Value

B1 BOOM extraction used Valid 100
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Code Description Validity Numeric Value

C Control re-run and valid - assay is valid Valid 1,000

D Contamination Invalid 10,000

E Poor viability Invalid 1,000,000

K Kit/Reagent Problem Invalid 1

O Lab error/Lab accident Invalid 100,000,000

P Equipment failure Invalid 0.1

Q Kit QC out of range - repeat Invalid 10

R Re-detected Valid 1,000,000,000,000

V Over amplified Invalid 10,000,000

W Inhibitory/Material didn’t amplify Invalid 100,000

Z Per lab - Do not use Invalid 0.001

HIV DNA PCR (Roche Amplicor Detect)
This section lists the DNA PCR censor codes available for the Roche Amplicor
Detect assay in LDMS.

Code Description Validity Numeric Value

A 0 control not negative Invalid 1

B 10 control not positive Invalid 10

C 20 control not positive Invalid 100

D 20 control OD < 2.000 Invalid 1,000

E VQA blinded control invalid Invalid 10,000

F Previous runs invalid - assay locked Descriptive only 100,000

G Converted from RLMP - Contamination Invalid 0.010000

H Converted from RLMP - Clotted Invalid 1 × 1010

L Converted from RLMP - Missing well Invalid 0.100000

M Converted from RLMP - Out of range
controls

Invalid 1,000,000

N Converted from RLMP - Lipemia Invalid 10,000,000

O Converted from RLMP - Lab error Invalid 1 × 1012

P Converted from RLMP - Equipment failure Invalid 0.001000

Q Converted from RLMP - QNS Invalid 1 × 1013

R Re-read Valid Run 100,000,000

T Converted from RLMP - Prerequisite test
failed

Invalid 1 × 1011

U Converted from RLMP - Unable to calculate Invalid 1,000,000,000

W Converted from RLMP - Material didn’t
amplify

Invalid 1 × 1014
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Code Description Validity Numeric Value

Y Converted from RLMP - No description
available

Invalid 1 × 1015

HIV DNA PCR (Roche Amplicor Detect) 1.5
This section lists the DNA PCR 1.5 censor codes available for the Roche
Amplicor Detect assay in LDMS.

Code Description Validity Numeric Value

A 0 control not negative Invalid 1

B 10 control not positive Invalid 10

C 20 control not positive Invalid 100

D 20 control OD < 2.000 Invalid 1,000

E VQA blinded control invalid Invalid 10,000

F Previous runs invalid - assay locked Descriptive only 100,000

I Internal Control Invalid Invalid 1,000,000

R Re-read Valid Run 10,000,000

Roche Amplicor HIV Monitor (RT PCR) assay censor codes
This section lists the Roche Amplicor assay censor codes available in LDMS.

Code Description Validity Numeric Value

A QS wells below lower limit Invalid .1

B QS wells above upper limit Invalid .01

C User re-selected well for algorithm Valid .0001

D OD ratio failure - repeat Invalid/Invalid Run9 1,000,000,000

F Control out of range Invalid Run10 1,000,000

I No QS wells in range Invalid 100,000

J HIV wells below lower limit - no HIV RNA
detected

Valid11 1

K HIV wells above upper limit Invalid 10

L QS wells out of sequence Valid with C censor 100

L HIV wells out of sequence Valid with C censor .001

R Re-read Valid Run 100,000,000

U Undetectable sample above cutoff - repeat Valid12 .00001

X2 Invalid standards - slope negative Invalid Run 1,000

9 If the run is repeated, the censor will be changed to C
10 If the F censor is used in conjunction with a D or X3 censor on the same

control, it can be re-detected and corrected.
11 Specimen should be re-tested, if possible
12 Specimen should be re-tested, if possible
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Code Description Validity Numeric Value

X3 Invalid/Out of sequence control Invalid Run 10,000,000

X4 Copies greater than upper limit of
quantification - dilute and repeat

Valid 10,000

Roche Amplicor HIV-1 Monitor UltraSensitive assay censor codes
This section lists the Roche Amplicor Monitor UltraSensitive assay censor
codes available in LDMS.

Code Description Validity Numeric Value

A QS wells below lower limit Invalid .1

B QS wells above upper limit Invalid .01

C User re-selected well for algorithm Valid .0001

D OD ratio failure - repeat Invalid/Invalid
Run13

1,000,000,000

F Control out of range Invalid Run14 1,000,000

I No QS wells in range Invalid 100,000

J HIV wells below lower limit - no HIV RNA
detected

Valid15 1

K HIV wells above upper limit Invalid 10

L QS wells out of sequence Valid with C censor 100

L HIV wells out of sequence Valid with C censor .001

R Re-read Valid Run 100,000,000

U Undetectable sample above cutoff - repeat Valid16 .00001

X2 Invalid standards - slope negative Invalid Run 1,000

X3 Invalid/Out of sequence control Invalid Run 10,000,000

X4 Copies greater than upper limit of
quantification - dilute and repeat

Valid 10,000

Roche COBAS Amplicor HIV-1 MONITOR Test, UltraSensitive
This section lists the Roche COBAS Amplicor UltraSensitive assay censor codes
available in LDMS.

Code Description Validity Numeric Value

F Invalid Control Invalid 1,000,000

G Copies less than lower limit of
quantification

Valid 0.0001

13 If the run is repeated, the censor will be changed to C
14 If the F censor is used in conjunction with a D or X3 censor on the same

control, it can be re-detected and corrected.
15 Specimen should be re-tested, if possible
16 Specimen should be re-tested, if possible
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Code Description Validity Numeric Value

I No QS wells in range Invalid 100,000

J Undetectable Valid 1

K wells out of range Invalid 10

L HIV wells out of sequence Invalid 0.001

L QS wells out of sequence Invalid 100

R Re-Read

X3 Invalid/Out of sequence control

X4 Copies greater than upper limit of
quantification

Valid, but needs
repeat

10,000

Roche COBAS Amplicor HIV-1 MONITOR assay censor codes
This section lists the Roche COBAS Amplicor assay censor codes available in
LDMS.

Code Description Validity Numeric Value

F Invalid Control Invalid 1,000,000

G Copies less than lower limit of
quantification

Valid 0.0001

I No QS wells in range Invalid 100,000

J Undetectable Valid 1

K wells out of range Invalid 10

L HIV wells out of sequence Invalid 0.001

L QS wells out of sequence Invalid 100

R Re-Read

X3 Invalid/Out of sequence control

X4 Copies greater than upper limit of
quantification

Valid, but needs
repeat

10,000

Roche COBAS Ampliprep/COBAS TaqMan HIV-1 assay censor codes
This section lists the Roche COBAS Ampliprep/COBAS TaqMan HIV-1 assay
censor codes available in LDMS.

Code Description Validity Numeric Value

F Invalid control Invalid 1000000.000000

G Result less than lower limit of
quantification

Valid 0.000100

H No Result Invalid 10000000.000000

I No QS wells in range Invalid 100000.000000

J Undetectable Valid 1.000000

X4 Results greater than upper limit of
quantification

Valid, but needs
repeat

10000.000000
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COBAS TaqMan HCV assay censor codes
This section lists the COBAS TaqMan HCV assay system censor codes available
in LDMS

Code Description Validity Numeric Value

F Invalid Control Invalid 1000000

G Result less than lower limit of
quantification

Valid 0.0001

H No Result Invalid 10000000

I QS Invalid Invalid 100000

J Undetectable Valid 1

X4 Results greater than upper limit of
quantification

Valid 10000

COBAS TaqMan HIV-1 Qual assay censor codes
This section lists the COBAS TaqMan HIV-1 Qual assay system censor codes
available in LDMS.

Code Description Validity Numeric Value

A 0 control not negative Invalid 1

B 10 control not positive Invalid 10

C 20 control not positive Invalid 100

E VQA blinded control fails validation Invalid 10000

F Assay locked Na 100000

H No result Invalid 10000000000

K Invalid control Invalid 1000000

L Low positive control out of range or invalid Invalid 1E+14

N Negative control out of range or invalid Invalid 10000000

O Run based validity override Valid 1E+12

P Insufficient VQA blinded controls assigned
to rack

Invalid 1000000000

Q Insufficient VQA controls assigned to rack Invalid 1E+13

R Re-read Valid 100000000

S 5 control invalid Invalid 1E+11

Abbott Realtime HIV-1 and Abbott SARS-COV-2 Quant assay censor
codes
This section lists the Abbott Realtime HIV-1 and Abbott SARS-COV-2 assay
censor codes available in LDMS.

Code Description Validity Numeric Value

F Invalid Control Invalid 1000000.000000

G Detected - Result less than lower limit of
quantification

Valid 0.000100
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Code Description Validity Numeric Value

H No Result Invalid 10000000.000000

J Undetectable Valid 1.000000

X4 Results greater than upper limit of
quantification

Valid, but needs
repeat

10000.000000

NASBA HIV-1 RNA assay censor codes
This section lists the NASBA HIV RNA assay censor codes available in LDMS.

Code Description Validity Numeric Value

A Invalid standards - slope negative Invalid Run 1

B Controls out of sequence Invalid Run 10

D Converted from RLMP - Contamination Invalid 10,000

E Converted from RLMP - Poor viability Invalid 1,000,000

F Converted from RLMP - Incorrect tube Invalid .001

G Converted from RLMP - QNS Invalid .0001

H Converted from RLMP - Broken tube Invalid .00001

I Invalid specimen Invalid 100

J WT < LDL, Undetectable Valid 1,000

K Converted from RLMP - No sample
received

Valid 1 × 1013

L Converted from RLMP - Laboratory
accident

Invalid .01

M Converted from RLMP - Out of range
controls

Invalid .000001

O Converted from RLMP - Lab error Invalid 1 × 1012

P Converted from RLMP - Equipment failure Invalid .1

Q Converted from RLMP - Improper/
Questionable ID

Invalid 10,000,000

R Re-read Valid Run 100,000,000

T Converted from RLMP - Prerequisite test
failed

Invalid 100,000

U Converted from RLMP - Unable to calculate Invalid 1,000,000,000

V Converted from RLMP - Over amplified Invalid 10,000,000,000

W Converted from RLMP - Material didn’t
amplify

Invalid 1 × 10 11

X Converted from RLMP - Delayed shipment Invalid 1 × 1014

Y Converted from RLMP - Missing well Invalid 1 × 1015
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Nuclisens HIV-1 QT assay censor codes
This section lists the Nuclisens assay censor codes available in LDMS.

Code Description

A Invalid slope

B Controls out of sequence

D Converted from RLMP - Contamination

E Converted from RLMP - Poor viability

F Converted from RLMP - Incorrect tube

G Converted from RLMP - QNS

H Converted from RLMP - Broken tube

I Invalid specimen

J WT < LDL, Undetectable

K Converted from RLMP - No sample received

L Converted from RLMP - Laboratory accident

M Converted from RLMP - Out of range controls

O Converted from RLMP - Lab error

P Converted from RLMP - Equipment failure

Q Converted from RLMP - Improper/Questionable ID

R Re-read

T Converted from RLMP - Prerequisite test failed

U Converted from RLMP - Unable to calculate

V Converted from RLMP - Over amplified

W Converted from RLMP - Material didn’t amplify

X Converted from RLMP - Delayed shipment

Y Converted from RLMP - Missing well

Pharmacology assay codes
Codes for pharmacology assays.

Pharmacology analyte codes
This section lists the codes for pharmacology (PK) drug analyte codes
available in LDMS.

Code Description

3TC Lamivudine

3TCDP 3TC diphosphate

3TCDP-PC 3TC diphosphate choline

3TCDP-PE 3TC diphosphate ethanolamine

3TCMP 3TC monophosphate
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Code Description

3TCTP 3TC triphosphate

4B-OHC 4β-hydroxycholesterol

6BHC 6 Beta Hydroxycortsol

7-COOH-CBD 7-Carbxoy Cannabidiol

7-OH-CBD 7-Hydroxy-Cannabidiol

10-1074LS 10-1074LS

AAG Alpha-1 Acid Glycoprotein

ABC Abacavir

ABC-CARB Abacavir carboxylate

ABC-GLU Abacavir glucronide

ABC-MP Abacavir Monophosphate

ACL Acetyl-Isoniazid

ADF Adefovir

AL Artemether-lumefantrine

ALB Albumin

AML Amlodipine

AMP/DXAMP Amphetamine/Dextroamphetamine

APV Amprenavir

ARM Artemether

ASV Asunaprevir

Atorvast Atorvastatin

Atorvast-2OH 2-hydroxy Atorvastatin

Atorvast-4OH 4-hydroxy Atorvastatin

Atorvast-LAC2OH 2-hydroxy Atorvastatin Lactone

Atorvast-LAC4OH 4-hydroxy Atorvastatin Lactone

ATV Atazanavir

AZM Azithromycin

BCV Becllabuvir

BDCQ Bisdesethylchloroquine

BDQ Bedaquiline

BDQ-M2 N-monodesmethyl metabolite of Bedaquiline

BICUF Bictegravir Unbound

BLM Bleomycin Sulfate

BMS-936559 BMS-936559

Boc3004 SCH783004
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Code Description

Boc3005 SCH783005

Boc3006 SCH783006

Boc3007 SCH783007

Boc4128 SCH534128

Boc4129 SCH534129

Bocepvr Boceprevir

BZD Benznidazole

CAB Cabotegravir

CBD Cannabidiol

CBV-MP Carbovir Monophosphate

CBVTP carbovir triphosphate

CEM-ADA Cemiplimab ADA

CIT Citalopram

CLF Clofazimine

CLQ Chloroquine

CMS Colistin Methane Sulfonate

CMS - ColA ColA metabolite of Colistin Methane Sulfonate

CMS - ColB ColB metabolite of Colistin Methane Sulfonate

COBI Cobicistat

CORT Cortisol

CPM Capreomycin

CPM1A Capreomycin Compound 1A

CPM1B Capreomycin Compound 1B

CS Cycloserine

CTH Cethromycin

CVC Cenicriviroc

D4T Stavudine

d4TTP d4T triphosphate

DCB Daclatasvir

DCV Daclatasvir

ddATP dideoxyadenosine triphosphate

DDC Zalcitabine

ddI Didanosine

DES Desogestrel

des RBT des rifabutin
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Code Description

des RFP des rifapentine

des RMP des rifampicin

DEX Dexamethasone

DHA Dihydroartemisinin

DHCQ Desethylhydroxychloroquine

DHPG Ganciclovir

DLM Delamanid

DLM-DM6705 DM6705

DLT Diltiazem

DLT- AL Desacetyldiltiazem metabolite of DLT

DLT- MT Desmethyldiltiazem metabolite of DLT

DLV Delavirdine

DMPA Medroxyprogesterone Acetate

DOR Doravirine

DOX Doxorubicin (liposomal-encapsulated and free)

DOXOL Doxorubicinol

DPV Dapivirine

DRV Darunavir

DSI Desipramine

DSV Dasabuvir (previously ABT-333)

DSV-m1 Dasabuvir m1

DTG Dolutegravir

DXAMPS Dextroamphetamine sulfate

DXM Dextromethorphan

DXM-3HM 3-Hydroxy Morphinan

DXM - DXO Dextrorphan metabolite of Dextromethorphan

DXMPH Dexmethylphenidate

E7OH 7-Hydroxy Efavirenz

E8OH 8-hydroxy efavirenz

EBR> Elbasvir

EE Ethinyl Estradiol

EFV Efavirenz

EMB Ethambutol HCL

ENF Enfuvirtide

ENG Etonogestrel
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Code Description

ESCIT Escitalopram

ET Etoposide

ETR Etravirine

EVG Elvitegravir

FCZ Fluconazole

FLX Fluoxetine

FOS Foscarnet

FTC Emtricitabine

FTC-TP Emtricitabine Tri-phosphate

GES Gestodene

GS-441524 Remdesivir Metabolite

HCQ Hydroxychloroquine

HDP-THV Hexadecyloxypropyl Tenofovir

HU Hydroxyurea

HYC Hydrocodone

Ibalzb Ibalizumab

IDV Indinavir

INH Isoniazid

IQP-0528 IQP-0528

ISO Isotretinoin

ISO-4OXO 4-OXO-Isotretinoin Metabolite

ISO-ATRA All-Trans Retinoic Acid

ITX 5061 ITX 5061

KAN Kanamycin

KYN Kynurenine

LDV Lepipasvir

LEN Lenacapavir

LF Lumefantrine

LF-DBL Desbutyl Lumefantrine

LPV Lopinavir

LPVF Free or unbound lopinavir concentrations

LVF Levofloxacin

LY-CoV555 LY3819253

LZD Linezolid

M3 N-didesmethyl metabolite of bedaquiline (TMC207)
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Code Description

M8 NFV Metabolite

METF Metformin

Minocyclene/Placebo Minocyclene/Placebo

MK-3475 MK-3475

MOR Morphine

MPA Mycophenolic Acid

MPAF Free Mycophenolic Acid

MPAG Mycophenolic Acid Metabolite

MPH Methylphenidate

MTD Methadone HCl

MTX Methotrexate

MVC Maraviroc

MXF Moxifloxacin

N-803 N-803 IL-15 Superagonist

N-DLV Delavirdine’s Metabolite

NET Norethisteron

NFV Nelfinavir

NFX Nifurtimox

NGM Norgestimate

NHC β-D-N4-hydroxycytidine

NIM Nimodipine

NVP Nevirapine

OBV Ombitasvir (previously ABT-267)

OFX Ofloxacin

OXT Oxytocin

OXY Oxycodone

P4 Progesterone

PA Pretomanid

PAS aminosalicylic acid

PEG-IFN Pegylated-Interferon alfa 2b

PF-332 PF-07321332

PGT121-414-LS PGT121-414-LS

PLD Pegylated Liposomal Doxorubicin

PMPA (9 - [2 - (R) - (phosphonomethoxy)propyl] adenine)

PNU -101603 PNU -101603 metabolite of Sutezolid
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Code Description

PPX Pramipexole

PTV Paritaprevir (previously ABT-450)

PTX Paclitaxel

PXT Paroxetine

PZA Pyrazinamide

PZQ Praziquantel

PZQ-4OH 4-Hydroxy metabolite of Praziquante

R-AMPH Dextro-amphetamine

RBT rifabutin

RDV-GS704277 Remdesivir alanine metabolite

RDV-GS441524 Remdesivir

RFP rifapentine

RGV Raltegravir

RIS Risperidone

RMD Romidepsin

RMP Rifampicin

RPV Rilpivirine

RTV Ritonavir

RUX Ruxolitinib

RV Ribavirin

RV-TP Ribavirin Triphosphate

S-AMPH Levo-amphetamine

SERT Sertraline

SERT – DMS Desmethylsertraline

SLGN Selgantolimod

SOF Sofosbuvir

SOF-GS-331007 GS-331007 metabolite of SOF

SOF-GS-566500 GS-566500 metabolite of SOF

SQ109 SQ109

SQV Saquinavir

STZ Sutezolid

TAF Tenofovir Alafenamide Fumarate

TEC Tecovirimat

TFV Tenofovir

TFVDP Tenofovir Diphosphate
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THA Thalidomide

THC Delta9-tetrahydrocannabinol

TPV Tipranavir

TRP Tryptophan

VCR Vincristine Sulfate

VCV Vicriviroc

VEL Velpatasvir

VRC01 VRC-HIVMAB060-00-AB

VRC01LS VRC-HIVMAB080-00-AB

ZDV Zidovudine

ZDVDP Zidovudine diphosphate

ZDVMP Zidovudine monophosphate

ZDVTP Zidovudine triphosphate

Pharmacology system censor codes
This section lists the pharmacology (PK) system censor codes available in
LDMS.

Code Description Validity Numeric Value

A Invalid. Greater than the upper limit,
dilute and repeat

Invalid 16

B Below quantifiable limit Valid 8

F Failed Invalid 32

H Unacceptable HQC Invalid 64

I Unacceptable HOQ Invalid 512

L17 Lower limit adjusted up for this run Valid 1

M Unacceptable MQC Invalid 128

Q Unacceptable LQC/ LQC1/LQC2 Invalid 256

R18 Repeat (with L system censor only) Invalid 4

U Sample Diluted Valid 1,000,000,000,000

17 No longer available, Windows LDMS specific
18 No longer available, Windows LDMS specific
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Pharmacology assay user censor codes
This section lists the pharmacology assay user censor codes available in
LDMS.

Code Description Validity Numeric Value

A19 Greater than the upper limit, dilute and
repeat

Invalid

B Below Quantifiable Limit or No Peak Valid 2048

D Drug not required to be assayed Valid20 512

F21 Failed Invalid

N Not Detected Valid 8

O QC out of range, dilute and repeat Invalid 4

P Not Able to Interpret Result Invalid 8192

S22 Quantity not sufficient Invalid

X Per lab, sample must be repeated Invalid 1024

Z No Result, Lab Issue Invalid 4096

Pharmacology concentration units
These unit codes are used for PK specimen concentration values.

Code Description

% percentage

FMOL/10^6 CELLS femtomol per 10^6 cells

FMOL/ML femtomol per milliliter

FMOLE femtomol

FMOLE/MG FMOLE/MG

FMOLE/SAMPLE FMOLE/SAMPLE

NG/MG NG/MG

NG/ML nanogram per milliliter

NG/SAMPLE nanogram per sample

NMOL nanomol

pg/injection picograms per injection

pg/mL picogram per milliliter

PMOL/10^6 CELLS picomol per 10^6 cells

PMOLE picomol

UG/ML microgram per milliliter

19 No longer available, Windows LDMS specific
20 Results removed from final views
21 No longer available, Windows LDMS specific
22 No longer available, Windows LDMS specific
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Code Description

UMOL micromol

P24 system censor codes
This section lists the P24 assay system censor codes available in LDMS.

Code Description

A Invalid standards - slope negative

B VQA standards out of sequence

C Missing media controls

D Kit controls out of sequence

R Re-read

GeneXpert MTB-RIF system censor codes
These are the system censors for the GeneXpert MTB-RIF assay.

Code Description

E Error

F Control invalid

H No result

R Re-read
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